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WinPAC-8xx7 ISaGRAF PAC 快速上手手冊 

WinPAC-8xx7 或 WP-8xx7 為 WP-8147/8447/8847/8137/8437/8837 的簡稱。 

WinPAC-8xx6 或 WP-8xx6 為 WP-8146/8446/8846/8136/8436/8836 的簡稱。 
  

重      要  

1. WP-8xx7/8xx6 的 插槽 0 ~ 7 只支援 高卡的 I-8K 與 I-87K I/O 模組。  

請參考 WP-8xx7 CD: \napdos\isagraf\wp-8xx7\chinese_manu\   Data Sheet 型錄檔案 

2. WP-8xx7 需設定為固定 IP 位址。 (不可使用 DHCP) 

3. 如果不使用 WP-8xx7 的 LAN2，需將 LAN2 設定為 Disable (請參考 附錄 D)。 

4. 建議使用工業級乙太網路交換器 NS-205/208 或 RS-405/408 來連接 PAC。 

5. 請最好不要把資料 file 與 開發好的 .net 程式存放在 \System_Disk 內, 因為 \System_Disk 使用 的

是 Nor Flash 記憶體, 它主要是給 OS, ISaGRAF driver, 與一些必要 utility 與 DLL 存放使用, size 不

大. 而且 Nor Flash 記憶體 不適合常常去更新資料, 若常常在 \System_Disk 內更新 file (比如每 1 

~5 秒就更新 file 一次, 一天下來 就更新了約幾萬次), 久了可能會損壞 \System_Disk 內的資料. 所

以自行開發的程式與要操作的 file 最好都存放在 \Micro_SD 內。 
 

注      意 

泓格科技股份有限公司對於因為使用本系列產品所造成的任何損害並不負任何法律上的責任，本

公司並保留在任何時候修訂本書且不需通知的權利。 

 泓格科技股份有限公司將儘可能地提供本系列產品可靠而詳盡的資訊。然而，本公司並無義務需

提供此系列產品詳盡的應用資訊，或對因非法使用本系列產品所遭受的損害負任何責任。 
  

商標 與 著作權 

本書所提所有公司商標，商標名稱及產品名稱分別屬於該商標或名稱的擁有者所有。 
 

開發軟體 

兩種選項: 

- ISaGRAF: 3.4x 或 3.5x 版，符合 IEC 61131-3 標準。LD, ST, FBD, SFC, IL 與 FC。 

- 非 ISaGRAF: Microsoft EVC++4.0 或 VS.NET 2008/2005/2003 (VB.net, C#.net)。 
 

參考資料 

- ISaGRAF English User’s Manual:   
WP-8xx7 CD: \napdos\isagraf\wp-8xx7\english_manu\ "user_manual_i_8xx7.pdf" 與 

"user_manual_i_8xx7_appendix.pdf"(附錄) 

- ISaGRAF 中文進階使用手冊:     
WP-8xx7 CD: \napdos\isagraf\wp-8xx7\chinese_manu\ 手冊與附錄檔案:  

"chinese_user_manual_i_8xx7.pdf" 與 "chinese_user_manual_i_8xx7_appendix.pdf" 

- 更多網頁資訊: www.icpdas.com > 商品目錄 > 解決方案 > Soft PLC, ISaGRAF & Soft-GRAF HMI > ISaGRAF 

首頁 > 產品手冊 
 

技術支援 

請連絡當地的經銷商或 E-mail 問題至  service@icpdas.com . 

常見問答集請參考 FAQ : www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC 

  
著作者: Chun Tsai;  編譯者: Eva Li   

版權所有泓格科技股份有限公司，2009 年 7 月起，保留所有權利。   

http://www.icpdas.com/
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/isagraf_tc.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/isagraf_tc.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download_tc.html#manu
mailto:service@icpdas.com
http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
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參  考  資  料 

ISaGRAF 英文進階使用手冊:   

WP-8xx7 CD: \napdos\isagraf\wp-8xx7\english_manu\  
"user_manual_i_8xx7.pdf" 與 "user_manual_i_8xx7_appendix.pdf"(附錄) 

ISaGRAF 中文進階使用手冊:     

WP-8xx7 CD: \napdos\isagraf\wp-8xx7\chinese_manu\  
"chinese_user_manual_i_8xx7.pdf" 與 "chinese_user_manual_i_8xx7_appendix.pdf"(附錄) 

網頁: www.icpdas.com > 商品目錄 > 解決方案 > Soft PLC, ISaGRAF & Soft-GRAF HMI > ISaGRAF 首頁 > 

 產品手冊 

 
工業級乙太網路交換器 : NS-205/208 & RS-405/408 (Ring Switch)   

www.icpdas.com > 商品目錄 > 解決方案 > 工業級乙太網路交換器 > Unmanaged Ethernet Switches 

 
 
 
 
 
 
 
 

電源供應器 :  
www.icpdas.com > 商品目錄 > 零配件 > Power Supply  

DP-660 :  24 V / 2.5 A , 5 V / 0.5 A 電源供應器 (DIN-Rail mounting) 

DP-665 :  24 V / 2.5 A , 5 V / 0.5 A 電源供應器  

DP-1200 : 24 V / 5 A 電源供應器 

 
 
 
 
 
 
 
 
 
FAQ 常見問題集:   

ISaGRAF 首頁 > 下載區 – 產品問答集 (FAQ) 

www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC 

 
 

  

Model: DP-665 Model: DP-665 Model: DP-660 Model: DP-1200 

Model: RS-405 Model: RS-408 Model: NS-205 Model: NS-208 

http://www.icpdas.com/
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/isagraf_tc.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download_tc.html#manu
http://www.icpdas.com/
http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html
http://www.icpdas.com/
http://www.icpdas.com/root/product/solutions/accessories/power_supply/power_supply_selection.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/isagraf_tc.html
http://www.icpdas.com/root/support/faq/isagraf_tc.html
http://www.icpdas.com/
http://www.icpdas.com/faq/isagraf.htm
http://www.icpdas.com/faq/isagraf.htm
http://www.icpdas.com/faq/isagraf.htm
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WP-8xx7 系列 I/O 模組選型指南 

WP-8x47 支援下列 I-8K/I-87K 高卡 I/O 模組 及 RS-485/FRnet 遠端 I/O 模組, 列於 ISaGRAF 產品型錄, 

請至下頁參考 I/O 模組列表 或 依照以下步驟參考網頁最新列表. 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
  

  2. 點選此圖示連結到 ISaGRAF 產品網頁 

1. www.icpdas.com 

3. 切換為 中文 

4. 點選 產品型錄 

http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download.html
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高速本機 I/O 模組 :  並列式 (Parallel Bus) 

I-8K 高卡系列 : 詳見: www.icpdas.com > 商品目錄 > 解決方案 > 遠端 I/O 模組/擴充單元 > I-8K & 87K 

I-8K 類比 輸出入 模組 

I-8014W 
16-bit 250K sampling rate 8/16-ch. analog input module (The scan rate cannot reach 250K when using in 
the ISaGRAF PAC) 

I-8017HW 
8-ch. Differential or 16-ch. Single-ended, 14-bit, High Speed Analog Input Module. (current input require 

external 125  resistor) (The scan rate cannot reach 100K when using in the ISaGRAF PAC) 

I-8024W 4-ch. Isolated Analog Output Module (+/-10 V, 0 ~ +20 mA) 

I-8K 數位 輸出入 模組 

I-8037W 16-ch. Isolated Open Collector Output Module 

I-8040W 32-ch. Isolated Digital Input Module 

I-8040PW 32-ch. Isolated Digital Input with Low Pass Filter Module 

I-8041W 32-ch. Isolated Open Collector Digital Output Module (Sink) 

I-8041AW 32-ch. Isolated Open Collector Digital Output Module (Source) 

I-8042W 16-ch. Isolated Digital Input & 16-ch. Isolated Open Collector Digital Output Module 

I-8046W 16-ch. Isolated Digital Input Module 

I-8050W 16-ch. Universal Digital I/O Module 

I-8051W 16-ch. Non-isolated Digital Input Module 

I-8052W 8-ch. Differential Isolated Digital Input Module  

I-8053W 16-ch. Isolated Digital Input Module 

I-8053PW 16-ch. Isolated Digital Input with Low Pass Filter Module 

I-8054W 8-ch. Isolated Digital Input Module & 8-ch. Isolated Open Collector Digital Output Module 

I-8055W Non-isolated 8-ch. Digital Logic Input Module & 8-ch. Open Collector Digital Output Module 

I-8056W 16-ch. Non-isolated Open Collector Output Module 

I-8057W 16-ch. Isolated Open Collector Output Module 

I-8058W 8-ch. Differential Isolated Digital Input Module, Max. AC/DC Input : 250V 

I-8060W 6-ch. Relay Output Module, AC: 0.6 A @ 125 V , 0.3 A @ 250 V; DC: 2 A @ 30 V  

I-8063W 4-ch. Differential Isolated digital input & 4-ch. Relay output module, AC : 0.6 A @ 125 V ; 0.3 A @ 250 V 

I-8064W 8-ch. Power Relay Output Module, AC: 5 A @ 250 V, DC: 5 A @ 30 V 

I-8068W 
4-ch. Form-A, 5 A @ 250 VAC /28 VDC & 4-ch. Form-C, 5 A (NO) /3 A (NC) @ 277 VAC /30 VDC Relay Output 
Module 

I-8069W 8-ch. PhotoMOS Relay Output Module, Max. AC/DC: 1 A @ 60 V 

I-8K 計數器 / 頻率 模組 

I-8084W 4-ch. Encoder, can be dir/pulse, or up/down or A/B phase (Quad. mode), Not support Encoder Z-index 

I-8088W 8-ch. PWM Output and 8-ch. isolated DI Module, software support 1 Hz ~ 100 kHz (non-continuous). 

I-8K 運動控制 模組 

I-8093W 
3-axis Encoder Module, max. 1M Hz for quadrant input mode, max. 4M Hz for pulse/direction and cw/ccw 
input model 

I-8090W 3-axis Encoder Module 

I-8091W 2-axis Stepping/Servo Motor Control Card without encoder input 

I-8092F High Speed 2-axis Motion Control Module, with FRnet Master (For XP-8xx7-CE6 only) 

I-8094 High Speed 4-axis Motion Control Module (For XP-8xx7-CE6 only) 

I-8094F High Speed 4-axis Motion Control Module, with FRnet Master (For XP-8xx7-CE6 only) 

I-8K 通訊 模組 

I-8112iW 2-ch. Isolated RS-232 Expansion Module 

I-8114W 4-ch. non-isolated RS-232 Expansion Module  

I-8114iW 4-ch. Isolated RS-232 Expansion Module 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html
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I-8142iW 2-ch. Isolated RS-422/485 Expansion Module  

I-8144iW 4-ch. Isolated RS-422/485 Expansion Module 

I-8172W 2-port FRnet Module 

I-8K CAN Bus 模組 

I-8123W 1 Port High Performance CANopen Master Module 

 

RS-485 遠端 I/O 模組 :  串列式 ; 可熱插拔 

I-87K 高卡系列 :  詳見: www.icpdas.com > 商品目錄 > 解決方案 > 遠端 I/O 模組/擴充單元 > I-8K & 87K 

I-87K 類比 輸出入 模組 

I-87005W 8-ch. Thermistor input and 8-ch. digital output module 

I-87013W 4-ch., 16-bit, 10 Hz (Total), 2/3/4 Wire RTD Input Module with Open Wire Detection 

I-87015W 7-ch., 16-bit, 12 Hz (Total), RTD Input Module with Open Wire Detection (for short sensor distance) 

I-87015PW 
7-ch. RTD Input Module with 3-wire RTD lead resistance elimination and with Open Wire Detection (for 
long sensor distance) 

I-87017RW 
8-ch. Differential , 16/12-bit, 10/60 Hz (Total) Analog Input Module with 240 Vrms Over Voltage Protection, 
Range of -20  ~ +20 mA Requires Optional External 125 Ω Resistor 

I-87017RCW 8-ch. Differential , 16/12-bit, 10/60 Hz(Total) Current Input Module 

I-87017W 8-ch. Analog Input Module 

I-87017W-A5 8-ch. High Voltage Input Module 

I-87017DW 8-ch. Analog Input Module (Gray Cover) (RoHS) 

I-87017ZW 10/20-ch. Analog Input Module with High Voltage Protection (RoHS) 

I-87018PW 8-ch. Thermocouple Input Module (Gray Cover) (RoHS) 

I-87018RW 8-ch. Thermocouple Input Module. Recommend to use the better I-87018Z. 

I-87018W 8-ch. Thermocouple Input Module. Recommend to use the better I-87018Z. 

I-87018ZW 
10-ch. Differential , 16-bit, 10 Hz (Total), Thermocouple Input Module with 240 Vrms Over Voltage 
Protection, Open Wire Detection, Range of +/-20 mA, 0~20 mA, 4~20 mA requires Optional External 125 Ω 
Resistor 

I-87019PW 8-ch. Universal Analog Input Module (RoHS) (With a CN-1824 Daughter Board) 

I-87019RW 
8-ch. Diff. , 16-bit, 8 Hz (Total), Universal Analog Input Module with 240 Vrms Over Voltage Protection, Open 
Wire Detection (V, mA, Thermocouple; Range of -20 ~ +20 mA need to set Jumper on board)  

I-87019ZW 
10-ch. Universal Analog Input Module (Gray Cover) (RoHS), Includes the I-87019ZW Module and a DB-1820 
Daughter Board 

I-87024CW 4-ch. 12-bit channel to channel isolated current output module with open-wire detection 

I-87024DW 4-ch. 14-bit analog output module 

I-87024RW 4-ch. 14-bit analog output module 

I-87024W 4-ch. 14-bit analog output module (0 ~ +5 V, +/-5 V, 0 ~ +10 V, +/-10 V, 0 ~ +20 mA, +4 ~ +20 mA) 

I-87028CW 8-ch. 12-bit current output module 

I-87H17W 8-ch. analog input module and HART master module. 

I-87K Multifunction 輸出入 模組 

I-87026PW 6-ch. Analog Input, 2-ch. Analog Output, 2-ch. Digital Input and 2-ch. Digital Output Module (RoHS) 

I-87K 數位 輸出入 模組 

I-87037W 16-ch. source type Isolated Digital Output Module(RoHS) 

I-87040W 32-ch. Isolated Digital Input Module 

I-87040PW 32-ch. Isolated Digital Input Module with 16-bit Counters (RoHS) 

I-87041W 32-ch. Sink Type Open Collector Isolated Digital Output Module 

I-87046W 16-ch. Non-Isolated Digital Input Module for Long Distance Measurement  

I-87051W 16-ch. Non-Isolated Digital Input Module 

I-87052W 8-ch. Differential , Isolated Digital Input Module 

I-87053PW 16-ch. Isolated Digital Input Module with 16-bit Counters 

I-87053W 16-ch. Isolated Digital Input Module 

I-87053W-A5 16-ch. 68 ~ 150 VDC Isolated Digital Input Module  

I-87053W-AC1 16-ch. AC Isolated Digital Input Module with 16-bit Counters 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html
http://www.icpdas.com/products/PAC/i-8000/selection_multifunction.htm
http://www.icpdas.com.tw/product/solutions/remote_io/rs-485/i-8k&i-87k/i-87026pw.html
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I-87053W-E5 16-channel 68-150 VDC solated Digital Input Module with 16-bit Counters 

I-87054W Isolated 8-ch. DI and 8-ch. Open Collector DO Module 

I-87055W Non-Isolated 8-ch. DI and 8-ch. Open Collector DO Module 

I-87057W 16-ch. Open Collector Isolated Digital Output Module 

I-87057PW 16-ch. Open Collector Isolated Digital Output Module 

I-87058W 8-ch. 80~250 VAC Isolated Digital Input Module 

I-87059W 8-ch. Differential 10-80 VAC Isolated Digital Input Module 

I-87061W 16-ch. Relay Output Module (RoHS) 

I-87063W 
4-ch. Differential Isolated Digital Input and 4-ch. Relay Output Module 5 A (NO) / 3 A(NC) @ 5 ~ 24 VDC ; 5 
A(NO) / 3 A(NC) @ 0 ~ 250 VAC 

I-87064W 8-ch. Relay Output Module, 5 A (47~63 Hz) @ 0~ 250 VAC ; 5 A @ 0~ 30 VDC 

I-87065W 8-ch. AC SSR Output Module, AC: 1.0 Arms @ 24 ~ 265 Vrms 

I-87066W 8-ch. DC SSR Output Module , DC: 1.0 Arms @ 3 ~ 30 VDC 

I-87068W 
4-ch. Form-A Relay Output and 4-ch. Form-C Relay Output Module ;  Form-A: 8 A @ 250 VAC; 8 A @ 28 VDC; 
Form-C: 5 A (NO) / 3 A (NC) @ 277 VAC ; 5 A(NO ) / 3 A(NC) @ 30 VAC 

I-87069W 8-ch. PhotoMOS Relay Output Module, Max. AC/DC: 0.13 A @ 350 V 

I-87K 計數器 / 頻率 模組 

I-87082W 2-ch. Counter/Frequency Module, Isolated or Non-isolated Inputs 

I-87K PWMS 模組 

I-87088W 8-ch. PWM outputs, software support 1 Hz~100 kHz, (non-continuous), duty: 0.1 ~ 99.9% 

I-87K GPS 模組 

I-87211W Time-Synchronization and GPS module for getting UTC/local time and local Longitude/Latitude  

 

RS-485 遠程 I/O 模組 

I-7000 
DCON Protocol 

www.icpdas.com > 商品目錄 > 解決方案 > 遠端 I/O 模組/擴充單元 > I-7000 & M-7000 

M-7000 
Modbus RTU, DCON Protocol 

www.icpdas.com > 商品目錄 > 解決方案 > 遠端 I/O 模組/擴充單元 > I-7000 & M-7000 

tM-7000 
DCON, Modbus RTU, Modbus 
ASCII Protocol 

www.icpdas.com > 商品目錄 > 解決方案 > 遠端 I/O 模組/擴充單元 > RS-485 Remote I/O 

Modules > tm-series 

RS-485 遠程 I/O 擴充單元 

RU-87P1/2/4/8 

熱插拔, 自動組態. 

www.icpdas.com > 商品目錄 > 解決方案 > 遠端 I/O 模組/擴充單元 > Remote I/O 

Expansion Unit > RS-485 Bus 選型  

I-87K1/4/5/8/9 
 

www.icpdas.com > 商品目錄 > 解決方案 > 遠端 I/O 模組/擴充單元 > Remote I/O 

Expansion Unit > RS-485 Bus 選型 

 

Ethernet I/O 模組 

ET-7000 

網路型 

www.icpdas.com >商品目錄 > 解決方案 > 遠端 I/O 模組/擴充單元 > Ethernet I/O > ET-7000

選型 

PET-7000 

PoE 網路型 

www.icpdas.com >商品目錄 > 解決方案 > 遠端 I/O 模組/擴充單元 > Ethernet I/O >  

PET-7000 選型 

tPET/tET-7000  

Modbus TCP 網路型 (PoE) 

www.icpdas.com >商品目錄 > 解決方案 > 遠端 I/O 模組/擴充單元 > Ethernet I/O >  

PETL-7000 & tPET/tET 選型 

Ethernet I/O 擴充單元 

I-8KE4/8-MTCP 

Modbus TCP 網路型 
www.icpdas.com >商品目錄 > 解決方案 > 遠端 I/O 模組/擴充單元 > Ethernet I/O > 

I-8KE4/8-MTCP (Modbus/TCP based Ethernet I/O Unit) 
 

  

http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html
http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-7000_m-7000/i-7000_m-7000_selection.html
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html
http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-7000_m-7000/i-7000_m-7000_selection.html
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html#rio7
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html#rio7
http://www.icpdas.com/root/product/solutions/remote_io/rs-485/tm-series/tm-series_selection.html
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html
http://www.icpdas.com/root/product/solutions/pac/ipac/io_expansion_unit_selection_tc.html
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html
http://www.icpdas.com/root/product/solutions/pac/ipac/io_expansion_unit_selection_tc.html
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html#eio
http://www.icpdas.com/root/product/solutions/remote_io/ethernet_io/ethernet_io_selection.html
http://www.icpdas.com/root/product/solutions/remote_io/ethernet_io/ethernet_io_selection.html
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html#eio
http://www.icpdas.com/root/product/solutions/remote_io/ethernet_io/ethernet_io_selection.html
http://www.icpdas.com/products/Remote_IO/petl-7000/PETL_Series_Main_Page.htm
http://www.icpdas.com/products/Remote_IO/petl-7000/PETL_Series_Main_Page.htm
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html#eio
http://www.icpdas.com/products/Remote_IO/petl-7000/PETL_Series_Main_Page_c.htm
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products_tc.html#eio
http://www.icpdas.com/root/product/solutions/pac/ipac/i-8ke4-mtcp_tc.html
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規格: WP-8137/ 8437/ 8837/ 8147/ 8447/ 8847 

 

PAC 規格:  

型號 WP-8137 WP-8437 WP-8837 WP-8147 WP-8447 WP-8847 WP-8057 WP-8357 WP-8757 

系統軟體 

作業系統 Windows CE 5.0 

.Net Compact 
Framework 

3.5 

內建服務 FTP server, Web server 

多語支援 英文, 德文, 法文, 西班牙文, 俄羅斯文, 韓文, 義大利文, 簡體中文, 繁體中文 

開發軟體 

ISaGR
AF 

開發

軟體 

ISaGRAF 
Ver.3 

IEC 61131-3 國際標準.  

編程語言 

LD, ST, FBD, SFC, IL, FC;  

支援 Soft-GRAF HMI: XP-8xx7-CE6, XP-8xx7-Atom-CE6, WP-8xx7/5xx7 與 

VP-2xW7/4xx7 PAC 

最大程式

碼容量 
1 MB 

掃描時間 一般程式: 3 ~ 15 ms; 大型或複雜程式: 15 ~ 50 ms ( 或更多) 

非 ISaGRAF 選項: MS eVC++ 4.0 或 VS .NET 2005/2008 (VB .NET, C#.NET) 

網路服務 

網路人機介面 

(Web HMI) 
PC 上執行 Internet Explorer 可經由區域網路, 網際網路 或 撥接 Modem 上網監控 

安全性 Web HMI 提供 3 組 使用者帳號 和 密碼保護 (high/middle/low) 

CPU 模組 

處理器 (CPU) PXA270, 520 MHz 

SDRAM 128 MB 

雙電池備援 SRAM 512 KB; 可斷電保持資料 5 年.  (可供保留變數使用)  

Flash 128 MB 96 MB 128 MB 

EEPROM 16 KB 

擴充記憶體 microSD 插槽中附一個 microSD卡 (最多可支援 32 GB) 
CF插槽中附一個CF卡(最多可

支援 32 GB) 

即時時鐘 (RTC) 可讀/寫 年、月、日、時、分、秒, 並提供星期資訊 

64-bit 硬體序號 有, 軟體防拷保護 

雙看門狗機制 有 

可程式 LED 指示燈 1 

旋轉式開關 (Rotary 有 (0 ~ 9) 

即將上市! 
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型號 WP-8137 WP-8437 WP-8837 WP-8147 WP-8447 WP-8847 WP-8057 WP-8357 WP-8757 

Switch) 

指撥式開關 (DIP 

Switch) 
- 有 (8 bits) - 有 (8 bits) - 有 (8 bits) 

Audio  - 麥克風輸入 與 耳機輸出 

VGA 與通訊介面 

VGA 
有;  640 x 480, 800 x 600, 

1024 x 768 
有 ;  640 x 480, 800 x 600 

Ethernet RJ-45 x 2, 10/100 Base-TX 雙乙太網路埠 (Auto-negotiating, LED indicators) 

USB 1.1 
(host)/(client) 

2 1 2 

USB 1.1 (client) - 1 

COM 0 給插槽上的 I-87K 高卡內部通訊使用 

COM 1 RS-232 (RxD, TxD, GND) (更新韌體用); 無隔離 

COM 2 
RS-485 (Data+, Data-) 內含 self-tuner 晶片; 

WP-8137, WP-8147 隔離值: 2500 VDC; 其於型號隔離值: 3000 VDC 

COM 3 
- 有  - 有  

RS-232/RS-485 (RS-232: RxD, TxD, CTS, RTS, GND; RS-485: Data+, Data-); 無隔離 

COM 4 
- 有  - 有  

RS-232 (RxD, TxD, CTS, RTS, DSR, DTR, CD, RI, GND); 無隔離 

COM 5 
- 有  - 

RS-232 (RxD, TxD, GND); 無隔離 

I/O 擴充槽 

插槽數目 
1 4 8 1 4 8 0 3 7 

注意: 僅支援 I-8K 高卡模組 與 I-87K 高卡模組 

機構特性 

尺寸 (W x L x H)  

  95 mm x 132 mm x 111 mm: WP-8137, WP-8147  
137 mm x 132 mm x 111 mm: WP-8057 
231 mm x 132 mm x 111 mm: WP-8437, WP-8447, WP-8357 
355 mm x 132 mm x 111 mm: WP-8837, WP-8847, WP-8757 

安裝方式 標準導軌安裝 (DIN-Rail) 或壁掛式安裝 (Wall Mounting) 

環境參數 

運作溫度 -25 ~ +75°C 

儲存溫度 -30 ~ +80°C 

相對溼度 10 ~ 90% RH (無凝露) 

電源 
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型號 WP-8137 WP-8437 WP-8837 WP-8147 WP-8447 WP-8847 WP-8057 WP-8357 WP-8757 

輸入電源 +10 ~ +30 VDC 

隔離 1 kV 

冗餘電源輸入 有; 其繼電器 (1 A @ 24 VDC) 用於電源失效時的警示 

電源功率 8 W 25 W 25 W 8 W 30 W 30 W 8 W 30 W 30 W 

功耗 7.3 W 9.1 W 9.6 W 7.3 W 9.1 W 9.6 W 7.3 W 9.1 W 9.6 W 

 

WP-8xx7 ISaGRAF 規格:  

通訊協定  (某些通訊協定應用需要額外選購設備) 

站號 (Net ID) 1~255, 軟體方式設定 

Modbus TCP/IP Master 

通訊協定 
最多可連接 100 台支援標準 Modbus TCP/IP Slave 通訊協定的設備 

(FAQ-113) 

Modbus RTU/ASCII 

Master 通訊協定 

最多可使用 10 個通訊埠 : COM1 ~ 14 (*)  (連接其他 Modbus Slave 設備). 支

援多埠通訊. 

Modbus RTU Slave 通訊

協定 

最多可使用 5 個通訊埠: COM1, COM2/3 選一, COM4 ~ COM8 (*)  (可連接 

ISaGRAF, PC/人機介面/OPC Server 及 觸控螢幕).  

Modbus TCP/IP Slave 通

訊協定 

2 個乙太網路埠都支援 Modbus TCP/IP Slave 通訊協定來連接 ISaGRAF 及 

PC/人機介面.  LAN1 與 LAN2 最多共可支持 32 個連結. (WP-8xx7 若使用 1 

個 連結來連接每台 PC/HMI, 最多可連接 32 台 PC/HMI; 若使用 2 個連結來

連接每台 PC/HMI, 則最多可連接 16 台 PC/HMI; ...) 當其中一條網路斷線, 另

一條網路可繼續連結 PC/HMI. 

Web HMI 通訊協定 透過網路通訊埠與使用微軟 IE 瀏覽器的電腦連線. 

使用者自訂通訊協定 
使用者可藉由串列通訊功能方塊來撰寫自己的通訊協定, 適用於 COM1 ~ 

COM14 (*). 

I-7000 與 I-87K RS-485 

遠程 I/O 

COM2 ~ 3 其中一個埠可連接遠程 I/O 模組 : I-7000 I/O 模組 或 I-87Kn 擴充

單元 + I-87K I/O 模組 或 RU-87Pn 擴充單元+ I-87K I/O 高卡模組. 一台控制器

最多可連接 255 台 I-7000/87K 遠程 I/O 模組. 

M-7000 系列 Modbus 

I/O 

最多可使用 10 個 RS-485 埠 (COM1 ~ 14) (*). 每個埠最多可連接 32 台 

M-7000 模組. 

Modbus TCP/IP I/O 

LAN2 支持 ICP DAS Ethernet I/O : I-8KE4-MTCP 與 I-8KE8-MTCP. 若 LAN2 發生

斷線狀況, 主機將自動切換到 LAN1 來連線到 Ethernet I/O 繼續工作. (此功

能需將 LAN1 與 LAN2 的 IP 設定在相同的 IP 網域)  (FAQ-042) 

FRnet I/O 

最多可使用 8 片 I-8172W 板卡 (插於 0 ~ 7 槽), 來連接 FRnet I/O 模組, 例如 

FR-2053, FR-2057, FR-32R, FR-32P. 每片 I-8172W 最多可連接 256 個 DI 點 加 

256 個 DO 點. (FAQ-082, 154) 

傳送 Email 提供函式, 經由 Ethernet port 傳送 Email. 可夾帶一個附件檔. 

Ebus LAN2 經由網路連接埠讓 ICP DAS 各 ISaGRAF 網路型控制器間互相交換資料.  
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SMS:簡訊服務 

WP-84x7/88x7 的 COM4 與 WP-81x7 的 COM1/COM5 可連接 GSM Modem 

支援簡訊功能. 使用者可用手機來對控制器詢問資料或下命令控制. 控制器

也可主動回覆警報 或資料給使用者手機. (*) 

可選用的 GSM Modem: GTM-201-RS232 (850/900/1800/1900 GSM/GPRS 外

接型 Modem) 或 網站介紹的 GSM/GPRS Modem 

MMICON/LCD COM4 或 COM5 可連接 ICP DAS 的 MMICON.  (*) 

UDP Server 與 UDP 

Client : 網路資料傳遞 

與 主動回報 

LAN1 或 LAN2 支持 UDP Server 與 UDP Client 通訊協定 來與 PC/HMI 或其他

能支援 UDP 協定的設備互相 傳遞/接收 資料. 例如: 可主動回報資料到 

InduSoft 的 RXTX Driver. 

TCP Client : 網路資料傳

遞 與 主動回報 

LAN1 或 LAN2 支援 TCP Client 通訊協定 來與 PC/HMI 或其他能支援 TCP 

server 通訊協定的設備互相傳遞/接收資料.  例如: 可主動回報資料到 

InduSoft 的 RXTX Driver 或 連結案場攝影設備. 

GPRS/SMS 

支持 I-8212W (2G/3G) 板卡 來 收/發 手機簡訊, 也可撥接 GPRS 上網來發送 

email 與 進行 "Ftp Client" (FAQ-151) 和 "TCP Client" / "UDP Server" / "UDP 

Client" (FAQ-143) 遠端通訊. 

SQL Client 
支援 SQL Client 功能可以連接後台的 Microsoft SQL Server (2000 SP3, 2005, 

2008 或相容版本) 來進行資料的寫入或讀取.  

可熱插拔備援 (冗餘) 

系統 

本備援系統 (Redundant System) 提供 2 組 Active IP, 永遠指向掌握控制權的

那台 PAC 的 LAN1 與 LAN2 網路埠, 來讓 1 台或多台 PC/ HMI/ SCADA 連接進

來. 因此 PC/HMI/SCADA 不需去判斷哪一台 PAC 是掌握控制權的那台, 只管

使用這 2 組 Active IP 去連接即可.  

另外, 本備援系統支援可熱插拔 I/O, 需使用 RU-87P4 或 RU-87P8 擴充單元 

插上 I-87K 高卡, 當 I/O 高卡發生意外損壞時, 可以不必停機直接拿一塊相

同型號正常的 I/O 高卡插入即可正常運作. (FAQ-093) 

CAN/CANopen 

可使用 COM1, COM3 ~ COM14 (*) 連接一顆 I-7530 (RS-232 轉 CAN 轉換器) 

來支持符合 CAN 與 CANopen 規約的設備與傳感器 (sensor). 一台 WP-8xx7 

最多可使用 10 個 RS-232 通訊埠來連接 10 個 I-7530. (FAQ-086)  

CANopen Master 
支持 I-8123W CANopen Master 板卡 來連接其它 CANopen Slave 設備. 

(FAQ-145) 

HART 解決方案 插槽 0 ~ 7 支援 I-87H17W 模組來與其他 HART 設備通訊. 

FTP Client   

支援 FTP Client, 可將 PAC 中的檔案上傳至遠端電腦上的 FTP Server. 

(FAQ-151) 

加 Soft-GRAF 的 g_Alarm 與 g_Logger1 HMI 元件也支持 FTP client. (FAQ-146) 

Soft-GRAF HMI 
支援 Soft-GRAF HMI. 可於電腦中使用 Soft-GRAF Studio 來設計 HMI 頁面, 並

將其下載至 PAC 中, 即可在 PAC 中顯示 HMI 畫面. (FAQ-146) 

選購 I/O 功能  (請參考 ISaGRAF PAC I/O 選型指南 I/O 模組列表) 
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PWM  

脈波輸

出 

高速 PWM 模

組 

I-7088, I-8088W, I-87088W: 8-ch. PWM 輸出, 軟體支持 1 Hz ~ 100 KHz (非連

續), 功率: 0.1 ~ 99.9% 

PWM (DO 模

組) 

最多 8 接點. 最快 250 Hz. Off=2, On=2 ms. 輸出方波: Off: 2 ~ 32766 ms, On: 2 

~ 32766 ms,  

可選用的輸出卡: I-8037W, 8041W, 8041AW, 8042W, 8050W, 8054W, 8055W, 

8056W, 8057W, 8060W, 8063W, 8064W, 8068W, 8069W. (Relay 型式的 DO 受

限於 Relay, 無法產生快速的脈衝) 

計數器, 

Encoder
,  

頻率量

測 

並列式 

(Parallel) DI 計

數器 

最多 8 接點. 計數值: 32-bit. 最快 250 Hz. 最小 ON 與 OFF 寬度必需 > 2 ms.  

可選用的輸入卡: I-8040W, 8040PW, 8042W, 8046W, 8048W, 8050W, 8051W, 

8052W, 8053W, 8053PW, 8054W, 8055W, 8058W, 8063W. 

串列式 (Serial) 

DI 計數器 

最快 100 Hz. 計數值: 0 ~ 65535 (16-bit).  

可選用的輸入卡: I-87040W, 87046W, 87051W, 87052W, 87053W, 

87053W-A5, 87054W, 87055W, 87058W, 87059W, 87063W. 

遠程 DI 計數

器 

所有遠程的 I-7K/I-87K DI 模組都支援計數器. 最快 100 Hz. 計數值: 0 ~ 

65535 . 

高速計數器 I-87082W: 最快 100 kHz, 32-bit;   I-8084W: 最快 250 kHz, 32-bit  

Encoder 

I-8093W: 3 軸之 Encoder 模組, Quadrant 輸入模式可達到 1 MHz 輸入頻率, 

Pulse/Direction 及 CW/CCW 輸入模 

                  式可達到 4 MHz 輸入頻率. (FAQ-112) 

I-8084W: 最大 250 kHz 之 4-ch Encoder, 可以為 pulse/direction 或 Up/Down 

或 A/B phase (Quad. mode), 不支 

                  持 Encoder Z-index. (FAQ-100) 

頻率量測 
I-87082W: 2-ch, 1 Hz ~ 100 kHz; I-87088W: 8-ch, 0.1 Hz ~ 500 kHz; 
I-8084W: 8-ch, 1 Hz ~ 250 kHz 

運動控

制  

馬達運動控制 

(Motion) 
可整合 1 或 多片 I-8092F (2 軸) 或 I-8094F/8094 (4 軸). 

* 注意: COM5 ~ COM14 位於 WP-8xx7 插槽 0~7 上選購的 COM 埠擴充卡中.  WP-8137/8147 沒有 

COM3 與 COM4. 

* ISaGRAF FAQ: www.icpdas.com > Support > FAQ > ISaGRAF Soft-Logic PAC > -中文-   

* 建議使用 NS-205/NS-208 或 RS405/RS408 (環狀式) 工業級乙太網路交換器. 

 
 
 
 

http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com.tw/product/solutions/industrial_ethernet_switch/switch_selection.html#b
http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html


                 WinPAC-8xx7 ISaGRAF PAC 快速上手手冊,  1.65 版,  2013 年 8 月     ICP DAS                        1-1 

第 1 章 典型的工程應用 

所有應用支援列表請參考網址 : www.icpdas.com > 商品目錄 > 解決方案 > Soft PLC, ISaGRAF & 

Soft-GRAF HMI > ISaGRAF 首頁 > 產品應用  

 

1.1 Soft-GRAF HMI 應用 : 建立多采多姿的 HMI 畫面  

 支援多樣化 HMI 元件:  

 頁面 (最多可建立 200 個頁面，支援密碼權限管制)  

 文字 (一般, 反白, 底線)  布林數值(一般, 反白, 閃爍) 

 訊息數值 (動態訊息, 多國語言顯示)  圖片(靜態, 動態, 布林圖片) 

 數值 (一般, 數值轉換, 達上下限值- 閃爍/ 換色/ 顯字)  移動軌跡圖 (1 軸, 2 軸) 

 按鈕(數值, 標題, 圖片, 權限管制, 執行前確認, 密碼控管)  登入/ 登出 

 趨勢圖 (即時趨勢圖, 歷史趨勢圖)  排程控制 

 長形錶頭 (垂直, 水平, 顯示刻度, 單向, 雙向)  弧形錶頭 

 資料記錄器 (記錄成File, 可匯出至USB隨身碟或FTP上傳)  警報列表 

 內建多種元件 (Button, Gif, LED... 陸續增加中)  

 支援多國語言: 英文，繁體中文，簡體中文， 俄文等。 

 支持 User 自己設計的圖形，比如 JPG, PNG ...。 

 更多資訊: 第 2.5 章 與  www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC > 
FAQ-146 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/isagraf_tc.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/isagraf_tc.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download_tc.html#manu
http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
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1.2 eLogger HMI 人機介面應用 

 
 eLogger 是 易學易用 多功能 的 HMI 人機介面開發工具. 泓格科技免費提供給產品使用者, 

用以設計人機介面的圖形與控制元件等項目.  

 
 建議使用 Soft-GRAF HMI, 效能會好很多, 參考第2.5節 

 
 詳細的程式設計等資訊, 請參考 www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF 

Soft-Logic PAC >  FAQ-115. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/faq/isagraf/115_c.htm
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1.3 通訊備援 (冗餘)系統 – 中央與地區控制站 

 
 更多資訊:  www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC  - 119 .  

 
 可採用 RS-485 或 乙太網路 通訊備援機制與應用. 

 
 適用於 XP-8xx7-CE6、XP-8xx7-Atom-CE6、WP-8xx7 與 VP-2xW7/4xx7 型號 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/faq/isagraf/119_c.htm
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1.4 備援 (冗餘) 系統 - 搭配 Ethernet I/O 

 若其中一個乙太網路斷線或損毀, 備援 (冗餘) 控制器將會使用另一條網路來處理網路 

(Ethernet) I/O 與資料交換 

 掃描 Ethernet I/O 比掃描 RS-485 I-7000 或 I-87K I/O 更加快速 

 更多資訊:   www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC – 093 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.5 備援(冗餘)系統 – 搭配 RS-485 I/O 

 若 WP-8xx7 的其中一個網路損毀, 另一個仍會維持運作. 

 若其中一台控制器當機, 另一台會接手來控制 RS-485 I/O. 

 PC/HMI 可透過 1 或 2 個 Active IP 來連接此備援(冗餘)系統.. 

 更多資訊列於www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC  - 093, 125, 

138  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf/093_c.htm
http://www.icpdas.com/
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf/093_c.htm
http://www.icpdas.com/faq/isagraf/125_c.htm
http://www.icpdas.com/faq/isagraf/138_c.htm
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1.6 Modbus Master : RTU, ASCII, RS-232/485/422 

 
 最多可支援 10 個埠 : COM1~COM4 及 COM5~COM14 (若 I-8112iW/ 14W/ 14iW/ 42iW/ 

44iW 插於擴充槽 0~2) 

 可連接到 Modbus PLC 或 M-7000 I/O 或 Modbus 設備 (電力量測器, 溫度控制器, 變頻器…) 

 
 

 
 
 
 
 
 
 
 

 

1.7 Modbus Master : TCP/IP 

 
 每台 WP-8xx7 最多可以連接 100 個 Modbus TCP/IP slave 設備. 

 可連接各類有支持標準 Modbus TCP/IP Slave 通訊協議的設備 

 更多資訊請見 www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC > 中文 – 

113  
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

http://www.icpdas.com/
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf/113_c.htm
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1.8 Modbus Slave : RTU/TCP  

   
 Modbus RTU (RS-232/485/422): 最多可連接 5 個埠 

 Modbus TCP/IP: 最多可支援 32 個連結 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.9 與其他 TCP/IP Server 或 UDP Client/Server 設備通訊 
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1.10 多重網路人機介面 (Web HMI) – 隨處監控! 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.11 傳送攜帶附件檔案的 Email 

 
 更多資訊列於  www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC  - 067 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

http://www.icpdas.com/
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf/067_c.htm
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1.12 資料記錄器 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

1.13 遠程 I/O 應用 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

藉由 ftp或Web HMI 來載入儲存於 WP-8xx7 的 Flash 

Disk 或 microSD 卡 的資料檔案. 
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1.14 SMS: 簡訊服務 

 可傳送各國文字(如: 中文, 英文...或其他) 或 傳送/接收純文字(pure text) 

 更多資訊: www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC - 111 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.15 當成遠程 I/O 模組的 Modbus 轉換器 

 有 Ethernet port 的 ISaGRAF PAC: 

可用來當成遠程 I/O 模組的 Modbus RTU 與 Modbus TCP/IP 通訊協定轉換器. 

 

 無 Ethernet port 的 ISaGRAF PAC: 

可用來當成遠程 I/O 模塊的 Modbus RTU 通訊協定轉換器. 

 

 
 
 

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/faq/isagraf/111_c.htm
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1.16 運動控制 

 1 個 I-8091W 可控制 2 軸: X-Y 軸, 或 2 軸獨立 

 2 個 I-8091W 可控制 4 軸: X-Y 軸 + 2 軸獨立, 或 4 軸獨立 

 Encoder 模組:    

I-8084W: 4-axis, 不支持 Z-index 

I-8090W: 3-axis 
I-8093W: 3-axis 

 
 
 
 
 
 
 
 
 
 

1.17 建物應力量測應用 

   
 請參見 www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC  - 091, 128 

 

 
 
 
 

http://www.icpdas.com/
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf/091_c.htm
http://www.icpdas.com/faq/isagraf/128_c.htm


                 WinPAC-8xx7 ISaGRAF PAC 快速上手手冊,  1.65 版,  2013 年 8 月     ICP DAS                        1-11 

1.18 快速 FRnet 遠程 I/O 

 FRnet I/O 的優點: I/O 掃描快速, 只需約 3 ms/scan (需依據程式的 PLC 掃描時間, 例: 當

SaGRAF PLC 程式的掃瞄時間約為 9 ms 時, 則所有的掃描時間是 9 ms, 而不是 3 ms.) 

 FRnet I/O 有支援 DI, DO, AI 與 AO 模組. 

 更多資訊請見 www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC - 082, 154  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.19 整合 CAN/CANopen 設備與傳感器 

 WP-8xx7 最多可支援 10 台 I-7530 (RS-232 轉 CAN 轉換器) (FAQ-086) 

 另外也有支持 I-8123W CANopen master 卡片請參訪 FAQ-145 

 更多資訊:  www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC  - 086, 145 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/faq/isagraf/082_c.htm
http://www.icpdas.com/faq/isagraf/154_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf/086_c.htm
http://www.icpdas.com/faq/isagraf/145_c.htm
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1.20 VIP 通訊安全 

 可為 Modbus TCP/IP 作安全設定 (VIP: Very Important IP) 

 
 
 
 
 
 
 
 
 
 
 
 
 

1.21 ISaGRAF PAC 連接 PM-2133/2134 智能電表 

 支援 Modbus 標準通訊協定，應用彈性大，可開多個 RS-485 通訊埠來連接多台 PM-213x 

智能電表。 

 PM-213x 系列為一輕薄短小之三相(單相)功能性智慧電表，具備基本電力參數量測、監測

及通訊功能，與 ISaGRAF PAC 搭配，可應用於各種需求智慧型電力量測的監控系統。 

 更多資訊:  www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC - 129 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf/129_c.htm
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1.22 ZigBee 無線通訊應用 

 
 ISaGRAF PAC 加上 ZB-2550P 與 ZB-2551P  這兩個無線通訊轉 RS-232 / RS-485 Converter 可

以無線傳輸, 降低佈線成本並可達到遠距離控制 I/O 模塊或進行資料收集的目地. 

 更多資訊:  www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC  - 110  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
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1.23 GPS 應用: ISaGRAF PAC 加上 I-87211W 或 GPS-721 

 
 WP-8xx7, VP-2xW7/4xx7, iP-8xx7, μPAC-7186(P)EG 支持一塊 I-87211W 卡於 slot 0 到 7 或 

I-87211W 與 GPS-721 模組的 RS-485 遠程 GPS I/O 

 可用於 自動對時 與 取得當地的經緯度座標 

 更多資訊:  www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC– 107 

 GPS receivers 網頁: www.icpdas.com > Products > Wireless..... > GPS receiver  

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/products/GSM_GPRS/wireless/solutions.htm#5
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1.24 透過 Ebus 交換資料 

 
 Ebus (Ethernet 網路) 

每台 ISaGRAF PAC 可使用它的乙太網路連接埠, 並透過 Ebus 通訊機制來相互交換資料. 

當 PC 藉由乙太網路與控制器對話時, 控制器也可以經由同一乙太網路與其他的控制器交

換資料; 此方式使得配置更加地靈活與快速. 

 
 注意: XP-8xx7-CE6/8xx7-Atom-CE6, WP-8xx7, VP-2xW7/4xx7 不支援 Fbus. 

 
 

 
 
 
 
 
 
 
 
 
 

1.25 偵測 I-87K 高卡 I/O 之熱插拔 (Hot-Swap) 狀況 

 
 在 ISaGRAF Workbench 軟體中, 您必須正確地將 I/O 卡連結到 "I/O connection" 視窗並選

用 "io_state" 卡來即時的觀察 I/O 的狀態. 當您熱插拔 I-87K (高卡) I/O 時, 將有訊息顯示

在 ISaGRAF PAC 的控制面板上 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

http://www.icpdas.com/products/PAC/common_file/application-notes-c.htm#ap-f_ebus
http://www.icpdas.com/products/PAC/common_file/application-notes-c.htm#ap-f_ebus
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1.26 資料庫應用 

 
 支援 SQL Client 功能可以連接後台的 Microsoft SQL Server (2000 SP3, 2005, 2008 或相容版

本) 來進行資料的寫入或讀取. 

 一台控制器 (PAC) 最多可連接 4 台 Server. 

 依據不同的型號, 控制器可支援多國語言, 包含: 繁體中文(台灣)、簡體中文、英文、法文、

德文、義大利文、葡萄牙語、俄語、西班牙語 與其它語言. 

 整合 機械 - 商務 自動化應用，跨越工業與商用領域. 

 更多資訊:   www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC – 135 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

http://www.icpdas.com/products/PAC/common_file/application-notes-c.htm#ap-f_ebus
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf/135_c.htm
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1.27 HART 解決方案 

 
 ISaGRAF PAC 可支援 I-87H17W 模組來與其他 HART 設備通訊. (Driver 版本- XP-8xx7-CE6: 

1.15 起 ; WP-8xx7: 1.35 起 ; VP-2xW7: 1.27 起) 

 ISaGRAF PAC 支援 I-87H17W 插在控制器上的 I/O 插槽 (XP-8xx7-CE6: 插槽 1 ~ 7 ; WP-8xx7: 

插槽 0 ~ 7 ; VP-2xW7/4xx7: 插槽 0 ~ 2), 但不支援 I-87H17W 插在 RS-485 遠程 I/O 擴充單元

上. 

 I-87H17W 有 8 個 AI 通道, 可量測 4 ~ 20 mA, 也可當成 8-ch 的 HART 通訊串口. 

 更多資訊:   www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC – 136 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf/136_c.htm
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1.28 2G/3G 無線傳輸應用 

 

 XP-8xx7-Atom-CE6, XP-8xx7-CE6, WP-8xx7, VP-2xW7/4xx7, WP-5xx7 搭配 2G/3G 無線傳輸

數據機，可與遠端的 Server 進行資料傳輸應用. 

 請點選 www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC - 143, 151, 153  

取得更多資訊. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/faq/isagraf/143_c.htm
http://www.icpdas.com/faq/isagraf/151_c.htm
http://www.icpdas.com/faq/isagraf/153_c.htm
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1.29 連接 DL-100TM485 測量濕度與溫度值 

 
 更多資訊:   www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC – 156 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf/156_c.htm
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第 2 章 軟體安裝 與 Soft-GRAF HMI 設計 

有關 ISaGRAF 與 Soft-GRAF HMI 人機介面應用的設計資訊, 請參考 第 2.5 節. 

有關 ISaGRAF 與 eLogger HMI 人機介面應用的設計資訊, 請參考 第 2.4 節. 
 

WinPAC-8xx7 或 WP-8xx7 為 WP-8147/8447/8847/8137/8437/8837 的簡稱 

WinPAC-8xx6 或 WP-8xx6 為 WP-8146/8446/8846/8136/8436/8836 的簡稱 
 
 
 

重要:  

1. WP-8xx7/8xx6 的 插槽 0 ~ 插槽 7 只支援 高卡的 I-8K 與 I-87K I/O 模組。 

請參考 WP-8xx7 光碟: \napdos\isagraf\wp-8xx7\chinese_manu\   datasheet pdf 檔案 

2. WP-8xx7 需設定為固定 IP 位址. (不可使用 DHCP)。 

3. 如果不使用 WP-8xx7 的 LAN2, 需將 LAN2 設定為 Disable (請參考 附錄 D)。 

4. 建議使用工業級乙太網路交換器 NS-205/208 或 RS-405/408 來連接 PAC。 
 

詳細資料請參考 WP-8xx7 CD 光碟裡的 ISaGRAF 進階使用手册:  

\napdos\isagraf\wp-8xx7\Chinese_manu\ "chinese_user_manual_i_8xx7.pdf”  
 

注意:   

 WP-8xx7/8xx6 預設為支援 ISaGRAF 程式設計與網路人機介面(Web HMI)。 

 WP-8xx7 可以同時使用 ISaGRAF 與 [EVC++ 4.0 或 VS.net 2008] 來程式設計，設計方法請參

閱 第 6 章 或 第 7 章。 

 
 
 
 

2.1 步驟 1 – 安裝 ISaGRAF 

使用者需至少安裝以下 2 樣軟體, 之後才能設計 WP-8xx7 控制器系統 : 
 

 A. ISaGRAF Workbench  
 B. ICP DAS Utilities For ISaGRAF 
 

使用者至少需購買一套 ISaGRAF Workbench (3.4x 或 3.5x 版本 ISaGRAF-256-E 或 ISaGRAF-256-C 

或 ISaGRAF-32-E 或 ISaGRAF-32-C) 安裝在 PC 上，才能進行程式的編輯、下載、監看及除錯。

項目(B)是免費的，附於 WP-8xx7 包裝盒內的 CD 中。 

 
系統需求: 

在安裝 ISaGRAF 作業平台前，您必須先安裝以下任何一種作業系統 : 

 Windows 98 或 Windows 2000 或 Windows XP 

 Windows NT Version 3.51 或 Windows NT Version 4.0 

 Windows Vista 或 Windows 7 (請參考 FAQ-117 或 2.1.4 節 /2.1.5 節 ) 

 

http://ftp.icpdas.com/pub/cd/wincon_isagraf/napdos/isagraf/wincon/chinese_manu/faq117_chinese.pdf
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安裝 ISaGRAF 作業平台 : 

 
 使用 Windows Vista 或 Windows 7 (32-bit)，請先參考 2.1.4 節。 

 使用 Windows 7 (64-bit) 作業系統，請先參考 2.1.5 節。 

 
 
1. 將 ISaGRAF 軟體光碟片放入光碟機中，通常具有自動執行程式功能的電腦將自動執行 

"install.bat" 檔。(如果您的電腦並不支援此項功能，您可以開啟檔案管理員，執行光碟機

目錄下的 "install.bat" 檔。如果無法找到此檔，您可執行 "ISaGRAF.exe" 開始安裝程序。) 

 
2. 當您執行 "install.bat" 檔後將出現如下的對話畫面，請選擇您想使用的語言版本，本書將

以英文版作為範例, 建議安裝英文版。 

 

   
 
3. 安裝完成後，請點選左下角的 [開始] > [程式集]，依照下列畫面即可啟動 ISaGRAF。 

 

 
 
  

選取想安裝的語言. 

建議安裝英文版, 本書以英文版作

為範例 
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2.1.1 保護鎖注意事項 : 

 
您必須安裝 ISaGRAF 提供的硬體保護鎖(dongle:安裝於電腦的並列埠)或 USB 保護鎖(ISaGRAF 

3.51 版起使用)，安裝完成才能使用 ISaGRAF 所有的功能。(ISaGRAF-32-E 或 ISaGRAF-32-C 不需

保護鎖) 

 
請執行 ISaGRAF 的 [Help] > [About] 查看安裝是否正確，若出現 "Maximum number of IO 

variables: 32" 表示 ISaGRAF 找不到保護鎖，請確認安插正確，重新開啟電腦，再查看一次。 

 
 

 
 
 
 
 
 
 
如果仍然出現 "Maximum number of IO variables: 32"，表示保護鎖的驅動程式沒有安裝成功，

請依保護鎖型態執行下列步驟。 

 
Dongle 型保護鎖: 

請執行下列驅動程式(位於 ISaGRAF 光碟)，然後將電腦重新開機:  

 ISaGRAF-80 版本:   \Sentinel5382\setup.exe  

 其他 ISaGRAF 版本:  \Sentinel\setup.exe 

 
USB 型保護鎖: 

1.安裝 ISaGRAF 軟體後，請先暫時取下 USB 保護鎖，執行 ISaGRAF 3.51~3.55 光碟裡的程式 

"\Sentinel\ SSD5411-32bit.exe"，然後重新開機。 

2.之後, 執行 ISaGRAF時, 皆需插上 USB保護鎖。 

 

2.1.2 Windows NT 使用者的注意事項 : 

 
如果您使用 Windows NT 作業系統，您需要在 ISaGRAF 作業平台下的子目錄 "EXE" 內的 

"isa.ini" 檔內加入一行 "NT=1"。如果您將 ISaGRAF 安裝在 C 硬碟，您會在下面路徑找到該檔 : 

C:\isawin\exe\isa.ini 
 
您可以使用任何 ASCII 文字編輯器 (例如 Notepad 或 UltraEdit32) 開啟 "isa.ini"，找到 [WS001] 

標頭 (應該在檔案的最上方)，在 [WS001] 部分的任何位置加入一行 "NT=1"，為了 RS-232 通訊

能正常運作，"NT=1" 這行敘述一定要加入。如下 : 

 
[WS001] 

NT=1 

Isa=C:\ISAWIN 
IsaExe=C:\ISAWIN\EXE 
Group=Samples 
IsaApl=c:\isawin\smp 
IsaTmp=C:\ISAWIN\TMP                                     
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2.1.3 Windows 2000 使用者的注意事項 : 

 
如果您使用 Windows 2000 作業系統，在關閉某些 ISaGRAF 視窗時，有些電腦會出現停滯 

20~40 秒 (沒有反應) 的現象。可能是 Windows 2000 裡 "CTFMON.EXE" 程式的關係。 

 
發生視窗停滯問題的處理方法: 

 
您可以同時按住鍵盤的 “Ctrl” + 

“Alt” + “Del”，出現如下畫面，請依

照下圖指示，結束 "CTFMON.EXE" 

的處理程序。 

 
 
 
 
 
 
 
 
 
解決視窗停滯問題的方法: 

 
為 "ISaGRAF project manager" 建立一個捷徑, 並在捷徑的設定視窗中選取 "run in separate 

memory space" 的選項設定。 
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2.1.4 Windows Vista 或 Windows 7 (32-bit) 使用者的注意事項 

 
安裝 ISaGRAF 軟體之前，若您使用的是 Windows Vista 或 Windows 7 (32-bit) 作業系統，為了

避免部分安裝的限制，請先變更使用者帳戶控制設定。 

 
 
如何關閉使用者帳戶控制 ? 

 
此設定須具備系統管理員的權限。 

 
1. 請於 [開始] > [控制台] > [使用者帳戶和家庭安全] > [使用者帳戶] > 點選 [開啟或關閉使用

者帳戶控制] 或 [變更使用者帳戶控制設定]。 
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2. 點選後，將出現以下的畫面。 
 

Windows Vista: 
畫面中標識的地方不要打勾，最後按下 “確定” 鍵。 

 
 
 
 
 
 
 
 
 
 
 
 
 
Windows 7: 
 
將畫面中的橫桿移至 “不要通知”，最後按下 “確定” 鍵。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. 請重新啟動電腦。 

4. 電腦重新開機後，請參考 章節 2.1 安裝 ISaGRAF。 
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2.1.5 Windows 7 (64-bit) 使用者的注意事項 

 
若您使用 Windows 7 (64-bit) Professional/Enterprise/Ultimate 作業系統, 則須在 XP Mode 下才

可安裝 ISaGRAF 軟體。請先執行以下步驟來安裝 Virtual PC 和 XP Mode。 

 
安裝 Virtual PC 和 XP Mode: 

1. 請從 Windows Virtual PC 網站 (http://go.microsoft.com/fwlink/?LinkID=160479) 下載 

Windows Virtual PC 與 Windows XP Mode 的安裝程式。 

2. 滑鼠雙擊“WindowsXPMode_nn-NN.exe” (此處的 nn-NN 代表語言環境，例如 en-US)，並

依照安裝精靈的導引完成 Windows XP Mode 安裝。 

3. 滑鼠雙擊 “Windows6.1-KB958559-x64.msu”，安裝 Windows Virtual PC。 

4. 重新啟動電腦。 

5. 請依序點選電腦 [開始] > [所有程式] > [Windows Virtual PC]，開啟 [Windows XP Mode]。 

6. 依照導引精靈完成 Windows XP Mode 的設定。請記得一定要將安裝過程中提供的密碼記

錄下來，因為您需要此密碼來登入虛擬機器。 

7. 請回到章節 2.1 來安裝 ISaGRAF。  

 
 
 
 

2.1.6 使用 Variable Arrays 變數陣列的注意事項 

 

使用 Variable Arrays 變數陣列的設定如下 
 

使用變數陣列必須在 c:\isawin\exe\isa.ini 檔案的最前端加入兩行程式碼: 

 
 

[DEBUG] 
Arrays=1 

 
 

  

http://go.microsoft.com/fwlink/?LinkID=160479
http://go.microsoft.com/fwlink/?LinkID=160479
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2.2 步驟 2 – 安裝 ICP DAS Utilities For ISaGRAF 

“ICP DAS Utilities For ISaGRAF” 包含 3 個主要項目 

 
 I/O libraries (適用所有 ICP DAS ISaGRAF 控制器) 

 Modem_Link utility  
 Auto-scan I/O utility 

 
注意: 

 
安裝“ICP DAS Utilities For ISaGRAF” 之前必須先安裝 ISaGRAF Workbench，請確認您已安裝 

ISaGRAF 軟體 (請參考 2.1:步驟 1 安裝完成後, 再繼續下列步驟。) 

 
您手中的 ICP DAS CD-ROM 內包含您所需要的 ICP DAS Utilities For ISaGRAF，請將此 CD-ROM 放

入光碟機內，以下詳細的步驟將引導您完成安裝。 

在 CD-ROM 內的 \napdos\isagraf\ 目錄, 請執行 "setup.exe"。 

 

 
 
注意 : 

如果您沒有 ICP DAS CD-ROM 或找不到 "\napdos\isagraf\setup.exe",  請參考網站

www.icpdas.com > 商品目錄 > 解決方案 > Soft PLC, ISaGRAF & Soft-GRAF HMI > ISaGRAF 首頁 > 

驅動程式  下載 " io_lib.zip ", 請將檔案儲存於 C:\ 下, 以確保檔案完整的存取 

 

  

http://www.icpdas.com/
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/isagraf_tc.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download/isagraf-link.html
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2.3 步驟 3 – 安裝網頁編輯軟體 
 

這個步驟您可以自行決定安裝的選項，如果您熟悉 HTML 設計，也許並不需要安裝，您可以

使用任何文字編輯程式來建立網頁，例如: Windows 2000 或 XP 的 “記事本”。 
 

本手冊的範例是使用微軟公司的 “Microsoft Office FrontPage 2003” (或更新版本) 來建立網

頁。 
 

使用者可以選擇自己喜愛的網頁編輯軟體來完成同樣的設計。 
 
 

2.4 eLogger HMI 與 ISaGRAF 軟邏輯設計 

 
泓格科技的 eLogger 是 易學易用 多功能 的 HMI 人機介面開發工具. 免費提供給產品使用者, 

用以設計人機介面的圖形與控制元件等項目. (建議使用 Soft-GRAF HMI, 效能會好很多, 參考

第 2.5 節.)" 

 
eLogger HMI 與 ISaGRAF 軟邏輯 的應用 可使用於下列 PAC 產品: 

 WP-8147 / 8447 / 8847 
 WP-8137 / 8437 / 8837 
 VP-25W7 / 23W7 / 4137 / 4147 
 XP-8047-CE6 / 8347-CE6 / 8747-CE6 
 

詳細的程式設計等資訊, 請參考 ISaGRAF PAC FAQ-115。 

 www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC >  FAQ-115 : 開發 eLogger 

HMI 加上 ISaGRAF SoftLogic 一起應用於 WP-8xx7, VP-2xW7/4xx7 與 XP-8xx7-CE6 等 PAC 內. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

http://www.icpdas.com/
http://www.icpdas.com/faq/faq_c.htm
http://www.icpdas.com/faq/faq_c.htm
http://www.icpdas.com/faq/faq_c.htm
http://www.icpdas.com/faq/isagraf/115_c.htm
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2.5 Soft-GRAF HMI 與 ISaGRAF 軟邏輯設計 

 

Soft-GRAF 是泓格科技開發的 HMI 軟體，可以讓使用者建立 HMI 畫面，並在同一台 PAC 內與

ISaGRAF 軟邏輯程式一起運行，PAC 有了 Soft-GRAF 的支持，使用者就可以用 Soft-GRAF Studio 

來開發 HMI 畫面，並搭配 ISaGRAF 來寫控制邏輯。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

特色 

 支援多樣化 HMI 元件:  

 頁面 (最多可建立 200 個頁面，支援密碼權限管制)  

 文字 (一般, 反白, 底線)  布林數值(一般, 反白, 閃爍) 

 訊息數值 (動態訊息, 多國語言顯示)  圖片(靜態, 動態, 布林圖片) 

 數值 (一般, 數值轉換, 達上下限值- 閃爍/ 換色/ 顯字)  移動軌跡圖 (1 軸, 2 軸) 

 按鈕(數值, 標題, 圖片, 權限管制, 執行前確認, 密碼控管)  登入/ 登出 

 趨勢圖 (即時趨勢圖, 歷史趨勢圖)  排程控制 

 長形錶頭 (垂直, 水平, 顯示刻度, 單向, 雙向)  弧形錶頭 

 資料記錄器 (記錄成File, 可匯出至USB隨身碟或FTP上傳)  警報列表 

 內建多種元件 (Button, Gif, LED... 陸續增加中)  

 支援多國語言: 英文，繁體中文，簡體中文， 俄文等。 

 支持 User 自己設計的圖形，比如 JPG, PNG ...。 
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相關參考連結: 

 

 更詳細的內容, 請見 FAQ 146 : 

www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC - 146 

Soft-GRAF Studio V.x.xx 軟體與文件: 在 ISaGRAF WinCE PAC 建立多采多姿的 HMI 畫面 

 

 以下為支持 Soft-GRAF 的 ISaGRAF PAC 與 Driver 版本: 

 
PAC 型號 ISaGRAF Driver 版本 

XP-8xx7-CE6 從 1.41 版起 

XP-8xx7-Atom-CE6 從 1.02 版起 

WP-8xx7 從 1.61 版起 

WP-5147 從 1.07 版起 

VP-2xW7/4xx7  從 1.53 版起 
 
 

最新的 ISaGRAF Driver 版本:  

http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download/is
agraf-link.html . 
 
www.icpdas.com > > Product > Solutions > Soft PLC, ISaGRAF & Soft-GRAF HMI > ISaGRAF > ISaGRAF 

Download List 
 
 
 
 
 
 

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/faq/isagraf/146_c.htm
http://www.icpdas.com/faq/isagraf/146_c.htm
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download/isagraf-link.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download/isagraf-link.html
http://www.icpdas.com/
http://www.icpdas.com/root/product/solutions/solutions.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/softplc_based_on_pac_products.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/isagraf.html
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第 3 章 安裝 Web HMI 範例程式 

WinPAC-8xx7 或 WP-8xx7 為 WP-8147/8447/8847/8137/8437/8837 的簡稱. 

WinPAC-8xx6 或 WP-8xx6 為 WP-8146/8446/8846/8136/8436/8836 的簡稱. 

 
重要:  

1. WP-8xx7/8xx6 的 插槽 0 ~ 插槽 7 只支援 高卡的 I-8K 與 I-87K I/O 模組。  

請參考 WP-8xx7 CD: \napdos\isagraf\wp-8xx7\chinese_manu\  Datasheet PDF 檔案 

2. WP-8xx7 需設定為固定 IP 位址。 (不可使用 DHCP) 

    建議使用工業級乙太網路交換器 NS-205/208 或 RS-405/408 來連接 PAC。 

3. WinPAC 插槽 0 位於最左邊。 

 

3.1 Web HMI 範例程式列表 

 
Web HMI 範例程式資料夾:  WP-8xx7 光碟: \napdos\isagraf\wp-8xx7\wp_webhmi_demo\ 

ftp://ftp.icpdas.com/pub/cd/winpac-8xx7/napdos/isagraf/wp-8xx7/wp_webhmi_demo/  
 
專案範例資料夾:  WP-8xx7 光碟: \napdos\isagraf\wp-8xx7\demo\ 

 
範例程式表: 

程式名稱 說明 搭配使用的 I/O 模組 

sample Web HMI 範例 無需搭配 I/O 模組 

example1 第 4 章的範例 插槽 0: I-87055W 

wphmi_01 顯示控制器的日期與時間 無需搭配 I/O 模組 

wphmi_02 DI 與 DO 範例 插槽 0: I-87055W 

wphmi_03 讀/寫 Long, float 與 Timer 值 無需搭配 I/O 模組 

wphmi_04 讀/寫控制器的字串(String) 無需搭配 I/O 模組 

wphmi_05 多頁範例: 頁面選單在左方 插槽 0: I-87055W 

wphmi_05a 多頁範例: 頁面選單在上方 插槽 0: I-87055W 

wphmi_06 AI/AO 範例，於 ISaGRAF 的轉換 
插槽 2: I-87024W 

插槽 3: I-8017HW 

wphmi_07 AI/AO 範例，於 PC 的轉換 
插槽 2: I-87024W 

插槽 3: I-8017HW 

wphmi_08 下載控制器裡的檔案到 PC  插槽 0: I-87055W 

wphmi_09 於 PC 彈出警報視窗 插槽 0: I-87055W 

wphmi_11 趨勢圖 
插槽 2: I-87024W 

插槽 3: I-8017HW 

wphmi_12 
記錄 I-8017HW 每隔 50 微秒 1 ~ 8 通道的電壓，並以

微軟 Excel 軟體繪出趨勢圖 

插槽 3: I-8017HW 

插槽 2: I-8024W 

wphmi_13 
記錄 I-8017HW 每隔 10 微秒 1 ~ 4 通道的電壓，並以

微軟 Excel 軟體繪出趨勢圖 

插槽 3: I-8017HW 

插槽 2: I-8024W 

 
 

ftp://ftp.icpdas.com/pub/cd/winpac-8xx7/napdos/isagraf/wp-8xx7/wp_webhmi_demo/
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3.2 安裝 Web HMI 範例程式的步驟 

3.2.1 步驟 1 – 硬體安裝 

 
A. 請準備一台 WP-8147/8447/8847 控制器，並在 0 槽 插上 I-87055W 模組 

 
如果您沒有 I-87055W (8 輸入及 8 輸出的模組)，請依同樣步驟設定，但您的網路人機介面範

例程式請使用範例檔 “wphmi_01”，而非 “wphmi_05”。 

 
B. 準備 VGA 螢幕、USB 滑鼠、乙太網路線各一份，並連接到 WP-8xx7。  

(以 VGA 螢幕右下方的軟體鍵盤為鍵盤) 

 
C. 啟動 WP-8xx7 控制器. 

 
 

3.2.2 步驟 2 – 設定網路選項 

 
A. 請參考 附錄 A.3 為 WinPAC 設定一組 固定 IP。 (不可使用 DHCP) 

 
B. 勾選 “Web” 頁面的 “Enable Web HMI” 選項，然後點選下方 “Setting” 按鈕，勾選 “Enable 

Account Security” 選項，再點選 “Edit” 來設定 (使用帳號 , 密碼). 最後記得點選 “OK” 離開。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
注意:  若沒有勾選 “Enable Account Security”，任何使用者都能輕易地透過網際網路操控您的 

PAC 控制器 ! 
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3.2.3 步驟 3 – 下載 ISaGRAF 專案  

 
請下載 ISaGRAF 專案 “wphmi_05” 到 WP-8xx7。 

此專案放置於 WP-8xx7 光碟:\napdos\isagraf\wp-8xx7\demo\ “wphmi_05.pia” 

 
“wphmi_05” 範例需要搭配一個 I-87055W 模組。若您沒有 I-87055W (8 輸入及 8 輸出 I/O 板卡)，

請下載 “wphmi_01” (光碟:\napdos\isagraf\wp-8xx7\demo\ “wphmi_01.pia”) 

 
如果您知道如何將 “wphmi_05.pia” 回存到 ISaGRAF Workbench 以及如何下載到控制器，請直

接跳到 3.2.4 節。在下列步驟之前，請確認電腦已經安裝 ISaGRAF Workbench。( 2.1 & 2.2 節) 

 
備份與回存 ISaGRAF 專案的步驟 : 

 
使用者可使用 ISaGRAF 提供的程式備份工具，將專案備份到磁碟片或指定的檔案路徑。有時

可能會想將 ISaGRAF 程式壓縮成一個檔案然後傳送給別人，比如 email 到 service@icpdas.com 

尋求技術支持。 

 
備份 ISaGRAF 專案 

 
在 "ISaGRAF Project Management" 視窗 

1. 以滑鼠點選 [Tools] > [Archive] > [Projects]，開啟 [Archive] 視窗 

2. 可以滑鼠點選 "Browse" 尋找將存放備份專案的目錄位置 (例如: C:\Demo) 

3. 選取 "Workbench" 中所要備份的專案名稱 

4. 按下"Backup" 即可備份到前面所選取的目錄位置 (例如: \Demo\example1.pia) 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

檔案備份位置 

2. 尋找與變更檔案

備份位置 

勾選可壓縮檔案 

3.選取欲備份檔案 

4. 進行備份 

1. 開啟 [Archive] 視窗 
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回存 ISaGRAF 專案 

 
回存之前備份的檔案，同樣在 "ISaGRAF Project Management" 視窗，執行備份專案的前兩個步

驟後 : 

1. 選取 "Archive" 中所要回存的專案名稱 

2. 按下 "Restore" 即可從指定的目錄位置回存專案到 ISaGRAF 內 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.2.3.1  下載 ISaGRAF 專案到控制器的步驟 

 
滑鼠雙擊 “wphmi_05” 以開啟專案，然後點選 “Link setup” 按鈕。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.選取欲回存檔案(點

選 “Browse” 可轉換目

錄) 

2. 進行回存 
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點選 “Setup” 並輸入您 WinPAC 控制器的 IP 位址， “Port number” 固定設為 502。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
請點選 “Debug” 按鈕來下載 “wphmi_05” 專案到 WP-8xx7。目前若有其他程式連線中，請先點

選 “Stop application ” 按鈕停止原先的程式。再點選 “Download” 下載專案到 WinPAC 控制器。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

若下載的程式尚未編譯，請按 

編譯按鈕 “Make application 

code” 產生編譯碼，再 

“Debug”。 
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3.2.4 步驟 4 – 下載網頁到 WinPAC 

 
A. 請複製光碟裡下列資料夾的所有檔案 ( 光碟: 

\napdos\isagraf\wp-8xx7\wp_webhmi_demo\wphmi_05\ *.* ) 到 WP-8xx7 控制器中  

( \Miscro_SD\Temp\HTTP\WebHMI\ ) 
 
範例 “wphmi_05” 需在 WinPAC 插槽 0 搭配一個 I-87055W 模組。若您沒有 I-87055W (8 輸入及 

8 輸出 I/O 板卡)，請下載 “wphmi_01” 。 

 
B. 一旦修改或重新複製網頁，請執行 “rs_wphmi.exe” 重新設定 Web 伺服器。 

每次修改 WP-8xx7 中 \Micro_SD\Temp\HTTP\WebHMI\ 資料夾裡的任何檔案，都必須重

新執行 “rs_wphmi.exe” 。 

 
 
 
 
 
 
 
 
 
 
 

3.2.5 步驟 5 – 展示 Web HMI  

 
請執行 Internet Explorer (6.0 或更高版本)，輸入你的 WP-8xx7 的 IP 位址。例如:  192.168.1.232   

或   http://192.168.1.232   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://192.168.1.232/
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第 4 章 建立 Web HMI 範例 

本章說明如何建立一個 ISaGRAF 專案及該專案的 Web HMI 人機介面。 

WinPAC-8xx7 或 WP-8xx7 為 WP-8147/8447/8847/8137/8437/8837 的簡稱. 

WinPAC-8xx6 或 WP-8xx6 為 WP-8146/8446/8846/8136/8436/8836 的簡稱. 

 
 
 
 
重要:  

 
1. WP-8xx7/8xx6 的 插槽 0 ~ 插槽 7 只支援 高卡的 I-8K 與 I-87K I/O 模組。 

請參考 WP-8xx7 光碟: \napdos\isagraf\wp-8xx7\chinese_manu\   datasheet pdf 型錄 

 
2. WP-8xx7 需設定為固定 IP 位址. (不可使用 DHCP)。 

 
3. 建議使用工業級乙太網路交換器 NS-205/208 或 RS-405/408 來連接 PAC。 

 
詳細資料請參考 WP-8xx7 CD 光碟裡的 ISaGRAF 進階使用手册第 2.1 節 :  

  \napdos\isagraf\wp-8xx7\Chinese_manu\ "chinese_user_manual_i_8xx7.pdf”  
 
WP-8xx7 也可以同時使用 ISaGRAF 與 (EVC++ 4.0 或 VS.net 2008)來程式設計，設計方法請參閱 

第 6 章或 第 7 章。 
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4.1 撰寫一個簡單的 ISaGRAF 程式 

接下來要在 ISaGRAF Workbench 撰寫一個簡易的 ISaGRAF 程式, 並且要將此程式下載到

WP-8xx7(插槽 0 插著 I-87055W I/O 卡)控制器內去執行。 如果您尚未在您的 PC 上安裝 

"ISaGRAF" 及 "ICP DAS Utilities for ISaGRAF", 請回到第 2 章。 

 
範例包含 1 個 LD 階梯程式 (範例專案於光碟 \napdos\isagraf\wp-8xx7\demo\ 中)。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
變數宣告: 

 

Name Type Attribute 說明 

OUT01 Boolean Output 輸出 1, 於 I-87055W, Modbus network addr = 1 

OUT02 Boolean Output 輸出 2, 於 I-87055W, Modbus network addr = 2 

K1 Boolean Input 輸入 1, 於 I-87055W, Modbus network addr = 11 

K2 Boolean Input 輸入 2, 於 I-87055W, Modbus network addr = 12 

T1 Timer Internal 
閃爍的週期, 預設值為 T#8s 

Modbus network addr = 21 

 
 
 
LD 階梯程式 (LD1) : 

 
 
 
 
 
 
 
 
  

專案名稱 – “example1” 

專案群組名稱 – “Test” 

LD 程式名稱 – “LD1” 
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4.1.1 啟動 ISaGRAF － 專案管理 

 
請點選 Windows 視窗左下角的 [開始] > [所有程式] > [ISaGRAF 3.5] (或 ISaGRAF 3.4)，然後點選 

[Projects] (如下)。 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

4.1.2 建立 ISaGRAF 使用者群組 

 
如下圖所示，點選按鈕 [Select Project Group] > [New Group]，輸入欲建立的群組名稱 例如: 

“Test”，按 "OK"，然後選擇新建的群組名稱，按 [Select] 開啟群組視窗。 
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4.1.3 建立新的 ISaGRAF 專案 

在要建立專案的群組(例如: Test)中點選 [Create new project] 按鈕來建立新 ISaGRAF 專案，請

在 “Name” 欄位中輸入專案名稱 “example1”，按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
如果您想要替您的專案加註解，請選擇 [Edit] > [Set comment text] 。 

 
 
 
 
 
 
 
 
 
 
 
 
在 "Project Management" 視窗可以看到您的專案名稱，請以滑鼠雙擊專案名稱開啟該專案。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

以滑鼠雙擊專案名稱來開

啟專案視窗 
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4.1.4 宣告 ISaGRAF 專案變數 

在撰寫 ISaGRAF 程式前，必須先宣告程式中要使用的變數。 

 
宣告布林變數 

1. 點選 "Dictionary" 工具按鈕 

 
 
 
 

2. 點選 "Boolean" 標籤，來宣告程式中要使用的布林變數。 

3. 滑鼠雙擊 "Boolean" 標籤下的第一個空白列，開啟 "Boolean Variable" 視窗。 

 
 
 
 
 
 
 

4. 在 "Name" 輸入變數名稱，本範例請輸入 "K1"。在 "Comment Section" 輸入說明 "Input 1 

in the I-87055W board"。 

5. 在 "Attribute" 欄位點選變數的屬性，本範例請選 "Input"。 

6. 點選 "Store" 儲存，該變數即宣告完成。 

 
 
 
 
 
 
 
 
 
 
 
 
注意:   

您必須確認您欲宣告的變數有正確的屬性(如下圖)，如果需要改變變數的屬性，只需用滑鼠

雙擊變數名稱，您便可重新設定變數的屬性。 

 
請依照上述步驟宣告本範例的另一個布林變數 –"K2"，資料與結果如下圖所示。 
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快速宣告變數 

 
本範例尚有兩個輸出變數 "OUT01 和 OUT02"。ISaGRAF 提供了簡便快速的方法來宣告這種有

連續順序的變數。 

 
1. 點選  "Quick Declaration"  工具按鈕。 

2. 在 "Numbering" 項目: 

“From” 和 "To" － 請輸入連續順序變數的開始和結束數字 (本例: 1，2)。 

"Digits" － 請輸入數字需要的位數  (本例: 2，若不足 2 位數會補 “0”)。 

3. 在 "Symbol" 項目的 "Name" 欄位輸入變數名稱  (本例: OUT)。 

4. 在 "Attribute" 欄位點選變數的屬性，(本例: "Output")。 

5. 然後按 "OK" 儲存。結果如下面 "Global Boolean" 視窗。 

6. 請點選 “Save” 按鈕來儲存所宣告的資料。. 
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宣告計時器變數(Timer) 

 
類似上述步驟，滑鼠點選 Global 設定視窗上的 "Timers" 標籤並雙擊有顏色的區域開啟 "Timer 

Variable" 視窗。 

 
1. 在 "Name" 輸入變數名稱，本例: "T1"。 

2. 在 "Attribute" 欄位點選變數的屬性，本例:  "Internal"。 

3. 設定 "Initial Value" 初始值為 "T#8s" 

4. 點選 "Store" 儲存，該變數即宣告完成，如下面 "Global timers" 視窗。 

 
請點選視窗右上角 “X” 關閉 “dictionary” 視窗。 
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4.1.5 指定變數的 Modbus 網路位址編號 

 
如果要 Web HMI 正確的交換專案裡變數的值，就必須指定適當的 Modbus 網路位址編號

(Modbus network address)。Web HMI 能識別 1 到 1024 的 Modbus 編號。而使用 SCADA 軟體

可以讀/寫 WP-8xx7 裡 1 到 8191 的 Modbus 編號。 

 
沒有指定 Modbus 編號的變數則無法讓 Web HMI、其他 SCADA 軟體或 HMI 設備 辨識使用。 

 
有關指定Modbus 網路位址的詳細說明請參考WP-8xx7 光碟中文進階手冊第 4.1 及 4.2 節。(檔

案: \napdos\isagraf\wp-8xx7\chinese_manu\ "Chinese_user_manual_i_8xx7.pdf” ) 

 
1. 點選 “dictionary” 工具按鈕 

2. 按 [Tools] > [Modbus SCADA addressing map] 

3. 選擇 [Options] > [Decimal] (十進位)，否則會預設顯示十六進位格式。 

4. 點選上視窗的 “00001” 

5. 雙擊下視窗的 “OUT01”，指定他的 Modbus 位址為 1。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

1 

2 3 

4 

5 
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請依照同樣步驟指定 OUT02 為位址 2，K1 為位址 11，K2 為位址 12，及計時器變數 T1 為位

址編號 21，結果如下面視窗所示。  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
非常重要:  

 
如果指定 Modbus 編號的變數是長整數、浮點數 或計時器變數，則會用掉兩個 Modbus 編號。 

詳細說明請參考 ISaGRAF 進階使用手冊第 4.2 節。  

(WP-8xx7 光碟: \napdos\isagraf\wp-8xx7\chinese_manu\ "Chinese_user_manual_i_8xx7.pdf”.) 

 
 
  

在此視窗顯示的 Modbus 位址編號

固定為十六進位格式。 
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4.1.6 建立 LD 程式 － "LD1" 

ISaGRAF 在每一循環的 PLC 掃描會執行每一個程式一次。首先執行 “begin” 區域的程式，再執

行 “Sequential” 區域，最後執行 “End” 區域的程式。如下圖所示。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
點選 "Create New Program" 工具鈕，在出現的 "New Program" 視窗 "Name" 欄裡輸入程式名稱，

本例: "LD1"。在 "Language" 選擇程式語言 "Quick LD: Ladder Diagram"，在 "Style" 欄裡選擇 

"Begin:  Main Program"。如果需要，您可以在 "Comment" 欄加上註解。 

 
 
 
 
 
 
 
 
 
 
 
 
 
現在您的專案裡有一個程式了，請以滑鼠雙擊 “LD1” 來開始進行程式編寫。 

 
 
 
 
 
 
 
 
 
  

掃描所有輸入 

‘Sequential’ 區域作業 

‘begin’ 區域作業 

‘End’ 區域作業 

重新更新所有輸出 

ISaGRAF 
循環 



                 WinPAC-8xx7 ISaGRAF PAC 快速上手手冊,  1.65 版,  2013 年 8 月     ICP DAS                        4-11 

4.1.7 編輯 "LD1" 程式 

當您用滑鼠雙擊 "LD1" 後，即可開啟"Quick LD Program" 程式視窗。 

點選 [ Edit ] > [ Insert Rung ]，或者，也可以點選按鈕 "F2 (Contact On The Left)” : 

 
 
 
 
 
 
 
 
 
 
 
同樣會出現如下圖所示的視窗。 

 
 
 
 
 
 
 
 
 
接著編輯 LD1 程式的第一行，移動游標點選左邊的 “Contact” ，按下 "Cut" 工具鈕來刪除它。 

 
 
 
 
 
 
 
 
 
 
 
按下 "F6 (Block on the left)" 工具鈕，在 “Coil” 左邊插入一個方塊。 

 
 
 
 
 
 
 
 
 
 
 

Move the cursor to the first contact and 
then click on “cut” to delete it 
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接下來要指定方塊內容，以滑鼠雙擊方塊，可開啟 "Function Block" 視窗。選取 "BLINK" 功能

方塊，之後再單擊 "OK"。 若要查看該方塊的說明，可以單擊 "Info"。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
以滑鼠雙擊 “CYCLE” 參數左邊區域來開啟指定變數的視窗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

滑鼠雙擊方塊內的任一區域，然後

選 BLINK 功能，按 OK。 

點選 "Info" 可查看該方塊的

說明. 
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選擇右上角 “Timer” 會出現計時器變數名稱，以滑鼠雙擊 “T1” 來指定該變數。 

 
 
 
 
 
 
 
 
 
 
 
再以滑鼠雙擊 “Coil”，選取右上角的 “Boolean” ，在出現的布林變數表中雙擊 “OUT01”，指定

為該 Coil 的變數。 
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LD 程式已經編輯完成，點選 “Save” 工具按鈕儲存程式，點選 “X” 按鈕存檔離開。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.1.8 連接 I/O 

在 4.1.4 節我們已經指定了變數 “OUT01”與“OUT02” 為 “Output” 屬性，“K1” 與 “K2” 為 “Input” 

屬性。這些 “input” 與 “output” 變數必須對應到實際的 I/O 卡接點。 

 
請點選 “I/O connection” 工具鈕開啟 “I/O connection” 視窗，雙擊第一個插槽 (即 slot 0，請確

認 I-87055W I/O 卡已插在 WinPAC 的 slot 0)，選取右下角 “Equipments”，再雙擊 “I_87055: 8 CH. 

DI & 8 CH. DO ”，設定完成按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

點選 “Note” 可查

閱此 I/O 設備的

說明 
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如果您沒有 I-87055W 模組，您可以點選工具按鈕 “Real / virtual board” ，切換成以虛擬的方

式指定 I/O 的連接。 

  
 
 
 
 
 
 
 
 
 
 
 
要連接 Input 變數 “K1” 和 “K2” 到 I-87055 的第 1 及第 2 接點，點選 “DI8”，雙擊 DI 右視

窗的接點 1，點選 “K1”， 按 “Connect” 。接著再點選 “Connect” 一次，設定 “K2” 到第二個

接點。 按 “Close” 即設定完成。 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 2 

3 

4 

5 
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請用同樣方法連接 Output 變數 “OUT01” 和 “OUT02” 到 I-87055 [DO8]的第 1 及第 2 接點，然

後按 “Save” 按鈕儲存並離開。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
重要注意:   

 
1. I/O 連接設定的 I/O 插槽 0~7 保留給 WinPAC 實際連接的 I/O 模組使用，其他的功能設定，

請設定於插槽 8 或之後的插槽。 

 
2. 所有屬性為 “Input” 與 “Output” 的變數都必須經過上述的 I/O 連接設定，才能確保程式編

譯成功。只有屬性為 “Input” 與 “Output” 的變數才會顯示於 "I/O Connections" 視窗中，所

以本範例只顯示 2 個布林 Output 變數 - OUT01, OUT02，以及 2 個布林 Input 變數 – K1 與

K2。 
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4.2 編譯及模擬程式 

為了讓所有的 ISaGRAF 程式都能在泓格 PAC ISaGRAF 系列 (ISaGRAF μPAC, iPAC, 

WinPAC, ViewPAC 控制器等) 上正常的運作，程式設計師必須選擇適當的 "Compiler 

Options" 編譯選項，您必須選擇 "ISA86M:  TIC Code For Intel" 選項，詳細步驟如下所示。 

 
首先，滑鼠點選 [Make] > [Compiler options] 。 

 
 
 
 
 
 
 
 
 
 
 
出現 "Compiler options" 視窗，請點選下圖所示的 Targets 選項 "ISA86M:  TIC Code For Intel"，

確定按下 "Select" 選擇，再勾選下圖所示的其他選項，最後按下 "OK" 按鈕，完成編譯選項的

設定。 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
有關不同 ISaGRAF 版本的編譯錯誤結果，請見本手冊的附錄 H。 

請確認選擇了

這些選項。 
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編譯專案 ! 

 
您在上一節已經選擇了適當的編譯選項，現在，點選 "Make Application Code" 按鈕即可編譯

此範例程式。如果編譯過程中沒有出現錯誤訊息，恭喜您，您已經成功地完成本 ISaGRAF 範

例程式。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
如果您在編譯過程中程式出現錯誤訊息，請點選 "CONTINUE" 按鍵檢視錯誤訊息代表的意義，

並回到專案編輯畫面更正錯誤，並重新編譯。 

 
 
 
模擬專案 ! 

 
完成專案的編譯之後，請如下圖所示點選 "Simulate" 按鈕來模擬專案。 

 
 
 
 
 
 
 
 
 
 
 
 
點選 "Simulate" 按鈕會出現 3 個視窗，分別是 "ISaGRAF-Debugger" 、"ISaGRAF-Debug programs" 

和 "I/O simulator" 三個視窗，如果您建立的 I/O 變數名稱沒有出現在 "I/O Simulator" 視窗，只

需要點選 [Options] > [Variable names] ，便可以在 "I/O simulator" 視窗中顯示變數名稱，如下

圖所示。 
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在 "ISaGRAF- Debug programs" 視窗中雙擊 "LD1"，可以打開 ISaGRAF 的 “Quick LD Program” 視

窗，並看到您先前所設計的程式。 

 
 
 
執行模擬 

 
當您開啟 "LD1" 後, 可看到以下的視窗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
您可以觀察到輸出點 “OUT01” 每 8 秒閃爍一次。 

 

點選 “X” 可關閉模擬 
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程式執行時，您可以調整 "T1" 變數來改變閃爍的區間值: 

1. 請按 "Dictionary" 按鈕開啟 "ISaGRAF Global Variables" 視窗 

2. 點選 "Timer" 標籤，雙擊 “T1” 區塊，輸入新值 “T#4000ms” (表示為 4000 微秒) 

3. 按 “Write”，請觀察閃爍間隔的改變狀況。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
接著模擬 “K1” 與 “K2” 輸入點，以滑鼠左鍵直接點選 “K1” 與 “K2”即可。 

 
 
 
 
 
 
 
 
 
 
關閉 “Debugger” 視窗可以離開模擬。 

 
 
 
 
 
 
 

  

關閉 Debugger 視窗即

離開模擬 
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4.3 下載與執行專案 

有兩種方式可以下載專案到WP-8xx7控制器，一是使用乙太網路線，一是使用RS-232連接線，

在此介紹使用 RS-232 連接線的方式。(使用乙太網路線下載的方式請參考 3.2.3 節) 

 
 
 
連接硬體 

首先，請依下圖連接硬體。RS-232必須如下圖所示來接線。(請參考附錄A.2，“Modbus RTU Slave 

Port” 必須設為 COM3，否則須以 Ethernet 方式下載。) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

注意: WP-8147 沒有 COM3，只有 WP-8447/8847 有 COM3。 

 
 
本節示範以 RS-232 連接線下載 ISaGRAF 程式，但您也可以自行使用 Ethernet 網路線將程式下

載到 WP-8xx7 (請參閱 3.2.3.1 節) 
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設定通訊參數 

 
請點選 "ISaGRAF Programs" 視窗的 "Link setup" 工具按鈕。 

 
 
 
 
 
 
 
 
 
 
 
請依下圖所示，設定適當的參數值: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
WP-8xx7 控制器的 RS-232 通訊參數必須和連接的電腦設定相同的序列通訊參數值。WP-8xx7

控制器 序列埠 COM3 (RS-232)的預設參數如下 : 

 
 
 
 
 
 
         (請參閱附錄 A.2 設定 COM3 為 Modbus RTU slave 埠) 

 
 
  

Baudrate:  19200 
Parity:  none 
Format: 8 bits, 1 stop 
Flow control: none 

WP-8xx7 的 Net-ID 站號; 預設 1。 

您電腦的 COM 編號 

按 “Setup” 設定序列通

訊參數 

預設值: 19200, N, 8, 1, 無浮點控制 



                 WinPAC-8xx7 ISaGRAF PAC 快速上手手冊,  1.65 版,  2013 年 8 月     ICP DAS                        4-23 

測試通訊 

 
將程式下載到控制器之前，請確定您的電腦與控制器的系統是正常通訊的，請依下列方式確

認，點選 "ISaGRAF - Programs" 視窗的 "Debug" 工具按鈕。 

 
 
 
 
 
 
 
 
 
 
如果電腦與 WP-8xx7 的控制系統是正常通訊，就會如下圖的視窗所示(如果控制器裡已有一個

程式正在執行，專案名稱的後面會顯示 "active" 。) 

 
 
 
 
 
 
 
 
 
 
如果 "ISaGRAF - Debugger" 視窗顯示 "Disconnected"，表示電腦與控制器的通訊不正確。 

 
最可能的原因是序列埠的通訊參數設定錯誤，或是，電腦的序列埠通訊設定與 WP-8xx7 控制

器的通訊設定不一致。 

  
您可以修改電腦的序列埠通訊設定 (可能須變更 BIOS 設定值) 或修改 ISaGRAF 程式的 "Serial 

link parameters" 設定值。 

 
如果控制器裡已經有程式執行中，在下載前需先停止該程式，請點選 "Stop application" 工具

按鈕。 

 
 
 
 
 
 
 
 
 
  

電腦裡的 ISaGRAF 專案名稱 

目前控制器裡執行的專案名稱 
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開始下載 

 
點選 "ISaGRAF - Debugger" 視窗的 "Download" 工具按鈕。 

 
 
 
 
 
 
 
 
 
 
在出現的選擇 "Download" 視窗 選擇 "ISA86M:  TIC Code For Intel"。 

 
 
 
 
 
 
 
 
 
 
按下 “Download” 按鈕，即開始下載程式。當程式成功的下載到 WP-8xx7 控制器時，則視窗顯

示如下 

 
 
 
 
 
 
 
 
 
  

若沒出現 “ISA86M: TIC code fort Intel”，表

示編譯選項設定時沒有勾選 “ISA86M: TIC 

code for Intel”，請參考 4.2 節，勾選該選

項，並再次編譯程式。 

要停止電腦與控制器的通訊，請按 “X”。 
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執行 LD 程式 

 
程式執行時，可以從幾個視窗觀察 I/O 的即時狀態。 

 
一個是 "I/O connection" 視窗，可看到每個 I/O 點的現況。點選 “ISaGRAF – Debug programs" 的 

“I/O connection" 按鈕開啟 "I/O Connections" 視窗，您可以切換 I-87055W I/O板卡DI的 開/關，

即時顯示 “K1” 與 “K2” 值的變化。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
點選 “Dictionary” 變數視窗，也可以顯示布林與計時器變數的即時狀態。 
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另外，開啟 "Quick LD Program" 視窗，可以顯示 LD 程式執行的即時狀態。 
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4.4 設計網頁 

完成 ISaGRAF 專案並下載到 WP-8xx7 後，接著為 ISaGRAF 專案設計網頁。 

 
如果您尚未實作第 3 章 “Web HMI 範例程式安裝”，請練習一次以熟悉步驟。 

 
本手冊使用微軟的 “Microsoft Office FrontPage 2003” (或更新版本) 來建立網頁，您可以選擇

自己熟悉的網頁編輯軟體或工具來完成網頁。 

您可參考 WP-8xx7 光碟裡已完成的範例，最好能實作一次以更加了解設計重點。 

WP-8xx7 光碟: \napdos\isagraf\wp-8xx7\wp_webhmi_demo\example1\ 

 
 
 
 

4.4.1 步驟 1 – 複製 Web HMI 範例頁面 

這個 Web HMI 範例頁面置於 WP-8xx7 光碟: 

   \napdos\isagraf\wp-8xx7\wp_webhmi_demo\sample\ 
 
請複製範例資料夾 “sample” 到你的電腦，並重新命名，例如: “example1”。 

 
本 Web HMI 範例包含下列 2 個資料夾、3 個 DLL 檔案與 4 個 HTM 檔案 : 

 
 ./img/  (預設圖片檔資料夾 - *.jpg , *.bmp , *.gif ) 

 ./msg/  (預設訊息檔資料夾 - wincon.js 和 xxerror.htm) 

 
 whmi_filter.dll (3 個 DLL 檔案) 

 login.dll 
 main.dll 
 
 index.htm     (預設首頁) 

 login.htm     (Web HMI 歡迎頁面) 

 menu.htm     (切換菜單頁面，一般在 IE 瀏覽器的左邊) 

 main.htm     (登入成功的首頁) 

 
使用者可以將自己的圖片檔放在 “user_img” 資料夾，將自訂的 java script 檔或 css 檔放在 

“user_msg” 資料夾，其他的資料夾名稱是不被 WinPAC Web HMI 接受的。 

 
“index.htm” 檔是網路伺服器的預設首頁檔，使用者請勿修改。當使用者由 IE 瀏覽器造訪

WP-8xx7，“index.htm” 會在 1 到 2 秒間重新指引到 “login.htm” 檔。 

使用者可以修改 “login.htm”、“menu.htm” 與 “main.htm” 檔案以符合自己的需求，本範例只修

改 “main.htm” 檔案。 
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4.4.2 步驟 2 – 建立 Main.htm 

 
請執行 Microsoft Office FrontPage 2003 (或更高版本) 並開啟 “main.htm”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
請切換到設計頁面。 

請依下圖所示點選 [插入] > [圖層]，插入一個 “Layer2” 圖層物件。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

您可以在此 3 個選項切換不

同工作頁面的視窗。 

此圖層物件的 ID – “Layer2” 
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在 “Layer2” 內點選滑鼠一下，然後按 [插入] > [圖層]，此動作會在原圖層內再插入一個圖層，

如下圖。請在新建立的圖層物件內輸入 “K1” 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
請依照上述插入 “Layer3” 的步驟，在 “Layer2” 裡、“Layer3” 位置下方，再插入一個 “Layer4” 圖

層物件，如下圖所示。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 點選 “Layer2” 物件內一

下 

2. 在 “Layer2” 裡插入 

“Layer4”  

請將 “Layer4” 放置在 “Layer3” 

下方 

在 “Layer2” 圖層內插入另一個

圖層。 
“Layer3” 在 “Layer2” 裡面。 
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接著要在 “Layer4” 裡插入一個圖片，檔名為 “./img/big_Tcircle_red0.jpg”。請按 [插入] > [圖片] 

> [從檔案]，切換到圖檔的資料夾來選擇，此例為 “example1/img/” 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
選取檔案後，結果視窗如下。 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 在 “Layer4” 內點選 

2. 插入一個圖檔 

Layer2 
Layer3 

Layer4 

Layer1 
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請依照前述步驟再插入一個 “Layer5” 物件，內含一個有 “K2” 文字的 “Layer6”，以及一個有 “OK” 

文字的 “Layer7” 。“K1” 用來顯示 I-87055W 的第一個 Input，“K2” 則顯示第二個。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
請依前述步驟再插入 “OUT01” 與 “OUT02”，OUT01 使用 “./img/circle_blue0.jpg” 圖檔，OUT02 

使用 “./img/cmd0.jpg” 圖檔，如下圖所示。OUT01用來顯示 I-87055W 的第一個Output，“OUT02” 

則用來控制與顯示第二個 Output。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 點選此處，插入 “Layer5” 

2.  依照前頁步驟，在 “Layer5” 

圖層裡，插入“Layer6” 與 

“Layer7” 圖層。 

Layer5 

Layer6 

Layer7 

Layer8 

Layer9 

Layer10 

Layer11 

Layer12 

Layer13 
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接著，請插入另一個圖層 “Layer14”，在 “Layer14” 裡再插入內含文字 “T1 = xxx ms” 的 “Layer15”，

同時，在 “Layer15” 下方再插入兩個空圖層 “Layer16” 及 “Layer17”。  

“T1” 用來顯示 ISaGRAF 專案程式裡計時器變數的值。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
請點選 “Save” 工具按鈕將完成的頁面存檔。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Layer14 
Layer15 

Layer16 Layer17 
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4.4.3 步驟 3 – 加入 Main.htm 的控制碼 

 
請切換到 “程式碼” 視窗，您可以看到一個有效語法的 HTML 文件，包含下列幾個基本物件，

如下圖。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

<html> 
 
<title>Your Title here</title> 
 
<head> 
 
<SCRIPT LANGUAGE="JavaScript"> 
 
</SCRIPT> 
 
</head> 
 
<body> 
 
</body> 
 
</html> 
 

“body” 區塊主要用來描述此頁面

的動作 

JavaScript 程式碼一般放在 

“head” 區塊 

請參閱第 5 章以了解詳細的 Web HMI 程式碼 
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請找到 <body> 區塊，修改下列程式碼 : (如圖所示) 

 
 
 
<!-- Caption --> 
<font color="blue" size="4">    
<div style="position: absolute; width: 353px; height: 24px; z-index: 1; left: 73px; top: 12px" 
id="layer1"> 
This is a Web HMI sample page !</div> 
</font>    
 
 
<div style="position: absolute; width: 102px; height: 93px; z-index: 2; left: 75px; top: 52px" 
id="layer2"> 
<div style="position: absolute; width: 44px; height: 24px; z-index: 1; left: 3px; top: 10px" 
id="layer3"> 
K1</div> 
<div style="position: absolute; width: 58px; height: 46px; z-index: 2; left: 1px; top: 38px" 
id="layer4"> 
<img   name= “B11”  border="0" src="img/big_Tcircle_red0.jpg" width="43" height="41"></div> 
<p>&nbsp;</div> 
 
 
 
 
<div style="position: absolute; width: 101px; height: 93px; z-index: 3; left: 241px; top: 51px" 
id="layer5"> 
<div style="position: absolute; width: 47px; height: 26px; z-index: 1; left: 6px; top: 4px" 
id="layer6"> 
K2</div> 
<div style="position: absolute; width: 92px; height: 35px; z-index: 2; left: 7px; top: 38px" 
id="layer7"> 
 
<font  id=“font_B12” color=“blue” size=“3”> 
<b  id=“B12”> OK </b> 
</font> </div> 
 
<p>&nbsp;</div> 
 
 
 
 
 
 
  

請將 “OK <div>” 修改為: 

<font  id=“font_B12” color=“blue” size=“3”> 
<b  id=“B12”> OK </b> 
</font> </div> 

請在 “<img” 之後插入文字: name= “B11”  

K2 區: Layer5 到 Layer7 

K1 區: Layer2 到 Layer4 

Caption 區:  Layer1 

所有 Layer 都以 “<div” 開頭，以 “</div>” 結束 
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<div style="position: absolute; width:82px; height:79px;z-index:4; left:71px; top:168px" 
id="layer8"> 
<div style="position: absolute; width: 60px; height: 31px; z-index: 1; left: 3px; top: 6px" 
id="layer9"> 
OUT01</div> 
<div style="position: absolute; width: 37px; height: 31px; z-index: 2; left: 6px; top: 42px" 
id="layer10"> 
<img  name=“B1”  border="0" src="img/circle_blue0.jpg" width="19" height="20"></div> 
<p>&nbsp;</div> 
  
 
 
 
 
<div style="position: absolute; width:100px; height:100px; z-index: 5; left:242px; top:164px" 
id="layer11"> 
<div style="position: absolute; width: 71px; height: 31px; z-index: 1; left: 4px; top: 8px" 
id="layer12"> 
OUT02</div> 
<div style="position: absolute; width: 61px; height: 48px; z-index: 2; left: 5px; top: 45px" 
id="layer13"> 
<img  style=“cursor:hand” name=“B2”  onclick="ON_OFF(form_B2, form_B2.B2, 
boolean_val[2])"  border="0" src="img/cmd0.jpg" width="50" height="40"></div> 
 

  <form name="form_B2" method="post" action="./main.dll"> 
    <input name="BEGIN" type="hidden"> 
    <input name="B2"    type="hidden" value="0"> 
    <input name="END"   type="hidden"> 
  </form> 
 

<p>&nbsp;</div> 
  
 
 
 
 
 
 
 
 
 
 
 
  

OUT01 區: Layer8 到 Layer10 

請在 “<img” 之後插入文字: name=“B1” 

OUT02 區: Layer11 到 Layer13 

請插入: 

  <form name="form_B2" method="post" action="./main.dll"> 
    <input name="BEGIN" type="hidden"> 
    <input name="B2"    type="hidden" value="0"> 
    <input name="END"   type="hidden"> 
  </form> 

請在 “<img” 之後插入: 

Style=“cursor:hand” name=“B2”  onclick="ON_OFF(form_B2, 
form_B2.B2, boolean_val[2])" 
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<div style="position: absolute; width: 181px; height: 90px; z-index: 6; left: 374px; top: 162px" 
id="layer14"> 
<div style="position: absolute; width: 119px; height: 28px; z-index: 1; left: 4px; top: 7px" 
id="layer15"> 
 

 T1 = <b id="T1">xxx ms</b></div> 
 
 
 

<div style="position: absolute; width: 98px; height: 28px; z-index: 2; left: 4px; top: 45px" 
id="layer16"> 
 

  <form name="form_L21" method="post" action="./main.dll"> 
    <input name="BEGIN" type="hidden"> 
    <input name="L21" type="text" size="8" value="xxx">  
    <input name="END" type="hidden"> 
  </form> 
 

&nbsp;</div> 
 
 
 
 
 
 
 
 
 

<div style="position: absolute; width: 67px; height: 33px; z-index: 3; left: 106px; top: 44px" 
id="layer17"> 
 
  <input type="button" value="Enter" onclick="Check_L21( )"> 
 
&nbsp;</div> 
<p>&nbsp;</div> 
 
 
 
 
 
 
 
到此為止，<body>   </body> 區塊的程式碼已經修改完成。 

 

T1 區: Layer14 到 Layer17 

請將 “T1 = xxx ms </div>” 修改為:  

T1 = <b id="T1">xxx ms</b></div> 
 

請在 “Layer16” 插入下列程式碼: 

<form name="form_L21" method="post" action="./main.dll"> 
    <input name="BEGIN" type="hidden"> 
    <input name="L21" type="text" size="8" value="xxx">  
    <input name="END" type="hidden"> 
  </form> 

請在 “Layser17” 插入: 

<input type="button" value="Enter" onclick="Check_L21( )"> 
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接著，請找到 “head” 區塊，依下圖所示修改下列 “head” 區塊的程式碼 : 

 
// variable to record object's blink state, 0:not blink, 1: blink, For example: 
// ********************************* 
var B12_blink=0;  // init as 0:not blink 
// ********************************* 
 
// function to blink object 
var blink_step=0; 
function blink_obj() 
{ 
  if(blink_step==1) 
  { 
    blink_step=0; 
     
    // display your object here 
    // blink B12, For example: 
    // ********************************* 
    if(B12_blink==1) 
    { 
      B12.innerText="Error !" ;   
      font_B12.color="red"; 
    } 
    // ********************************* 
  } 
  else 
  { 
    blink_step=1; 
 
    // un-display your object here 
    // blink B12, For example: 
    // ********************************* 
    if(B12_blink==1) 
    { 
      B12.innerText="" ; 
      font_B12.color="red"; 
    } 
    // ********************************* 
  } 
  setTimeout("blink_obj()", blink_period);    
} 
 
 
 

本範例當 K2=True，會閃爍 “Error !” 字樣，此 3 區

塊的程式碼，請去除加在前面的註解記號 //，變

成如本頁所列。 
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我們需要 function “Check_L21” 來檢查輸入的 T1 值並將它傳到 PAC。 

請找到 function Check_L21 程式碼，去除註解記號，如下列所示 : 

 
 
// form sample, to check value of L21 & then post val to controller 
// For example: 
// ************************************************************** 
 
function Check_L21() 
{ 
  var val=form_L21.L21.value; 
  if(val>12000 || val<4000) 
  { 
    alert("T1's value should be in the range of 4000 to 12000"); 
    return; 
  } 
  Check(form_L21);  // post value to the controller 
} 
// ************************************************************** 
 
 
 
 
另外，“refresh_data()” function 也需要加入下列程式碼 : 

 
// To refresh displayed data, this function is called by IE about every 1.5 sec later 
 
function refresh_data() 
{ 
  B1.src = "./img/circle_blue" + boolean_val[1] + ".jpg"; 
  B2.src = "./img/cmd" + boolean_val[2] + ".jpg"; 
 

  B11.src = "./img/big_Tcircle_red" + boolean_val[11] + ".jpg"; 
 

  if(boolean_val[12]==0) 
  { 
    B12.innerText="Ok"; 
    font_B12.color="blue"; 
    B12_blink=0; 
  } 
  else 
  { 
    B12_blink=1; 
  }   
  T1.innerText=timer_val[21] + " ms"; 
} 
 

 

 



                 WinPAC-8xx7 ISaGRAF PAC 快速上手手冊,  1.65 版,  2013 年 8 月     ICP DAS                        4-39 

現在，所有程式碼已經修改完成，請儲存檔案。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
您可以點選 “預覽” 視窗來模擬執行狀態。 
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4.4.4 步驟 4 – 下載 Web HMI 頁面到 PAC 

 
下載的步驟類似 3.2 節的下載步驟，如果您尚未實作第 3 章 “安裝 Web HMI 範例程式”，請您

盡快練習一次以熟悉操作方式。下列步驟請開啟 PAC 控制器來操作。 

 
 
設定 Web 選項 

 
執行 “isaWinPAC”，勾選 “Web” 頁面的 “Enable Web HMI” 選項，再點選“Setting”，勾選 “Enable 

Account Security”，並點選 “Edit” 設定 “使用帳號” 與 “密碼”，最後記得點選 “OK”。 

 
注意:  如果沒有勾選 “Enable Account Security”，任何使用者都能透過 IE 瀏覽器輕易的操控您

的 PAC。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
接著請複製 “example1” 的所有檔案到 ISaGRAF PAC 可程式自動化控制器裡: 

 
複製下列檔案: 

 <您的電腦>: 資料夾\example1\ *.*   

到下列位置:  

 <ISaGRAF PAC>: Micro_SD\Temp\HTTP\WebHMI\  
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一旦修改或重新複製網頁，請執行 “rs_wphmi.exe” 重新設定 Web 伺服器。 

每次修改 WP-8xx7 中 \Micro_SD\Temp\HTTP\WebHMI\ 資料夾裡的任何檔案，都必須重新執

行 “rs_wphmi.exe” 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
展示 Web HMI: 

 
請執行 IE 瀏覽器 (6.0 或更高版本)，輸入你的 WP-8xx7 的 IP 網址。 

例如:   192.168.1.232    或  http:// 192.168.1.232 
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如果網頁有任何問題，您可以啟動下列視窗的偵錯功能，每次網頁有錯時皆顯示錯誤訊息。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
有錯誤時，請確認 ISaGRAF 專案是否已確實下載至控制器 (請參閱第 4.3 或 3.2.3 節) ?   

另外，ISaGRAF 變數是否設定了正確的 Modbus 網路位址編號 (請參閱第 4.1.5 節) ? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

雙擊此處可顯示錯誤訊息

視窗。 
勾選此項，並點選 “OK”。 

目前執行的 ISaGRAF 專案名稱列

於此處 
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第 5 章 Web HMI 設計基礎 

WinPAC-8xx7 或 WP-8xx7 為 WP-8147/8447/8847/8137/8437/8837 的簡稱. 

WinPAC-8xx6 或 WP-8xx6 為 WP-8146/8446/8846/8136/8436/8836 的簡稱. 

  
重要:  

1. WP-8xx7/8xx6 的 插槽 0 ~ 插槽 7 只支援 高卡的 I-8K 與 I-87K I/O 模組。 

請參考 WP-8xx7 光碟:  

\napdos\isagraf\wp-8xx7\chinese_manu\ chinese_wp-8x47_datasheet.pdf 
2. WP-8xx7 需設定為固定 IP 位址. (不可使用 DHCP)。 

 
注意:   

1. 本章描述 Web HMI 的基本程式設計。我們不會將重點放在 HTML 上，如果您想知道更多有

關 HTML 的程式設計，最好的辦法是 “買一本 HTML 相關的著作”，書店裡有許多這類型的

好書。 

2. Web HMI 只支援基本的 HTML 標籤，並不支援 ASP、PHP、JSP 或其他網頁伺服器語言。 

3. 請不要在 Web HMI 中使用<frameset>  </frameset>、<frame> </frame>。 

4. 物件名稱、ID 編號、編碼、變數名稱和功能名稱都是字母大小寫有別的!  

例如: refresh_data( ) 和 Refresh_data( ) 是不相同的。 

5. WP-8xx7 光碟裡提供了 10 個以上的 Web HMI 範例，請參考 3.1 節。 

 
 

5.1 Web HMI 的基本檔案 

Web HMI 的基本檔案包括 2 個資料夾、3 個 DLL 檔和 4 個 htm 檔，如下所列: 
 

 ./img/  (預設圖片檔 - *.jpg , *.bmp , *.gif ) 

 ./msg/  (預設訊息檔 - wincon.js 和 xxerror.htm) 
 

 whmi_filter.dll (3 個 DLL 檔) 

 login.dll 
 main.dll 
 

 index.htm  (預設首頁) 

 login.htm  (Web HMI 歡迎頁面) 

 menu.htm  (切換菜單頁面，一般在 IE 瀏覽器左邊) 

 main.htm  (登入成功的首頁) 
 

使用者可以將自己的圖片檔放在 “user_img” 資料夾，將自訂的 java script 檔或 css 檔放在 

“user_msg” 資料夾，其他的資料夾名稱是不被 WinPAC Web HMI 接受的。 

 
“index.htm” 檔是網路伺服器的預設首頁檔，使用者請勿修改。當使用者由 IE 瀏覽器造訪

WP-8xx7，“index.htm” 會在 1 到 2 秒間重新指引到 “login.htm” 檔。 

 
使用者可以修改 “login.htm”、“menu.htm” 與 “main.htm” 檔案以符合自己的需求。 
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5.2 Login.htm  

Login.htm 是使用者造訪網頁時的第一個歡迎頁面，可以修改自訂。以下是 login.htm 的基本程

式碼。 

 
<html> 
<head> 
 
<title>Login</title> 
 
<meta http-equiv=pragma content=no-cache>    
 
<meta http-equiv="Content-Type" content="text/html; charset=UTF-8" > 
 
<script language="JavaScript"> 
var random_val=123; 
function get_random_val() 
{ 
  var rightNow = new Date();   
  random_val += 323456789*rightNow.getMinutes() +  
                         107654321*(rightNow.getTime()%1000); 
  setTimeout("get_random_val()", 197); // repeat call 
} 
 

//check if username and possword are empty 
function validate(fm)  
{ 
  setKey(fm); 
  return true; 
}  
 

//Embed key whille submitting 
function setKey(fm) 
{    
  var rightNow = new Date();   
  cookieVal = random_val+rightNow.getTime(); 
  fm.key_.value = cookieVal;   
}     
</script> 
 

</head> 
 
  

此行僅供 “Login.htm” 使用，請勿在其他頁面使

用，例如: “menu.htm”、“main.htm” 和 其他 .htm 頁

面。 

請在此指定編碼語系。 

例如: 

英文: UTF-8 

繁體中文: big5 

簡體中文: gb2312 

或其他語言 
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<body onload="get_random_val()"> 
 
<div style="position: absolute; width: 332px; height: 34px; z-index: 5; left: 147px; top: 27px" 
id="layer1"> 
Welcome !</div> 
 
 
<div style="position:absolute; width:122px; height:38px; z-index:4; left: 171px; top: 95px;"  
id="layer2"> 
 
 
 
  <form name="form1" action="./login.dll" method="post"> 
     <input type="hidden" name="key_"> 
     <input type="submit" name="Submit" value="  Enter  " style="cursor:hand" onClick="return 
validate(this.form)">            
  </form> 
 
</div> 
  
</body> 
 
 
<!-- To ensure no-cache work --> 
<head> 
<meta http-equiv=pragma content=no-cache>    
</head> 
 
</html> 
 
 
 
 
 
 
 
以上為 login.htm 的基本程式碼。您可以自行插入更多圖像與文字，但是必須保留這些基本程

式碼。 

 

  

Login.htm 一開始必需先呼叫 get_random_val( )， 這是

Login.htm 的切入點。 

此程式碼只供 “Login.htm” 使用，請勿應

用到其他頁面，例如: “menu.htm”、

“main.htm” 和其他 .htm 頁面。 

您的標題可放於此 

“form1” 是必需的 

您可修改 “Enter”，例如: 改為 “請進”，

但須同時配合修改本頁面開頭的語系

設定 “charset”。 
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5.3 Menu.htm  

注意: 

 
若您想了解詳細的多重頁面應用，WP-8xx7 光碟裡有 2 個範例: 

\napdos\isagraf\wp-8xx7\wp_webhmi_demo\  wphmi_05 和 wphmi_05a 

“wphmi_05” 的切換菜單選項在左方，而 “wphmi_05a” 的在上方。 

 
“Menu.htm” 定義 Web HMI 的頁面菜單，特別是多重頁面的應用。頁面菜單只能放在左方或上

方。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

在左方: 

 
可以調整寬度與捲軸。 

寬度 

在上方: 

 
可以調整寬度與捲軸。 

寬度 
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以下為 menu.htm 的基本程式碼 : 

 
<!-- top_or_left=1 , scrolling=0 , width=60 , resize=1 --> 
 
 
 
 
 
<html> 
<head> 
<title>Title1</title>    
 
<meta http-equiv="Content-Type" content="text/html; charset=UTF-8" > 
 
<SCRIPT LANGUAGE="JavaScript" src="./msg/wincon.js"></SCRIPT>    
<SCRIPT LANGUAGE="JavaScript"> 
 
function start1() 
{ 
  A_11(); 
} 
 
 
function refresh_data() 
{ 
  if(run_at_pc==1) return;  
} 
 
</SCRIPT> 
</head> 
<body onload="start1()"> 
 
<!-- Logout button --> 
<form name="form_logout" method="post" action="./login.dll"> 
  <input style="cursor:hand" name="CMD" type="submit" value="Logout" onClick="return 
logout(this.form)"> 
</form> 
 
</body> 
</html> 
 
 
注意: 

若您想了解詳細的多重頁面應用，WP-8xx7 光碟裡有 2 個範例: 

\napdos\isagraf\wp-8xx7\wp_webhmi_demo\  wphmi_05 和 wphmi_05a 

“wphmi_05” 的切換菜單選項在左方，而 “wphmi_05a” 的在上方。 

 

本行在 menu.htm、

main.htm 和其他多重頁

面都是必須的 

請在此設定語系，例如 : 

 英文:  UTF-8 

 繁體中文: big5 

 簡體中文: gb2312 

 或其他語系 

form_logout 是登出按鈕 

start1( ) 是 menu.htm 的切入點 

第一列並非註解，是用來定義頁面菜單 : 

top_or_left: 位置。1:在上方；0:在左方 

scrolling: 捲動。1:是；0:否 

width: 菜單框架的寬度，0 – 999 (單位: 像素) 

resize: 調整大小。1:是；0:否 
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5.4 Main.htm  

 

5.4.1 一個簡單的 Main.htm 範例 

 
在製作複雜的 main.htm 之前，請先看一個簡單的 main.htm 範例，此範例只做一件事: 在成功

登入網頁時顯示 “Hello !” 訊息。 

 
 
<html> 
<head> 
<title>Title1</title> 
<meta http-equiv="Content-Type" content="text/html; charset=UTF-8" >   
 
<SCRIPT LANGUAGE="JavaScript" src="./msg/wincon.js"></SCRIPT>   
 
 
 
 
<SCRIPT LANGUAGE="JavaScript"> 
show_scroll_word(200,"Hello, Welcome to the Web HMI Sample !");   
 
 
function refresh_data() 
{ 
} 
 
</SCRIPT> 
</head> 
 
 
<body onLoad="init()"> 
 
 
<font color="blue" size="4">    
<div style="position: absolute; width: 353px; height: 24px; z-index: 1; left: 73px; top: 12px" 
id="layer1">   Hello !</div> 
</font>    
 
 
</body> 
</html> 
 
 
 

在此處設定您的語系，例如: 英文: UTF-8、繁體中文: big5、 

簡體中文: gb2312，或其他語系。 

此行在 menu.htm、main.htm 和其他多重頁面是必須的 

呼叫 show_scroll_world( )可在 IE 瀏覽器底部顯示移動文字，200

表示 200 微秒，可以調整，例如: 500 微秒。 

當 IE 收到來自控制器的資料，會自動呼叫 refresh_data( )來更新資料，依通

訊品質不同而每隔 1.25 到 5 秒更新一次。 

init( ) 是 main.htm 與其他多重頁面的切入點 

版面設計物件以 “<div” 標籤開頭，以 “</div>” 標籤結尾，此處只

顯示訊息 “Hello !”。 
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您可以在 WP-8xx7 光碟下列目錄裡找到 main.htm 檔案:  

    \napdos\isagraf\wp-8xx7\wp_webhmi_demo\sample   
 
用來取代上述 main.htm 檔案並下載到控制器 (請參閱 4.4.4 節)，當您成功登入時可以看到如下

畫面。 

 
如果您拔除電腦或控制器的 Ethernet 網路線，大約 10 秒鐘，會出現如下圖的斷線訊息 

“Communication is temporary break now !”，再插回網路線，大約 10 到 45 秒會自動恢復通訊。 

 

 
如果斷訊超過 120 秒，會顯示下列訊息，請關閉再重開 IE 瀏覽器，再次登入。 

 
 
  

此處會顯示移動文字，因為有呼叫

show_scroll_world( )。 
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5.4.2 更多關於 refresh_data( )功能與動態資料 

 
注意: 程式碼、變數名稱與功能名稱的字母大小寫是不相同的， 

          例如: refresh_data( ) 是正確的，而 Refresh_data( ) 是不正確的。 

 
refresh_data( ) 功能必須一直放在 main.htm 和其他多重頁面中，當 IE 收到來自控制器的資料，

會自動呼叫 refresh_data( )來更新資料，依通訊品質不同而每隔 1.25 到 5 秒更新一次。 

 
refresh_data( ) 通常用來更新動態資料，例如: ISaGRAF 專案中布林、整數、計時器、浮點等變

數的值。 

 
要讓 IE 瀏覽器能接收 ISaGRAF 專案的資料，必需設定互不相同的 Modbus 網路位址編號 (請參

閱 4.1.5 節)。Web HMI 只接收 1 到 1024 範圍的網路位址編號，資料若無網路位址編號 (No. = 0) 

或編號不在許可範圍內 (1 ~ 1024)，IE 瀏覽器則無法接收該資料。 

 
main.htm 與其他多重頁面可以使用下列變數陣列存取 ISaGRAF 的資料 (注意大小寫不同)，[  ] 括

號內為對應的網路位址編號，例如: boolean_val[2] 表示 ISaGRAF 資料中網路位址編號指定為 2

的布林資料的值。 

 
 
 
 
 
 
 
 
 
 
 
 
接收 long integer (32-bit 整數) 值時，請使用 get_long_val( ) 功能，例如: get_long_val(11)，

get_long_val(13)，get_long_val(15)。 

 
 
 
 
 
注意:  

ISaGRAF 專案的 long integer、timer 和 float 變數的網路位址編號必須佔用 2 個位址。 (請參閱

ISaGRAF 進階手冊 4.2 節或光碟 \napdos\isagraf\wp-8xx7\ chinese_manu\ 

“Chinese_User_Manual_I_8xx7.pdf”).  
 
這表示，如果您指定網路位址編號=11給Real變數(或Timer或 integer都是32-bit值 – 大於32767

或小於 -32768)，那麼下一個位址 12 就不能再指定給任何 ISaGRAF 專案變數，而必須從 No.=13 

來指定。 

 
 

boolean_val ISaGRAF 的 boolean 值 

word_val ISaGRAF 的 word 值，-32768 ~ +32767 

float_val ISaGRAF 的 real 值， 例如: 1.234, -0.456E-02 

timer_val ISaGRAF 的 timer 值，單位: ms，最大 = 86399999 (< 1 天) 

string_val ISaGRAF 的 message 值，最大字串長度 255 

get_long_val(  ) ISaGRAF 的長整數值，-2147483648 ~ +2147483647 
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5.4.2.1 顯示動態 Boolean 資料 

 
範例程式: whmi_02 與 whmi_05 (請參閱 3.1 節) 

 
再回頭來看 refresh_data function，如果要使用動態布林值，必須加入下列程式碼。 

 
… 
function refresh_data() 
{ 
  B1.src = "./img/circle_blue" + boolean_val[1] + ".jpg" ; 
} 
… 
 
 
<body onLoad="init()"> 
… 
 
 
<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 
<img name="B1" src="img/circle_blue0.jpg"></div> 
 
… 
</body> 
 
 
 
 
5.4.2.2 顯示動態 Float、Word、Timer 資料 

 
範例程式: wphmi_01、wphmi_03 與 wphmi_05 (請參閱 3.1 節) 

如果要顯示動態 float 值，必須使用下列程式碼。 

 
… 
function refresh_data() 
{ 
  F21.innerText = float_val[21] ; 
} 
… 
 
 

<body onLoad="init()"> 
… 
 
<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 
<b  id="F21"> xxxx </b> </div> 
 

… 
</body> 
 
 

在此定義圖片物件 “B1” 的動作 

在此宣告文字物件 “F21”，使用 “<b” 標籤、id=”F21” 和 “</b>” 標籤，

F21 的初始值為 “xxxx”。 

若 boolean_val[1]=1，“B1” 顯示 “img/circle_blue1.jpg” 圖片 

若 boolean_val[1]=0，“B1” 顯示 “img/circle_blue0.jpg” 圖片 

定義圖片物件 “B1” 的版面配置 (或位置)， 

使用 “<div” 和 “</div>” 標籤 

在此宣告圖片物件 “B1”，使用 “img” 標籤 及 name= “B1”    src= …     

以 “src=” 定義 B1 的初始值 

顯示 Word 資料請使用 “word_val[ ]”， 

顯示 Timer 資料請使用 “timer_val[ ]”， 

例如: F21.innerText = timer_val[21] + “  ms”; 

定義文字物件 “F21” 的版面配置 (或位置)， 

使用 “<div”   “</div>” 標籤。 

在此定義文字物件 “F21” 的動作 
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5.4.2.3 顯示動態 Long Integer 資料 

 
範例程式: wphmi_03 與 wphmi_05 (請參閱 3.1 節) 

如果要顯示動態 long integer (32-bit 格式)值，必須使用下列程式碼。  

 
 
function refresh_data() 
{ 
  L11.innerText = get_long_val(11) ; 
} 
… 
<body onLoad="init()"> 
… 
<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 
<b  id="L11"> xxx </b> </div> 
 
… 
</body> 
 
 
 
 
 
 
5.4.2.4 顯示動態 String 資料 

 
如果要顯示動態 string 值 (最長 255)，必須使用下列程式碼。  

 
… 
function refresh_data() 
{ 
  S31.innerText = string_val[31] ; 
} 
… 
 
<body onLoad="init()"> 
… 
 
<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 
<b  id="S31"> empty </b> </div> 
 
… 
</body> 
 
 
 
 
  

在此定義文字物件 “L11” 的動作 

定義文字物件 “L11” 的版面配置 (或位置)， 

使用 “<div” 與 “</div>” 標籤。 

在此宣告文字物件 “L11”，使用 “<b” 標籤、id=”L11” 與 “</b>” 標籤，

L11 的初始值為 “xxx”。 

在此定義文字物件 “S31” 的動作 

here. 

定義文字物件 “S31” 的版面配置 (或位置)， 

使用 “<div” 與 “</div>” 標籤。 

在此宣告文字物件 “S31”，使用 “<b” 標籤、id= “S31” 與 “</b>” 標籤，

S31 的初始值是 “empty”。 

The declaration of Text object “S31” is defined here by the “<b” tag and  
id=”S31”  and “</b>” tag,  the initial value of this S31 is  “empty” 
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5.4.2.5 觸發 Boolean 物件的閃爍動作 

 
範例程式: wphmi_02 與 wphmi_05 (請參閱 3.1 節) 

 
當布林的值改變時，有的應用需要顯示一個閃爍的提醒訊息，例如:  

當 boolean_val[12] 為 False，表示正確而顯示 “OK”，當 boolean_val[12] 為 True，表示錯誤而顯

示 “Error !”，使用者可能想要閃爍 “Error !” 訊息來吸引注意力。 

 
下列程式碼可做到這個閃爍動作。 

 
 
… 
var blink_period=500;   
 
setTimeout("blink_obj()", blink_period);     
 
var B12_blink=0;   // init as 0:not blink 
var blink_step=0; 
 
function blink_obj() 
{ 
  if(blink_step==1) 
  { 
    blink_step=0; 
     
    if(B12_blink==1) 
    { 
      B12.innerText="Error !" ;   
      font_B12.color="red"; 
    } 
     
  } 
  else 
  { 
    blink_step=1; 
 
    if(B12_blink==1) 
    { 
      B12.innerText="" ; 
      font_B12.color="red"; 
    } 
  } 
  setTimeout("blink_obj()", blink_period);    
} 
 
  

閃爍週期，單位: ms 

閃爍步驟 1: 

顯示 “Error !” ，紅色字型。 

閃爍步驟 2: 

顯示 “” (空白)，紅色字型。 

設定 timer 來控制閃爍動作 

1: 閃爍, 0: 不閃爍 
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…function refresh_data() 
{ 
 
  if(boolean_val[12]==0) 
  { 
    B12.innerText="Ok"; 
    font_B12.color="blue"; 
    B12_blink=0; 
  } 
  else 
  { 
    B12_blink=1; 
  }   
} 
… 
 

<body onLoad="init()"> 
… 
 
<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 
 

<font  id=”font_B12” color=”blue” size=”3”> 
 
<b  id="B12">OK</b>  
 
</font> 
 
</div> 
… 
</body> 
 
 
5.4.2.6 Float 值以固定的小數位數顯示 

 
範例程式: wphmi_06 與 wphmi_07 (請參閱 3.1 節) 
 

float_str1(para1 , para2 ) function 可以將 float 值轉換為小數位數固定的 string 值，並指定 “.” 小

數點記號後面的固定位數。 
 

para1 是要被轉換的 float 值，例如: 1.234567 

para2 是小數點記號 “.” 後面的位數，0 ~ 6 

例如:  float_str1(1.234567, 3)，傳回 “1.234” 

          float_str1(1.234567, 2)，傳回 “1.23” 

 
… 
function refresh_data() 
{ 
  F21.innerText = float_str1( float_val[21] , 3) ; 
} 
  

在此定義文字物件 “B12” 的版面配置(或位置)，使用 

“<div” 與  “</div>” 標籤。 

“<font>“ 與 “</font>” 標籤用來控制字型的顏色與大小 

將網路位址編號 21 的 float 值轉換為 “.”小數點記號後面

有 3 個位數的 string 值 

在此宣告文字物件 “B12”，使用 “<b” tag、id=”B12” 與 “</b>” 標籤，B2

的初始值是 “OK”。 

在此定義文字物件 “B12” 的動作。 

 
若 boolean_val[12]=0，不閃爍。 

若 boolean_val[12]=1，閃爍。 
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5.4.3 發送資料到控制器 

 
前一節(5.4.2 節) 說明了如何取得與顯示來自控制器的資料，本節著重於如何將資料發送到控制

器，換句話說，就是要透過 IE 瀏覽器控制 PAC 控制器。 

 
要在 ISaGRAF 專案中設定一個 boolean/ word/ long integer/ float/ timer/ string 變數的新值，需要

在 main.htm 或其他多重頁面中加入 “form” 物件，“form” 物件如下: 

 
 
 
 
 
<form  name="form_L21"  method="post"  action="./main.dll"> 
  <input  name="BEGIN"  type="hidden"> 
  <input  name="L21"  type="text"  size="8"  value="xxx">  
  <input  name="END"  type="hidden"> 
</form> 
 
 
 
 
 
 
 
用來控制PAC資料的 “<input>” 名稱必須依循下列格式，字母後面的數字必須在1到1024之間，

這個數字用來指向 ISaGRAF 專案中相同數字的 Modbus 網路位址編號的變數名稱。 

 
 
 
 
 
 
 
 
 
 
 
注意:  

ISaGRAF 專案中的 long integer、timer 和 float 變數的網路位址編號必須佔有 2 個位址編號 (參

閱 “ISaGRAF 進階使用手冊” 4.2 節或光碟 \napdos\isagraf\ wp-8xx7\english_manu\  

“chinese_user_manual_I_8xx7.pdf” ) 
 
這表示，如果您指定網路位址編號=11給Real變數(或Timer或 integer都是32-bit值 – 大於32767

或小於 -32768)，那麼下一個位址 12 就不能再指定給任何 ISaGRAF 專案變數，而必須從 No.=13 

來指定。 

 
  

此 form 的名稱 

B 指向 ISaGRAF 的 boolean 資料，例如: B5 , B109 

W 指向 ISaGRAF 的 word 資料 (-32768 ~ +32767)，例如: W9 , W1001 

L 指向 ISaGRAF 的 long integer 資料 (-2147483648 ~ +2147483647), 如: L21 

 “L” 同時也指向 ISaGRAF 的 timer 資料 

F 指向 ISaGRAF 的 real 資料，例如: F13 , F235 

S 指向 ISaGRAF 的 message 資料，例如: S18 

Method 一定要用 “post” 

action 一定要用“./main.dll” 

在 form 裡，第一個 

“<input>”，名稱必須是 

“BEGIN”(大寫)，type 必

須是 “hidden” 

在 form 裡，最後的 “<input>” 

名稱必須是 “END” (大寫)，

type 必須是 “hidden”。 

在“BEGIN” 與 “END” 中間

的所有 “<input>” 就是要發

布到控制器的資料 
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5.4.3.1 發送 Boolean 值到控制器 
 

 
A. 以圖片發送 

… 
function ON_OFF(form_obj, obj, current_boo_value) 
{ 
  if(current_boo_value==0)   
  { 
    flag = confirm("turn ON ?"); 
    if(flag) obj.value=1; 
  }  
  else 
  { 
    flag = confirm("turn OFF ?"); 
    if(flag) obj.value=0; 
  } 
  if(flag) 
  { 
   if(GetUserID(form_obj)==true) form_obj.submit(); 
  } 
} 
function refresh_data() 
{ 
  B2.src = “img/cmd” + boolean_val[2] + “.jpg” ; 
} 
… 
 

<body onLoad="init()"> 
… 
 

<div style="position: absolute; width:100px;height:100px; z-index: 5; left: 242px; top: 164px" > 
 
 
 
 
<img style="cursor:hand" name="B2"  onclick="ON_OFF(form_B2, form_B2.B2, boolean_val[2])"   
src="img/cmd0.jpg"> 
 
 
 
 
 
<form name="form_B2" method="post" action="./main.dll"> 
    <input name="BEGIN"  type="hidden"> 
    <input name="B2"     type="hidden" value="0"> 
    <input name="END"    type="hidden"> 
</form> 
</div> 
… 
</body>  

第一個參數是 “form” 的名稱. 

第二個參數是 form 裡面 “<input>” 的名稱. 

最後的參數是目前的布林值. 

顯示目前布林圖片, 此例:   

0: 顯示“img/cmd0.jpg”; 1: 顯示 “img/cmd1.jpg”. 

此處以“<div” 及 “</div>” 標籤定義圖片物件 “B2” 的

版面配置(或位置). 

範例程式: vphmi_02  與  vphmi_05  

ON_OFF function 以參考目前布林值的方式將布林值發送到控制器. 

當進入圖片區時, “cursor:hand” 

會將滑鼠指標顯示為手的圖片. 圖片物件的名稱 

當滑鼠點選時, “onclick” 會呼叫 ON_OFF( ), 

第一個參數是 “form” 的名稱, 此例為 “form_B2”. 

第二個參數是 form 裡面“<input>” 的名稱, 此為 “form_B2.B2” 

最後的參數是目前布林值, 此為 boolean_val[2] . 

Form 的名稱 

Form 裡面“<input>”的名稱, 此例為“B2”, 因為它在

“form_B2”裡, 所以定義為 “form_B2.B2”. 
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B. 以按鈕發送 

 
function ON_(form_obj, obj) 
{ 
  flag = confirm("turn ON ?"); 
  if(flag)  
  { 
    obj.value=1; 
    if(GetUserID(form_obj)==true) form_obj.submit(); 
  } 
} 
function OFF_(form_obj, obj) 
{ 
  flag = confirm("turn OFF ?"); 
  if(flag)  
  { 
    obj.value=0; 
    if(GetUserID(form_obj)==true) form_obj.submit(); 
  } 
} 
function refresh_data() 
{ 
  B2.src = "img/big_Tcircle_red" + boolean_val[2] + ".jpg" ; 
} 
… 
 

<body onLoad="init()"> 
… 
<div style="position: absolute; width: 56px; height:40px; z-index: 5; left: 82px; top: 69px" > 
<img name="B2" src="img/big_Tcircle_red0.jpg"> 
</div> 
 

<div style="position:absolute; left:85px; top:124px; width:42px; height:27px;"> 
<input type="button" value="ON" style="cursor:hand" onClick="ON_(form_B2, form_B2.B2)">  
 
 
 
<form name="form_B2" method="post" action="./main.dll"> 
    <input name="BEGIN"      type="hidden"  value="">  
    <input name="B2"        type="hidden"  value="1"> 
    <input name="END"       type="hidden"  value="">  
</form> 
</div> 
 
<div style="position:absolute; left:85px; top:166px; width:47px; height:31px"> 
<input type="button" value="OFF" style="cursor:hand" onClick="OFF_(form_B2, form_B2.B2)"> 
</div> 
… 
</body> 
  

“ON_”  function 用於當布林值為 “True”, 將值發送到控制器. 

“OFF_” function 用於當布林值為 “Fasle”, 將值發送到控制器. 

此處以 “<div” 及 “</div>” 標籤定義圖片物件 “B2” 

的版面配置(或位置). 

範例程式: wphmi_02 與 wphmi_05 

 

顯示目前的布林圖片, 此例中: 

0: 顯示 “img/big_Tcircle_red0.jpg” 

1: 顯示 “img/ big_Tcircle_red1.jpg” 

以此按鈕呼叫 ON_( ),  第一個參數是 form 的名稱，此例為 “form_B2”; 

第二個參數是 form 裡“<input>”的名稱, 此為 “form_B2.B2” 

以此按鈕來呼叫 OFF_( ). 第一個參數是 form 的名稱, 此例為 “form_B2”; 

第二個參數是 form 裡“<input>”的名稱, 此為 “form_B2.B2”. 

Form 裡面“<input>”的名稱, 此例為“B2”, 因為它在 

“form_B2” 裡, 所以定義為 “form_B2.B2”. 
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5.4.3.2 發送 Word、Long、Float、Timer 及 String 的值到控制器 

… 
function Check(form_obj) 
{  
  flag = confirm("Are you sure?");  
  if(flag) 
  { 
    if(GetUserID(form_obj)==false) { return false; }   
    form_obj.submit(); 
    return true;  
  } 
  else 
  {  
    return false;  
  } 
} 
 

 
function refresh_data() 
{ 
  L15.innerText=get_long_val(15);    
  F17.innerText=float_val[17];    
} 
… 
 

<body onLoad="init()"> 
… 
 

<div style="position: absolute; width: 195px; height: 25px; z-index: 2; left: 45px; top: 52px" > 
L15 = <b id="L15">xxxx</b></div> 
<div style="position: absolute; width: 196px; height: 29px; z-index: 3; left: 45px; top: 82px" > 
F17 = <b id="F17">xxxx</b></div> 
 

<div style="position:absolute; left:47px; top:131px; width:204px; height:60px"> 
  <form name="form1" method="post" action="./main.dll"> 
    <input name="BEGIN"  type="hidden"  value="">  
    <input name="L15"    type="text"    value="Enter long val (L15)"> 
    <input name="F17"    type="text"    value="Enter float val (F17)"> 
    <input name="END"    type="hidden"  value="">  
  </form> 
</div> 
 
 
<div style="position:absolute; width:74px; height:31px; left: 234px; top: 150px;"> 
  <input type="button" style="cursor:hand" onClick="return Check(form1)"  value="Enter"> 
</div> 
… 
 

</body> 
 

  

範例程式:  

wphmi_03,  wphmi_04, 
wphmi_05,  wphmi_06 與 

wphmi_07 

Check( ) 可用來發

送任一 “form”。 

在此顯示動態值: 

若資料為 word，請使用 word_val[  ] 

若資料為 timer，請使用 timer_val[  ] 

若資料為 string，請使用 string_val[  ] 

當滑鼠點選按鈕，就會呼叫 

Check( ) 把資料發送到控制器。 

當滑鼠進入按鈕區，“cursor:hand” 

會將滑鼠鍵頭會顯示為手的形狀。 

輸入 “form1” 裡面的文字 L15 和 F17，若資料為 timer，請使用 

“L”，為 word 請用 “W”，為 string 請用 “S”。 

此處以“<div”  “</div>” 標籤定義文字物件

“L15” 和 “F17” 的版面配置(或位置)。 
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5.5 多重頁面 (multi-pages) 

WP-8xx7 的 Web HMI 支援多重頁面應用，請參閱第 3 章: – 範例 “wphmi_05”。 

 
 

5.5.1 Level2 與 Level3 頁面 

 
多重頁面的名稱可以是 html 檔的任何有效檔名， 

如: “page2.htm”、“kitchen.htm”、“u2-page4.htm”。 

 
若以 “u2-” 檔名開頭，就稱為 Level2 頁面，如: “wphmi_05” 裡的 “u2-Page4.htm”。 

若以 “u3-” 檔名開頭，就稱為 Level3 頁面，如: “wphmi_05” 裡的 “u3-time.htm”。 

 
甚麼是 Level2 頁面? 即: 只有在使用者以中(middle)或高(high)優先權登入才能存取的頁面，而要

存取 Level3 頁面，使用者必須以高優先權登入。頁面名稱沒有 “u2-” 和 “u3-” 就稱為 Level1 頁

面，任何人登入成功就能執行該頁面，例如: “main.htm”。 

其他多重頁面的規則幾乎與 “main.htm” 的規則相同(請見 5.4 節) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

注意:   

如果沒有勾選 “Enable Account Security”， 

任何人都能透過 IE 操控您的 PAC ! 
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5.5.2 切換頁面 

 
請看下列範例“wphmi_05” 的 “menu.htm”，“goto_R_page( )” function 可以用來切換頁面。 

 
<!-- top_or_left=0 , scrolling=0 , width=110 , resize=1 --> 
 
<html> 
<head> 
<title>Title1</title>    
<meta http-equiv="Content-Type" content="text/html; charset=big5" > 
<SCRIPT LANGUAGE="JavaScript" src="./msg/wincon.js"></SCRIPT>    
 
<SCRIPT LANGUAGE="JavaScript"> 
function start1() 
{ 
  A_11(); 
} 
function refresh_data() 
{ 
  if(run_at_pc==1) return;  // if simulate at the PC, just return 
  … 
} 
</SCRIPT> 
</head> 
<body onload="start1()"> 
 
<!-- Logout button --> 
<form name="form_logout" method="post" action="./login.dll"> 
  <input style="cursor:hand" name="CMD" type="submit" value="Logout" onClick="return 
logout(this.form)"> 
</form> 
<br/> 
<br/> 
 
<!-- Goto main.htm --> 
<A style="cursor:hand" onClick="goto_R_page('main.htm')">第 1 頁</A> 

<br/> 
<br/> 
 
<!-- Goto kitchen.htm --> 
<A style="cursor:hand" onClick="goto_R_page('kitchen.htm')">Kitchen</A><br/> 
<br/> 
<br/> 
 
 

  

切換到 “main.htm” 頁面 

切換到 “kitchen.htm” 頁面 

當滑鼠進入按鈕區，“cursor:hand” 會將滑鼠箭頭

顯示成手的形狀。 



                 WinPAC-8xx7 ISaGRAF PAC 快速上手手冊,  1.65 版,  2013 年 8 月     ICP DAS                        5-19 

5.6 網路安全防護 

以幾種方式可以經由乙太網路來存取 WP-8xx7 內的資料。 

 
1. 使用 Modbus TCP 通訊協定，port 編號 502 (ISaGRAF 與其他 HMI 用此方式) 

2. 使用 ftp (例如: 在 IE 瀏覽器網址輸入 “ftp://10.0.0.103” ) 

3. 使用 telent (例如: 在 PC 開啟一個 “command” 視窗，輸入 “telnet 10.0.0.103”) 

4. 使用 Web server (WinPAC 的 Web HMI 用此方式) 

 
為了安全，您可以開啟 PAC 驅動程式的視窗，關閉項目 2 與 3 的功能，如下: 

 
 
 
 
 
 
 
 
 
 
 
項目 4 (Settings...) 請設定必要的 username 及 password 來保護。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

勾選以關閉功能 

點選以設定使用者名

稱及密碼。 
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關於第 1 種方式 Modbus TCP/IP 的保護，您可以在控制器上設定最多開放 8 組 ISaGRAF 或其他

HMI 的 IP 可允許進來，如下圖。 

 
請在 ISaGRAF IO連結視窗選擇使用 “vip” 連接，並輸入允許連到控制器的 IP，若沒有使用 “vip”，

表示任何遠端 IP 都可使用 Modbus TCP/IP 通訊協定連進來，若使用了 “vip” 但沒設定任何 IP(都

為 “N/A”)，則沒有任何 HMI 或 ISaGRAF 可以連進來。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
若您修改了 I/O 連結設定，請再次編譯您的 ISaGRAF 專案並下載到控制器中。 
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第 6 章 使用 VB.net 2008 程式來 讀/寫 ISaGRAF 變數 

 
重要: 

請最好不要把資料 file 與 開發好的 .net 程式存放在 \System_Disk 內, 因為 \System_Disk 使用 

的是 Nor Flash 記憶體, 它主要是給 OS, ISaGRAF driver, 與一些必要 utility 與 DLL 存放使用, size 

不大. 而且 Nor Flash 記憶體 不適合常常去更新資料, 若常常在 \System_Disk 內更新 file (比如每 

1 ~5 秒就更新 file 一次, 一天下來 就更新了約幾萬次), 久了可能會損壞 \System_Disk 內的資料. 

所以自行開發的程式與要操作的 file 最好都存放在 \Micro_SD 內。 

 
 
 
 
 
 
 
本章以 Visual Studio .NET 2008 開發工具建立一個範例程式的方式來說明，範例: 

 
光碟 : \napdos\isagraf\wp-8xx7\vb.net_2008_demo\ 

wp_vb01 : 數位 I/O 範例，搭配 I-87055W 模組 (於 slot 0)  

wp_vb02 : 類比 I/O 範例，搭配 I-87024W (slot 1) 與 I-8017HW (slot 2) 模組 

wp_vb03 : 讀/寫 ISaGRAF internal integers, timers 及 real 變數 (無需 I/O 模組) 

 
對應的專案範例檔名: "wp_vb01.pia", "wp_vb02.pia", "wp_vb03.pia" (同目錄) 

 
 

 

6.1 建立新專案 

1. 開啟微軟 Visual Studio .NET 2008 軟體，點選 [File] > [New Project] 
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2. 點選 [Smart Device] > [.NET frame work 2.0] > [Smart Device Project]，在下方輸入專案名稱(本

例: project1)，然後按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. 點選 [Device Application] > [Windows CE] > [.NET Compact Framework Version 2.0]，然後

按 “OK”。 
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6.2 加入專案參考 

“QuickerNet” library 包含了所有模組的 function，在程式裡使用 “Quicker” 關鍵字之前，您必須

在應用程式的參考清單裡加入參考: “QuickerNet.dll”。 

 
1. 滑鼠右鍵點擊 “Solution Explorer” 視窗裡的專案

名稱， 

選擇 “Add Reference …” 

 
 
 
 
 
 
 
 
 
 
 
 
2. 點選 “mscorlib”，按 “OK”。 (“mscorlib” 出現在.NET 的 Component Name 區) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

右鍵 

此為 mscorlib.dll 

“.NET” 頁籤 
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3. 點選 “Browse” 頁籤，“搜尋位置” 請切換到光碟 \napdos\isagraf\wp-8xx7\ 

vb.net_2008_demo\wp_vb01\vb01\，選擇 “QuickerNet.dll”，按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. 加入 “mscorlib” 及 “QuickerNet.dll” 後，

請雙擊專案的 “My Project”，確認是否

已加入 “QuickerNet.dll”。 

 
 
 
 
 
 
 
 
 

 
 
 
 
 

5. 以滑鼠右鍵點選 “Form1.vb”，選擇 “View Code”，在第一、二行插入 “Option Explicit On” 與 

“Imports Quicker” (如下圖)。 

 
 
 
 
 
 
 
 
 
 
 
接著您就可以在您的 VB 表格中設計所需的物件與動作了。 

  

雙擊滑鼠 

雙擊 
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6.3 編譯應用程式 

程式撰寫完成後，請依下列步驟建置(build)一個應用。 

 
1. 請記得隨時按下 “Save All” 工具按鈕來存檔。 

 
  
 
 
 
 
 
 
2. 編譯 (即建置) 此專案，下方的 “Error List” 視窗會列出建置結果。 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
3. 在下列資料夾中可以展到執行檔 

 
<您的 VB.net 專案資料夾> \bin\Release\ <project_name>.exe 

 
請將此執行檔複製到控制器的 \System_Disk\ISaGRAF\ 目錄下來執行。 

 
 
注意:  

使用者可複製 VB.net 執行檔到其他目錄下執行，但是至少要同時複製 3 個 DLL 檔案，否則執

行會有錯誤。 

例如: 要在 \Micro_SD\ 目錄下執行 project1.exe，必須在該目錄下有下列 3+1 個檔案，即 

“project1.exe”、“QuickerNet.dll”、“Quicker.dll” 與 “Mscorlib.dll” 檔。 

(可在光碟的 “\System_disk\ISaGRAF\” 目錄下取得此 3 個 DLL 檔案 “QuickerNet.dll”、

“Quicker.dll” 與 “Mscorlib.dll”) 
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6.4 QuickerNET.DLL  

 
本節著重於 QuickerNET.DLL function 的應用範例說明。 

 
有許多 function 都可用來 讀/寫 資料 從/到 ISaGRAF 控制器。QuickerNET.DLL 的 function 可以

分為兩大類:  

 
1. 數位 讀/寫 Function 

2. 類比 讀/寫 Function 

 
 

6.4.1 數位(Digital) 讀/寫 函式 

  
■UserSetCoil 

 
說明:  

此 function 設定 Boolean 值到指定的 Modbus 位址編號的 Boolean 變數。 

 
語法:  

UserShare.UserSetCoil ( iUserAddress As System.UInt16, iStatus As byte)  

 
參數:  

iUserAddress : 指定變數的 Modbus 位址編號 (1 ~ 8191) 

iStatus : 設定變數的狀態；例如: iStatus = 1 表示 True，iStatus = 0 表示 False。 

 
回傳值:  

無 

 
範例:  

‘ 設定 Modbus 網路位址 “1” 的 output 變數為 True.  

UserShare.UserSetCoil(Convert.ToUInt16(1), 1)  
 
範例程式 :  

光碟:  \napdos\isagraf\wp-8xx7\vb.net_2008_demo\wp_vb01 
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■UserGetCoil 

 
說明:  

此 function 讀出指定的 Modbus 位址編號的 Boolean 變數值。 

 
語法:  

UserShare.UserGetCoil ( iUserAddress As System.UInt16, ByRef iStatus As byte)  

 
參數:  

iUserAddress : 指定變數的 Modbus 位址編號 (1 ~ 8191) 

iStatus : 取得變數的狀態；iStatus = 1 表示 True，iStatus = 0 表示 False 

 
回傳值:  

無 

 
範例:  

‘ 取得 Modbus 位址編號 “1” 的變數狀態.  

Dim iStatus As Byte  
UserShare.UserGetCoil(Convert.ToUInt16(1), iStatus)  
 
範例程式 :  

光碟:  \napdos\isagraf\wp-8xx7\vb.net_2008_demo\wp_vb01 
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6.4.2 類比(Analog) 讀/寫 函式 

 

■UserSetReg_short ■UserSetReg_long ■UserSetReg_float 

 
說明:  

這些 function 用來設定 16-bit short integer、32-bit long integer 及 32-bit float 值到指定的Modbus

位址編號。 

 
語法:  

UserShare.UserSetReg_Short (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) 
As Byte 
 

UserShare.UserSetReg_Long (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) 
As Byte 
 

UserShare.UserSetReg_Float (ByVal iUserAddress As System.UInt16, ByRef iStatus As Single) As 
Byte 

 
參數:  

iUserAddress : 指定變數的 Modbus 位址編號 (1 ~ 8191) 

iStatus : 設定 short / long integer 或 float 值 

 
範例:  

‘ 設定 long 值 “1234567” 到 Modbus 位址編號 “1” 的變數.  

UserShare.UserSetReg_long(Convert.ToUInt16(1), Convert.ToInt32(1234567) )    
 

‘ 設定 short 值 “-1234” 到 Modbus 位址編號 “3” 的變數. 

UserShare.UserSetReg_short(Convert.ToUInt16(3), Convert.ToInt16(-1234) )    
 

‘ 設定 float 值 “2.174” 到 Modbus 位址編號 “4” 的變數. 

UserShare.UserSetReg_float(Convert.ToUInt16(4), Convert.ToSingle(2.174) )    
 
範例程式:  

光碟 :   

1. 讀/寫 類比 I/O: \napdos\isagraf\wp-8xx7\vb.net_2008_demo\wp_vb02 

2. 讀/寫 internal long integer、Timer 及 Real (浮點數) 的值: 

\napdos\isagraf\wp-8xx7\vb.net_2008_demo\wp_vb03 
 
注意:  

ISaGRAF 專案中，long integer、timer 及 real 變數必須佔用 2 個網路位址編號。  

(請參閱 “ISaGRAF 進階使用手冊” 4.2 節 或 光碟: \napdos\isagraf\wp-8xx7 \english_manu\ 

“Chinese_User_Manual_I_8xx7.pdf”) 
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■UserGetReg_short ■UserGetReg_long ■UserGetReg_float 

 
說明:  

這些 function 讀出指定的 Modbus 位址編號的 16-bit short integer、32-bit long integer 及 32-bit 

float 的值。 

 
語法:  

UserShare. UserGetReg_Short (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) As 
Byte 
 
UserShare. UserGetReg_Long (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) As 
Byte 
 
UserShare. UserGetReg_Float (ByVal iUserAddress As System.UInt16, ByRef iStatus As Single) As 
Byte 

 
參數:  

iUserAddress : 指定變數的 Modbus 位址編號 (1 ~ 8191) 

iStatus : 取得 short / long integer 或 float 值 

  
範例:  

Dim float_val As Single 
Dim short_val As Int16 
Dim long_val As Int32 
  
‘ 取得 Modbus 位址編號 “7” 的 float 變數值. 

UserShare.UserGetReg_float(Convert.ToUInt16(7), float_val)  
 
‘取得 Modbus 位址編號 “9” 的 long 變數值. 

UserShare.UserGetReg_long(Convert.ToUInt16(9), long_val)  
 
‘取得 Modbus 位址編號 “11” 的 short 變數值. 

UserShare.UserGetReg_short(Convert.ToUInt16(11), short_val)  
 
範例程式:  

光碟:   

1. 讀/寫 類比 I/O: \napdos\isagraf\wp-8xx7\vb.net_2008_demo\wp_vb02 

2. 讀/寫 internal long integer、Timer 及 Real (浮點數) 的值: 

\napdos\isagraf\wp-8xx7\vb.net_2008_demo\wp_vb03 
 
注意:  

ISaGRAF 專案中，long integer、timer 及 real 變數必須佔用 2 個網路位址編號。  

(請參閱 “ISaGRAF 進階使用手冊” 4.2 節 或 光碟: \napdos\isagraf\wp-8xx7 \chinese_manu\ 

“Chinese_User_Manual_I_8xx7.pdf”) 
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第 7 章 使用 EVC++ 程式來 讀/寫 ISaGRAF 變數 

 
重要: 

 
請最好不要把資料 file 與 開發好的 .net 程式存放在 \System_Disk 內, 因為 \System_Disk 使用 

的是 Nor Flash 記憶體, 它主要是給 OS, ISaGRAF driver, 與一些必要 utility 與 DLL 存放使用, size 

不大. 而且 Nor Flash 記憶體 不適合常常去更新資料, 若常常在 \System_Disk 內更新 file (比如每 

1 ~5 秒就更新 file 一次, 一天下來 就更新了約幾萬次), 久了可能會損壞 \System_Disk 內的資料. 

所以自行開發的程式與要操作的 file 最好都存放在 \Micro_SD 內。 

 
 
使用者可以自己撰寫 EVC++ 4.0 應用程式來 讀/寫 ISaGRAF 變數，透過本章介紹的 function 可以 

讀/寫 boolean、word、long 及 float 值。 

 
設計時需要包含進來的檔案與 library 為  “WinConAgent.h” 與  “Quicker.lib” (光碟目錄 : 

\napdos\isagraf\wp-8xx7\evc++_lib\ )。 

 
執行時需要的 DLL 為 “Quicker.dll” (光碟目錄: \System_Disk\isagraf\ )。 

 
請將編譯成功的執行程式檔複製到 WinPAC 控制器的目錄: \System_Disk\isagraf\ ，然後執行。 
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寫入 boolean 值 : 

 

unsigned char UserSetCoil(unsigned short iUserAddress, unsigned char iStatus); 

 
 iUserAddress: 1 ~ 8191  (ISaGRAF 專案中，變數的網路位址編號) 

 iStatus:    0: 寫入 boolean 值 False；1: 寫入 boolean 值 True 

 
 例如:   

  UserSetCoil(100 , 1)  // 將 True 值寫入位址編號 “100” 的變數 

 
 
寫入 word 或 float 或 long 值 : 

 

 
 iUserAddress:  1 ~ 8191  (ISaGRAF 專案中，變數的網路位址編號) 

 iStatus:   long 型態的指標，用來儲存要寫入的資料 

 iDType 0: 資料型態為 word  

  1: 資料型態為 float  

  2: 資料型態為 long  (ISaGRAF 裡 Timer 值的型態: long, 單位: ms) 

 例如: 

  float   float_val; 
  long   word_val, long_val; 
  long   *temp_val; 
 

  // 把 word_val (-32768 ~ +32767) 寫入網路位址編號 1 的 ISaGRAF 變數 

  word_val = -20000 ; 
  temp_val = (long *)(&word_val); 
  UserSetReg(1 , temp_val, 0); 
 
  // 把 float_val 寫入網路位址編號 2 的 ISaGRAF 變數 

  float_val = 1.2345 ; 
  temp_val = (long *)(&float_val); 
  UserSetReg(2 , temp_val, 1); 
 
  // 把 long_val 寫入網路位址編號 4 的 ISaGRAF 變數 

  long_val = 12345678 ; 
  temp_val = (long *)(&long_val); 
  UserSetReg(4 , temp_val, 2); 
 
 
  

unsigned char UserSetReg(unsigned short iUserAddress, long *iStatus, unsigned char iDType); 
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讀出 boolean 值 : 

 

 
 iUserAddress: 1 ~ 8191  (ISaGRAF 專案中，變數的網路位址編號) 

 iStatus:    0: 布林為 False；1: 布林為 True 

 
 例如:   

  unsigned char bVal; 
  UserGetCoil(5 , &bVal)  // 把布林值寫入網路位址編號 5 

 
 
 
讀出 word 或 float 或 long 值 : 

 

 
 iUserAddress: 1 ~ 8191  (ISaGRAF 專案中，變數的網路位址編號) 

 iStatus:   long 型態的指標，用來儲存回傳的資料 

 iDType 0: 資料型態為 word  

  1: 資料型態為 float  

  2: 資料型態為 long  (ISaGRAF 裡 Timer 值的型態: long，單位: ms) 

 例如: 

  float   float_val; 
  long   word_val, long_val; 
  long   ret_val; 
 
       // 取得網路位址編號 10 的 ISaGRAF 變數 word_val (-32768 ~ +32767) 

  UserGetReg(10, &ret_val, 0); 
  if ( ret_val>=0  &&  ret_val<=32767 )  word_val = ret_val; 
  else  word_val = ret_val  |  0xFFFF0000; 
 
  // 取得網路位址編號 11 的 ISaGRAF float 變數 

  UserGetReg(11, &ret_val, 1) ; 
  float_val = *(float *) (&ret_val) ; 
 
  //取得網路位址編號 13 的 ISaGRAF long 變數 

  UserGetReg(13, &ret_val, 2) ; 
  long_val = ret_val ; 
 
注意:  

ISaGRAF 專案中，long integer、timer 及 real 變數必須佔用 2 個網路位址編號。  

(請參閱 “ISaGRAF 進階使用手冊” 4.2 節 或 光碟: \napdos\isagraf\wp-8xx7 \english_manu\ 

“Chinese_User_Manual_I_8xx7.pdf”) 
 
 

unsigned char UserGetCoil(unsigned short iUserAddress, unsigned char *iStatus); 

unsigned char UserGetReg(unsigned short iUserAddress, long *iStatus, unsigned char iDType); 
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第 8 章 使用 InduSoft 專案來 讀/寫 ISaGRAF 變數 

注意: 

 
如果 HMI 程式運作不順或通訊遲緩，請參閱附錄 F。 

WinPAC-8xx7 (或 WP-8xx7 或 WP-8x47) 為 WP-8147/8447/8847 的簡稱。 

WinPAC-8xx6 (或 WP-8xx6 或 WP-8x46) 為 WP-8146/8446/8846 的簡稱。 

 
重要:  

 
1. WP-8xx7/8xx6 需設定為固定 IP 位址。 (不可使用 DHCP) 

2. 建議使用工業級乙太網路交換器 NS-205/208 或 RS-405/408 來連接 PAC。 

3. 詳細資料請參考 “ISaGRAF 中文進階手冊”，請見光碟: 

\napdos\isagraf\wp-8xx7\chinese_manu\ datasheet PDF 檔案 

4. WinPAC-8xx6 可支援 InduSoft 與 ISaGRAF 同時運行於控制器中 

 
 
 
 
 
 
控制器同時執行 InduSoft 與 ISaGRAF 的簡單範例: 

 
步驟 1: 建立新的 ISaGRAF 專案 

 
本範例使用 PAC控制器WP-8xx6 + I-87055W DI/DO模組(插槽 0) + I-87024W AO 模組(插槽 2)，

以及一個 internal 變數，ISaGRAF 變數定義如下: 

 
 

變數型態 名稱 網路位址編號 說  明 屬性 

Boolean DI_1 1 87055W DI 點 1 Input 

Boolean DO_1 11 87055W DO 點 1 Output 

Integers AO_1 21 87024W AO 點 1 Output 

Integers Internal 31 內部變數 Internal 

 
 
若您不熟悉 ISaGRAF 設定步驟，請參閱本手冊 4.1 節到 4.3 節。 

 
並設定 I/O 的連接，如下圖:  
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設定 I/O 的連接, 如下圖:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
要與 InduSoft 交換的 ISaGRAF 變數必須宣告其 Modbus “網路位址”, 方法如下:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
請存檔並編譯此 ISaGRAF專案, 然後下載到控制器(PAC), 若不熟悉步驟, 請參閱本手冊 4.1 節到

4.3 節. 

  

空的 LD 程式 

請設定編號為十進位 “Decimal” 

本範例請設定編號 1 給 DI_1 

            編號 11 給 DO_1 

            編號 21 給 AO_1 

            編號 31 給 Internal 
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步驟 2: 建立 InduSoft 專案 
 

1. 開啟 “InduSoft Web Studio”, 點選 [File] > [New] . 

2. 出現 “New” 視窗, 請點選 “Project” 頁籤, 在 “Project name” 欄位輸入要建立的專案名稱, 在 

“Product type” 項目選擇 “Windows Embedded Lite” , 按 “OK” . 

3. 出現 “Project Wizard” 視窗, 請選擇 “Template” 的 “Empty Application” , “Resolution” 的 

“320 x 240” 及 “Shared Tags” 的 “None” .  

4. “Project Explorer” 視窗出現您的新專案(如下圖). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

1 

2 

3 
4 
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定義應用標籤 
 
點選功能表 [Insert] > [Tag] . 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
出現 “New Tag” 視窗. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
本範例使用一個 DI/DO 模組 I-87055W, 一個 AO 模組 I-87024W 與一個 internal 變數, 變數定義

如下, 請一一建立下列標籤. 
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建立主螢幕  
 
1. 點選 “Project Explorer” 視窗的 “Graphics” 頁籤 

2. 再以滑鼠右鍵點選 “Screens” 的 “Insert“ , 會出現 “Screen Attributes” 視窗 

3. 設定螢幕屬性, 如: 大小 “Size”, 位置 “Location”, 執行屬性 “Runtime Properties” 與背景圖 

“Background Picture” 等, 按 “OK” 可開始編輯螢幕. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. 點選 “Text” 文字工具按鈕, 在主螢幕上要放文字標籤的位置點選一下, 輸入 
“87055W_DI_1”. 

5. 再次以同樣方式點選 “Text” 按鈕, 輸入 “#” (“#” 表示顯示 1 位數, “####” 表示顯示 4 位數，

“######” 表示顯示 6 位數), 然後點選 “Text Data Link” 按鈕. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
  

4. 點選 “Text” 加入標籤 

“87055W_DI_1” 

5. 點選 “Text” 加入 “#” 標籤, 然

後點選 “Text Data Link” 

“#”    表示顯示 1 位數 

“####” 表示顯示 4 位數 

2. 滑鼠右鍵點選 “Screen” 資料夾 

1. 點選 “Graphics” 

3. 設定螢幕屬性 
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6. 滑鼠雙擊 “#” 物件, 出現設定視窗, 在 “Tag/Expression” 欄位輸入 “DI”. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
重複前述步驟, 建立其他物件, 最後點選主功能表的 “Save” 工具按鈕, 將此螢幕存檔為 

“MainPage.scr”. (點選 [File] > [Save As HTML] 讓遠端工作站使用一般瀏覽器就可看到本螢幕)  
 
 
注意: 輸出物件, 如 87024W_AO_1 及 87055W_DO_1, “Text Data Link” 的 “Input Enabled” 設定, 

必須如下圖所示. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

主螢幕建立完成, 如下圖所示. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

勾選此項, 表示使用

者可在程式執行時

輸入物件值。 
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建立 Modbus TCP 工作區 
 
1. 點選 “Project Explorer” 視窗的 “Comm” 頁籤 

2. 以滑鼠右鍵點選 “Drivers” 資料夾, 選擇 “Add/Remove drivers” 

3. 在開啟的 “Communication Drivers” 視窗, 選擇 “MOTCP” DLL, 按 “Select”, 最後點選 “OK” 關

閉此視窗. 
 
 

            
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
展開 “Drivers” 資料夾, 以滑鼠右鍵點選 “MOTCP” 資料夾, 選擇 “Insert”. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
  

以右鍵點選，然後選擇 “Insert”  

2. 右鍵點選“Drivers”, 選 “Add/Remove drivers” 

1. 點選頁籤“Comm” 

3. 選擇 DLL 為 “MOTCP” 



 

8-8                       WinPAC-8xx7 ISaGRAF PAC 快速上手手冊,  1.65 版,  2013 年 8 月     ICP DAS     

出現一個 Modbus TCP 工作區 “MOTCP001.DRV”, 請如下圖填入您相對應的資料. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

資料 

型態 

語法 

範例 

工作區初始位址的

有效範圍 
說  明 

0X 0X:1 依設備而不同 Coil 狀態: 使用 Modbus 命令 01, 05, 15 來讀寫 

1X 1X:5 依設備而不同 Input 狀態: 使用 Modbus 命令 02 來讀出 

3X 3X:4 依設備而不同 Input Register: 使用 Modbus 命令 04 來讀出 

4X 4X:5 依設備而不同 Holding Register: 使用 Modbus 命令 03, 06, 16 來讀寫 

FP FP:1 依設備而不同 
浮點數值(Holding Register): 使用兩個連續 Holding 

Registers 來讀寫 

DW DW:2 依設備而不同 
32-bit 整數值 (Holding Register): 使用兩個連續 Holding 

Registers 來讀寫 

 
  

“127.0.0.1:502:1” 的意義: 

“127.0.0.1” 近端主機 IP 位址, 

表示資料傳輸到同一控制器. 

“502” 是 Modbus TCP/IP 的埠號. 

最後的 “1” 是 PAC 的站號(Net-ID). 

1X:0   讀取 “Boolean” 資料 

0X:0   寫入 “Boolean” 資料 

3X:0   讀取 “short integer” 資料 (16-bit integer,  Word: -32768 ~ +32767) 

4X:0   寫入 “short integer” 資料 (16-bit integer,  Word: -32768 ~ +32767) 

DW:0  讀寫 “long integer”  資料 (32-bit integer, Double Word) 

FP:0   讀寫 “floating point” 資料 (32-bit REAL) 

 
其他詳細資料請參考下表. 
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請依下表資料插入下列 4 個 Modbus TCP 工作區:  
 

DRV 名稱 MOTCP001.DRV MOTCP002.DRV MOTCP003.DRV MOTCP004.DRV 

Description DI DO AO Internal 

Station 127.0.0.1:502:1 

Header 1X:0 0X:0 4X:0 3X:0 

Tag Name DI DO AO Internal 

Enable Read  
when Idle 1   1 

Enable Write  
on Tag Change  1 1  

Address 1 11 21 31 

 
以上項目設定完成, 請按鍵盤 “Ctrl + F4” 來關閉所有內部視窗並儲存所有檔案. 
 
 
 
專案設定 
 
選擇 [Project] < [Viewer] 開啟 “Project Settings” 視窗, 將 “Startup screen” 項目設定為 

“MainPage.scr”, 然後按 “OK” 關閉視窗. 
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網頁客戶端: Web Thin Clients 
 
選擇 [Project] < [Web] 開啟 “Project Settings” 視窗, 在 “Data Server IP Address” 填入 PAC正確的

IP 網址, 按 “OK”. 
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下載與執行專案 
 
點選 [Home] > [Connect] 開啟 “Remote Management” 視窗, 在 “Target Station” 的 “Network IP” 

輸入您 PAC 的正確 IP 位址, 按 “Connect”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
在通訊正常下, 點選 “Project” 頁籤, 按 “Download” 按鈕, 當下載完成, 按 “RUN” 按鈕來執行專

案. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

請輸入您 PAC 的 IP 網址 

“Install system files” 按鈕可以更新您 ViewPAC 的 InduSoft firmware 到 PC 目前的

版本, 點選按鈕之前, 請確認您的ViewPAC 目錄 \System_Disk\InduSoft\path下的

檔案不是唯讀的(read only), 才能更新. 
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規劃 WinPAC 的網頁路徑 

 
執行WinPAC Utility並修改網頁路徑為 “\System_Disk\InduSoft\Demo_01\Web”， 點選 “Setting” 

及 “Save and Reboot” 來完成規劃。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

遠端實測您的專案 

 
開啟 IE 瀏覽器，輸入 WinPAC 的 IP 網址，例如: “http://10.0.0.80/MainPage.html”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://10.0.0.80/MainPage.html
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第 9 章 範例程式 與 FAQ 

WinPAC-8xx7 或 WP-8xx7 為 WP-8147/8447/8847/8137/8437/8837 的簡稱. 

WinPAC-8xx6 或 WP-8xx6 為 WP-8146/8446/8846/8136/8436/8836 的簡稱. 

 
詳細說明請參考 “ISaGRAF 進階手冊”，放置於 WP-8xx7 光碟: 

  \napdos\isagraf\wp-8xx7\chinese_manu\ "Chinese_user_manual_i_8xx7.pdf" 
"Chinese_user_manual_i_8xx7_appendix.pdf" (附錄) 

範例程式: http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download.html#demo 

FAQ:  www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC  

 

9.1 線上支援 

如有任何疑問，您可以寫信至電子郵件信箱: service@icpdas.com. 

 
ISaGRAF 標準功能與功能方塊的線上支援: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download.html#demo
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
mailto:service@icpdas.com
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ICP DAS 新增功能與功能方塊的線上支援 : 
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 ICP DAS 新增 I/O 模組 與 I/O 複合設備: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ISaGRAF 程式語言線上支援: 
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9.2 安裝 ISaGRAF 程式範例 

ISaGRAF 程式範例 放置於 ISaGRAF WinCE ViewPAC 光碟與網頁: 
 

CD-ROM: \napdos\isagraf\vp-25w7-23w7\demo\ 

Web: http://www.icpdas.com  > 商品目錄 > 解決方案 > Soft PLC, ISaGRAF & Soft-GRAF 

HMI > 下載區 -範例程式  

FTP: ftp://ftp.icpdas.com/pub/cd/vp-25w7-23w7/napdos/isagraf/vp-25w7-23w7/demo/ 
 
ISaGRAF 進階使用手冊 放置於 ISaGRAF WinCE ViewPAC 光碟與網頁: 
 

中文: \napdos\isagraf\vp-25w7-23w7\chinese-manu\ “Chinese_User_Manual_I_8xx7.pdf” 

“Chinese_User_Manual_I_8xx7_Appendix.pdf” 

Web:  > 商品目錄 > 解決方案 > Soft PLC, ISaGRAF & Soft-GRAF HMI > 下載區 -手冊  

 
ISaGRAF 問題集 :   

FAQ 常問問題集: www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC >  

    下載: ftp://ftp.icpdas.com/pub/cd/winpac-8xx7/napdos/isagraf/wp-8xx7/demo/  

 
 
 
範例程式列表 : 
 

專案名稱 說明 使用的 I/O 模組 

Soft-GRAF 
demo01 ~ 
demo07 

Soft-GRAF HMI 範例 demo01 ~ demo07.   

(sofgr_01~sofgr_08: FAQ-146) 
 

example1 Web HMI 人機頁面 簡單範例  slot 0: I-87055W 

wp_vb01 
WP-8xx7 的 VB.net 2008 demo 01: DI/DO 範例 

請參考第 6 章 
slot 0: I-87055W 

wp_vb02 
WP-8xx7 的 VB.net 2008 demo 02: AI/AO 範例 

請參考第 6 章 
slot 1: I-87024W 
slot 2: I-8017HW 

wp_vb03 
WP-8xx7的VB.net 2008 demo 03: 讀/寫 long integer, float

及 Timer .  請參考第 6 章 
 

wpdmo_01 
WinPAC demo_01: 如何在 WinPAC 內 讀/寫 File 資料

(float 值)。(FAQ > 060) 
 

wpdmo_02 
WinPAC demo_02: 如何在WinPAC內 讀/寫 File資料(long 

integer 值)。(FAQ  > 060) 
 

wpdmo_03 
依時間間隔輸出，如 SYSDAT_R, SYSDAT_W, SYSTIM_R, 

SYSTIM_W (ST+QLD) 

 
 

wpdmo_04 
WinPAC demo_04: 使用者自訂 Modbus 通訊協定 (不使

用 "Mbus") 
 
 

wpdmo_05 指定事件發生數秒後觸發某動作.  (英文 FAQ  > 017) slot 0: I-87055W 

http://www.icpdas.com/index_tc.html
http://www.icpdas.com/root/product/solutions/solutions_tc.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/softplc_based_on_pac_products_tc.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/softplc_based_on_pac_products_tc.html
ftp://ftp.icpdas.com/pub/cd/vp-25w7-23w7/napdos/isagraf/vp-25w7-23w7/demo/
http://www.icpdas.com/index_tc.html
http://www.icpdas.com/root/product/solutions/solutions_tc.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/softplc_based_on_pac_products_tc.html
http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
ftp://ftp.icpdas.com/pub/cd/winpac-8xx7/napdos/isagraf/wp-8xx7/demo/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/faq/isagraf.htm
http://www.icpdas.com/faq/isagraf.htm
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專案名稱 說明 使用的 I/O 模組 

wpdmo_06 使用 Message 陣列 - MsgAry_r , MsgAry_w  

wpdmo_07 轉換 float 值為 string，使用 real_str 與 rea_str2  

wpdmo_08 
PID 控 制 ， 參 考 光 碟 : \napdos\isgraf\wp-8xx7\ 

english_manu\ "PID_AL...htm" 
 

wpdmo_09 儲存與備份 boolean / long integer 值  到/從  檔案  

wpdmo_10 儲存與備份 boolean / long integer 值  到/從  EEPROM  

wpdmo_11 
以 \Micro_SD 為目錄，每隔 10 秒儲存 3 個值到 3 個檔

案，每個月改變檔名。 
 

wpdmo_14 
Retain variable: Retain_b, Retain_N, Retain_f, Retain_t  
(中文 FAQ  > 074) 

 

wpdmo_16 
以 \Micro_SD 為目錄，每隔 1 分鐘儲存 3 個值到 1 個檔

案，每天改變檔名。 
 

wpdmo19 
當警告發生，傳遞 UDP 字串到 PC，Time_Gap 為 1 秒 (使

用變數陣列) (參考 “ISaGRAF 進階手冊” 第 19.2 節) 
slot0: I-87055W 

wpdmo19a 
3 秒後傳遞 UDP 字串到 PC，Time_Gap 為 250 ms (請參

考 “ISaGRAF 進階手冊” 第 19.2 節) 
slot0: I-87055W 

wpdmo19b 
3 秒後傳遞 UDP 字串到 PC，Time_Gap 為 250 ms 

(wpdmo19a 較佳) (見 “ISaGRAF 進階手冊” 第 19.2 節) 
slot0: I-87055W 

wpdmo_20 投過 UDP/IP 從遠端 PC 或控制器接收字串  

wpdmo_21 使用 "com_MRTU" 來 停止/啟動 Modbus RTU slave 埠  

wpdmo_22 PWM I/O 範例(WinPAC 脈寬調整，最小 2 秒) slot 0: I-8055W 

wpdmo_23 
使用 COMOPEN, COMSTR_W，每秒傳遞時間字串到

COM3:RS-232。 (中文 FAQ  > 059) 
 
 

wpdmo_24 當發生警報 1~8，傳遞字串到 COM3 slot 0: I-87055W 

wpdmo_26 
移動 WP-8xx7 插槽 1 的 I-8091W 的 X 軸時脈 

(請參考 “ISaGRAF 進階手冊” 第 18 章) 
slot 1: I-8091W 
 

wpdmo_27 
運動控制:  x 軸  

(請參考 “ISaGRAF 進階手冊” 第 18 章) 
slot 1: I-8091W 
slot 2: I-8090W 

wpdmo_28 
運動控制 :  x-y 軸 

(請參考 “ISaGRAF 進階手冊” 第 18 章) 
slot 1: I-8091W 
slot 2: I-8090W 

wpdmo_29 
當給予 CMD 時，移動到絕對位置 

(請參考 “ISaGRAF 進階手冊” 第 18 章) 
slot 1: I-8091W 
slot 2: I-8090W 

wpdmo_30 

WP-8xx7(10.0.0.102) 連結 2 個 I-8KE8 乙太網路擴充單元 

+ I/O 模組，一個是 10.0.0.108，一個是 10.0.0.109。  (中

文 FAQ  > 042) 

 

wpdmo_31 
WP-8xx7(10.0.0.2) 連結 1 個 I-8KE8 乙太網路擴充單元 + 

I/O 模組 (10.0.0.109)。  (FAQ > 042) 
 

http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/root/support/faq/isagraf_tc.php
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專案名稱 說明 使用的 I/O 模組 

wpdmo_32 
設定 WP-8xx7 為 TCP/IP Client 並連結到其他 TCP/IP 

server (1 個連接) (見 “ISaGRAF 進階手冊” 第 19.3 節) 
slot 0: I-87055W 

wpdmo_33 同 Wpdmo_32，但當事件持續超過 3 秒時，只傳遞訊息 slot 0: I-87055W 

wpdmo_36 從 Modbus RTU 設備讀出實數值 (FAQ - 047, 075)  

wpdmo_37 將實數值寫到 Modbus RTU 設備 (FAQ– 047,075)  

wpdmo_38 
使用 Modbus 函式 6 來寫 16 個位元到設備 

(FAQ - 046 與 075) 
 

wpdmo_39 
WP-8xx7 + I-8172W 連接 FRNET I/O 模組 

(FAQ - 082) 
 

wpdmo_41 

使用 COM3 連接 1: M-7053D + 2: M-7045D  

(MBRTU 格式, baud=9600) 

(請參考 “ISaGRAF 進階手冊” 第 21 章) 

 

wpdmo_42 
使用 COM3 連接 1: M-7053D 來讀取 DI 計數值  (MBRTU 

格式, baud=9600) 
 

wpdmo_43 
使用 COM3 連接 1: M-7017R + 2: M-7024 (MBRTU 格式, 

baud=9600) 
 

wpdmo_44 
使用 COM3 連接 1: M-7017RC,  Current input, +/- 20mA,  

4-20mA (Modbus 格式) 
 

wpdmo_45 
使用 COM3 連接 1: M-7019R (設定為 T/C K-type input) 

(MBRTU 格式, baud=9600) 
 

wpdmo_46 
使用 COM3 連接 1: M-7080  

(MBRTU 格式, baud=9600) 
 

wpdmo_48 VB.net 2005 範例 - "MBTCP_demo" (FAQ > 051)  

wpdmo_50 
非線性轉換，例如: 給 P 值，求 V 值 (P , V 的關係列於檔

案) 
 

wpdmo_51 
使用 str_real 函式，從檔案讀取 10 個實數，共 10 列，

每列 1 個實數。 
 

wpdmo_52 

Msg_F 函式範例，ISaGRAF PAC 的驅動程式需為下列版

本或更新版本。 

I-8xx7: 3.19 版;  I-7188EG/XG: 2.17/2.15 版; W-8xx7: 3.36

版;  WP-8xx7:  

 

wpdmo_53 

Msg_N 函式範例，ISaGRAF PAC 的驅動程式需為下列版

本或更新版本。 

I-8xx7: 3.19;  I-7188EG/XG: 2.17/2.15;  
W-8xx7: 3.36;  WP-8xx7:   

 

wpdmo_54 
使用 msg_f 函式，從檔案讀取 20 個實數，共 4 列，每

列 5 個實數。 (FAQ > 060) 
 

http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
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專案名稱 說明 使用的 I/O 模組 

wpdmo_55 
使用 msg_n 函式，從檔案讀取 20 個整數，共 2 列，每

列 10 個整數。 
 

wpdmo56 保存 17 個實數到檔案中，共 2 列，每列 10 個實數。  

wpdmo56a 
保存 2 個布林 + 17 個實數到檔案，2 列，每列 10 個實

數。 
 

wpdmo56b 保存 25 個整數到檔案中，2 列，每列 10 個整數。  

wpdmo56c 
保存 2 個布林 + 25 個整數到檔案，2 列，每列 10 個實

數。  (FAQ > 060) 
 

wpdmo56d 
保存 17 個實數 + 2 個布林 + 10 個整數到 2 個檔案，每

列 10 個值。 
 

wpdmo56e 
保存超過 255 個實數、255 個布林、255 個整數到 2 個

檔案，最多 1024 個值。 
 

wpdmo_61 
I-8xx7, WP-8xx7: 透過 UDP 主動資料回報到 PC。控制器

=10.0.0.103，PC=10.0.0.91 
 

wpdmo_62 
使用乙太網路埠發送 email (不附加檔案，寄給一個收件

者)  (FAQ > 067, 071, 072, 076 或 077) 
 

wpdmo_63 
只有 WP-8xx7 與 W-8xx7 有此功能: 發送可夾帶附件的

email 給一個收件者  (FAQ > 067, 071, 072 或 077) 
 

wpdmo64a 工作站 1001, 使用乙太網路對多台控制器做時間校正。  

wpdmo64b 工作站 1002, 使用乙太網路對多台控制器做時間校正。  

wpdmo65a 
WP-8xx7 應用: 每分鐘記錄溫度到檔案一次，每天將記錄

檔以 email 寄出。(FAQ > 067, 71, 72, 76, 77) 
slot 2: I-87018z 

wpdmo65b 
WP-8xx7: 同 wdmo_65a，但增加時間校正與發出報告給

PC。(FAQ > 067, 071, 072, 076 或 077) 
slot 2: I-87018z 

wpdmo_66 
每隔 20ms 記錄 I-8017HW 模組 1~ 4-Ch. 的電壓，並以

email 發送記錄檔 
slot 2: I-8024W 
slot 3: I-8017HW 

Wpdmo_70 
FRnet 應用: WP-8xx7 或 iP-8447。slot1: I-8172W,  

Port0, FR-2057(adr=4), FR-2053(adr=8) 

slot 1: I-8172W  
FR-2057, FR-2053 

wpdmo71a 

CAN應用: 以WP-8xx7的COM4連接 I-7530  -- "CANopen" 

ID=1 設備 (8DI, 8DO, 4AO, 8AI)。 

(FAQ > 086) 

 

wpdmo71b 
類似 wdmo_71A，但連接 2 個 I-7530，一個連接 COM5，

一個連接 COM6。 
 

wpdmo71c 
WP-8xx7 COM4 – I-7530 – 使用 CAN 設備取得字串(也包

含 float 或 integer 資料) 
 

wpdmo71d 
類似 wdmo_71c，但連接兩個 I-7530，一個連接 COM5，

一個連接 COM6。 
 

http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
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專案名稱 說明 使用的 I/O 模組 

wpdmo71e 
WP-8xx7: 以 COM5 連接 I-7530 來連接 CANopen 設備，    

以 COM6 連接 I-7530 來連接 CAN 設備。 
 

wpdmo72a 

新的 WP-8xx7 可熱插拔備援系統(冗餘系統):  

搭配 RU-87P4 + I-87K I/O (不連接 Touch HMI)   

(FAQ > 093) 

 

wpdmo72b 

同 wpdmo72a，但設定 COM1 為 Modbus RTU slave 埠來

連接一台 RS-232 觸控螢幕(Touch HMI)   

(FAQ > 093) 

 

wpdmo72c 
新的 WP-8xx7 備援(冗餘)系統 (Ethernet I/O) : 

搭配 I-8KE8-MTCP I/O 模組.  (不連接 Touch HMI) 
 

wpdmo74a 求實數平均值  (FAQ > 099)  

wpdmo74b 求整數平均值  (FAQ > 099)  

wpdmo75 在插槽 0 使用 I-8088W(8-ch, PWM output) slot 0: I-8088W 

wpdmo75b 
經由 WP-8xx7 的 COM2:RS485 連接 I-87088W (I-7088) 

(addr=1,baud=115200) 
I-87088W (I-7088) 

wpdmo77a 
使用 eth_udp，eth_send( ) ，eth_recv( ) 來傳送 / 接收 

UDP bytes  
 

wpdmo77b 
使用 eth_tcp ，eth_send( ) ，eth_recv( ) 來傳送 / 接收 TCP 

bytes  
 

wpdmo78 
XP-8xx7-CE6 COM3 Mbus Master---M-7011 (ID=1, 
baud=9600) 來取得 AI,DI (FAQ > 118) 

M-7011 

wpdmo78 
WP-8xx7 COM2 Mbus Master---M-7011 (ID=1, 
baud=9600) 來取得 AI,DI (中文 FAQ -118) 

M-7011 

wpdmo79a AP1 (中文 FAQ -119): Mbus RTU Master (中央工作站)  

wpdmo79b 
AP1 (中文 FAQ -119): Mbus RTU Slave (區域工作站 1), 須

設定 ID (Slave Number) 為 1 
 

wpdmo79c 
AP1 (中文 FAQ -119): Mbus RTU Slave (區域工作站 2), 須

設定 ID (Slave Number) 為 2 
 

wpdmo80a AP2 (FAQ - 119): Mbus TCP Master (中央工作站)  

wpdmo80b 
AP2 (FAQ - 119) (區域工作站 1), 須設定 ID 為 1, 

LAN1=192.168.1.178, LAN2=192.168.1.179 
 

wpdmo80c 
AP2  (FAQ - 119) (區域工作站 2), 須設定 ID 為 1, 

LAN1=192.168.1.180, LAN2=192.168.1.181 
 

wpdmo81 
WP-8xx7+slot 1: I-8017HW (single-End) 來取得 動態平均

值 (中文 FAQ -120) 
slot 1: I-8017HW 

wphmi_01 WinPAC Web HMI 人機範例 example 1 ,   

http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/faq/isagraf_c.htm
http://www.icpdas.com/faq/isagraf_c.htm
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專案名稱 說明 使用的 I/O 模組 

顯示控制器的日期與時間 (無 I/O 模組) 

wphmi_02 
WinPAC Web HMI 人機範例 example 2 ,   

DI 與 DO 範例程式 (slot 0: I-87055W) 
slot 0: I-87055W 

wphmi_03 
WinPAC Web HMI 人機範例 example 3 ,   

讀/寫 Long, float 與 Timer 的值 (無 I/O 模組) 
 

wphmi_04 
WinPAC Web HMI 人機範例 example 4 ,   

讀寫控制器的 String 值 (無 I/O 模組) 
 

wphmi_05 
WinPAC Web HMI 人機範例 example 5,  

多重頁面範例, 選單在左 
slot 0: I-87055W 

wphmi05a 
WinPAC Web HMI 人機範例 example 5A,  

多重頁面範例, 選單在上 
slot 0: I-87055W 

wphmi_06 
WinPAC Web HMI 人機範例 example 6,  

AIO 範例, 於 ISaGRAF 中運算 
slot 2: I-87024W 
slot 3: I-8017HW 

wphmi_07 
WinPAC Web HMI 人機範例 example 7,  

AIO 範例, 於 PC 中運算 
slot 2: I-87024W 
slot 3: I-8017HW, 

wphmi_08 
WinPAC Web HMI 人機範例 example 8,  

下載控制器的檔案到 PC 中 
slot 0: I-87055W 

wphmi_09 
WinPAC Web HMI 人機範例 example 9,  

於 PC 視窗自動顯示警告視窗 
slot 0: I-87055W 

wphmi_11 趨勢線範例  (slot 2: I-87024W , slot 3: I-8017HW) 
slot 2: I-87024W 
slot 3: I-8017HW 

wphmi_12 
每 50ms 記錄 I-8017HW 1 ~ 8 Ch. 的電壓, 並繪製

M.S.Excel 趨勢圖 
I-8017HW 

wphmi_13 
每 10ms 記錄 I-8017HW 1 ~ 4 Ch. 的電壓, 並繪製

M.S.Excel 趨勢圖 
I-8017HW 
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安裝 ISaGRAF 程式範例到 WinPAC 時，強烈建議您建立一個 “ISaGRAF 專案群組”，將所有的範

例程式檔案都安裝在裡面，例如: 建立 “Demo” 專案群組。 

點選工具按鈕 [Select project group] > [New group]，輸入您要的群組名稱。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
接著將範例程式安裝到建立的專案群組中，在 "ISaGRAF Project Management" 視窗點選 [Tools] 

> [Archive] > [Projects]。 
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接著出現 "Archive Projects" 視窗，點選 "Browse" 按鈕選擇範例程式檔案存放的硬碟與資料夾 

(在 WP-8xx7 光碟  \napdos\isagraf\wp-8xx7\demo\ )，選好按 “OK”。 

 

 
 

 
接著開始安裝，滑鼠選取 Archive 欄位裡所有檔案 (先以滑鼠點選 "wdemo_01" 檔案，再按住

鍵盤 "Shift" 鍵不放，以滑鼠捲動 Archive 欄位的捲動軸直到出現最後一個檔案，以滑鼠點選

最後一個檔案後，放開鍵盤 "Shift" 鍵，即可選取所有檔案)，按下 "Archive" 視窗的 “Restore” 按

鈕，所有範例程式將安裝到您建立的資料夾中。 
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9.3 FAQ : 常見問題表 
 

FAQ (ISaGRAF Ver.3 FAQ 中文:  問題 / 說明 / 範例程式) 網頁指引 

     www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC  

 
 
FAQ 問題列表: 
 

編號 中文 ISaGRAF Ver.3 FAQ 

5 Q: 如果我的 ISaGRAF 軟件不是 ISaGRAF-256 或 ISaGRAF-L, 可以使用超過 32 個 I/O 點嗎 ?  

16 
Q:若 D/I 量測點在切換 OFF 到 ON, 或由 ON 到 OFF 過程中有短暫的訊號跳動現象, 該如

何來編程 ? 

18 Q: ISaGRAF-256 軟體是否有 I/O 點數的使用限制 ? 

20 Q:如何在 ISaGRAF 內搜尋某一變數名稱 ? 

21 Q:有時在關閉 ISaGRAF 視窗時會卡住約 20 ~ 40 秒, 如何解決 ? 

22 
Q:如何使用 Proface 的人機介面 (Touch-Panel HMI) 來連接 I-7188EG/XG , I-8xx7 與 

WinCon-8xx7 等 ISaGRAF 控制器 ? 

24 
Q:如何將 Analog / Input 或 Analog / Output 的 4 到 20 mA 值, 轉換成 工程應用值 ? 如何

將 Analog / Input 或 Analog / Output 的 0 到 10 V 值, 轉換成 工程應用值 ?  

30 Q:如何直接取得第 0 ~ 7 的 I/O 插槽內溫度卡片的“攝氏度”或“華式度”值 ? 

31 Q:如何直接取得遠程 I-7000 及 I-87xxx 溫度輸入 I/O 的溫度值 ? 

38 Q:如何 啟用 I-7188EG 或 I-7188XG 的 COM3 成為 Mobus RTU slave 埠 ? 

39 Q:如何使用變數陣列 ? 

40 

Q:如何啟用 I-8437 / 8837 的 COM3:RS232/485 來成為 Modbus RTU Slave 串口 ? 如何改變

COM1 與 I-8417 / 8817 的 COM2 或 I-8437/8837 的 COM3 Modbus RTU port 通訊速率

之設定 ?  

41 Q:如何將 圖控/HMI/上位機 連接到 單一 IP 地址的備援(冗餘) 系統 ?  

42 
Q:如何使用 WinCon-8347 / 8747 來連接 I-8KE4-MTCP 與 I-8KE8-MTCP 這 2 款 Ethernet 

I/O ?  

46 Q:如何使用 Modbus 函式 6 來寫 16 個 Bit 到 Modbus RTU 設備 ? 

47 Q:如何對 Modbus RTU Slave 設備讀/寫實數資料 ? 

48 Q:WinCon 如何連接 FRnet I/O ? 

49 
Q:如何使用“Mbus_R”與“Mbus_R1”方塊,來直接取得M-7000溫度模塊的攝氏或華氏溫度

值 ? 

50 Q:如何連接 M-7000 系列 Modbus RTU I/O ?  

51 Q:如何使用 PC上的 VB.net 2005程式, 用Modbus TCP/IP 規約來與 ISaGRAF控制器連接 ?  

52 Q:如何使用 PC 上的 VB 6.0 程式, 用 Modbus TCP/IP 規約與 ISaGRAF 控制器連接 ?  

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/faq/isagraf/005_c.htm
http://www.icpdas.com/faq/isagraf/005_c.htm
http://www.icpdas.com/faq/isagraf/016_c.htm
http://www.icpdas.com/faq/isagraf/016_c.htm
http://www.icpdas.com/faq/isagraf/016_c.htm
http://www.icpdas.com/faq/isagraf/018_c.htm
http://www.icpdas.com/faq/isagraf/018_c.htm
http://www.icpdas.com/faq/isagraf/020_c.htm
http://www.icpdas.com/faq/isagraf/020_c.htm
http://www.icpdas.com/faq/isagraf/021_c.htm
http://www.icpdas.com/faq/isagraf/021_c.htm
http://www.icpdas.com/faq/isagraf/022_c.htm
http://www.icpdas.com/faq/isagraf/022_c.htm
http://www.icpdas.com/faq/isagraf/022_c.htm
http://www.icpdas.com/faq/isagraf/024_c.htm
http://www.icpdas.com/faq/isagraf/024_c.htm
http://www.icpdas.com/faq/isagraf/024_c.htm
http://www.icpdas.com/faq/isagraf/030_c.htm
http://www.icpdas.com/faq/isagraf/030_c.htm
http://www.icpdas.com/faq/isagraf/031_c.htm
http://www.icpdas.com/faq/isagraf/031_c.htm
http://www.icpdas.com/faq/isagraf/038_c.htm
http://www.icpdas.com/faq/isagraf/038_c.htm
http://www.icpdas.com/faq/isagraf/039_c.htm
http://www.icpdas.com/faq/isagraf/039_c.htm
http://www.icpdas.com/faq/isagraf/040_c.htm
http://www.icpdas.com/faq/isagraf/040_c.htm
http://www.icpdas.com/faq/isagraf/040_c.htm
http://www.icpdas.com/faq/isagraf/040_c.htm
http://www.icpdas.com/faq/isagraf/041_c.htm
http://www.icpdas.com/faq/isagraf/041_c.htm
http://www.icpdas.com/faq/isagraf/042_c.htm
http://www.icpdas.com/faq/isagraf/042_c.htm
http://www.icpdas.com/faq/isagraf/042_c.htm
http://www.icpdas.com/faq/isagraf/046_c.htm
http://www.icpdas.com/faq/isagraf/046_c.htm
http://www.icpdas.com/faq/isagraf/047_c.htm
http://www.icpdas.com/faq/isagraf/047_c.htm
http://www.icpdas.com/faq/isagraf/048_c.htm
http://www.icpdas.com/faq/isagraf/048_c.htm
http://www.icpdas.com/faq/isagraf/049_c.htm
http://www.icpdas.com/faq/isagraf/049_c.htm
http://www.icpdas.com/faq/isagraf/049_c.htm
http://www.icpdas.com/faq/isagraf/050_c.htm
http://www.icpdas.com/faq/isagraf/050_c.htm
http://www.icpdas.com/faq/isagraf/051_c.htm
http://www.icpdas.com/faq/isagraf/051_c.htm
http://www.icpdas.com/faq/isagraf/052_c.htm
http://www.icpdas.com/faq/isagraf/052_c.htm
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編號 中文 ISaGRAF Ver.3 FAQ 

53 Q:不同型號的 ISaGRAF 控制器性能比較表 

55 
Q:如何連接 I-7018z 量測 6 個 4 到 20 mA 的電流輸入值 與 4 個 Thermo-Couple 溫度輸入

值, 並顯示在 PC 的 VB 6.0 程式上 ?  

56 Q:如何 在 ISaGRAF 控制器內 使用較準確的 固定週期 去 做某件事 ?  

57 

Q:如何使用 WinCon-8xx7, 每 0.01 秒記錄 I-8017H 的 1 ~ 4 個電壓值於 User 配置的一塊

RAM 記憶區內, 連續記錄 1~10 分鐘, 之後再儲存到 RAM Disk File 內, 最後可在 PC 上

開 M.S. Excel 來看 1 ~ 4 條趨勢圖 ?  

58 
Q:如何使用 I-8437-80或 I-8837-80, 每0.05秒記錄 I-8017H的1 ~ 4個電壓值於 S256 / S512

內的一個檔案, 連續記錄 1~10分鐘, 之後可在PC上開M.S. Excel來看 1 ~ 4條趨勢圖 ? 

59 Q:常用的 COM Port 函式技巧 來讀寫 RS-232 / 422 / 485  

60 Q: 如何在 WinCon 內 讀 / 寫 File 資料 ?  

61 

Q: 如何連接 RS-485 遠程 I-7000 與 I-87xxx I/O 模塊到 I-8xx7 , I-7188EG/XG 與 

WinCon-8xx7 控制器 ? 如何設計 RS-485 遠程 I-7017RC , I-87017RC , I-7018Z I/O 模塊的

程序 ?  

62 Q: 如何規劃 備援系統 (冗餘系統) ? 採用 Ethernet I/O 

63 
Q: 為何我的 RS-485 遠程 I-7000 與 I-87K Output 模塊 在 RS-485 通訊線斷線後 沒有啟動 

wacthdog 讓 Output 點跑到 安全輸出值 ?  

65 
Q: 泓格科技 提供 便宜穩定 且 有效率的 主動 訊號採集 與 資料回報 系統 (提供 VC++ 

6.0 與 VB 6.0 與 ISaGRAF demo 程式).   

66 
Q: 如何使用 RS-232 / RS-485 通訊串口來接收設備主動傳過來的數值資料 ? 比如像是 條

碼機 或是 RS-232 磅秤.  

67 
Q: 如何使用 WinCon-8xx7 或 μPAC-7188EG 或 iPAC-8447/8847 來發送可夾帶附件的

Email ?  

68 Q: 為何 W-8xx7 或 I-8xx7 或 I-7188EG 或 I-7188XG 發生一直重啟(Reset)的現象? 

69 Q: 為何我的 PC 無法用 ftp 命令來連上 W-8347 或 W-8747 ?   

70 Q: 如何 自動對多台 ISaGRAF PAC 進行時間校正 與 記錄運作狀態 ?   

71 
Q: 應用例: 用 W-8xx7 來 記 錄 10 個溫度 資 料, 每分鐘 記 錄 一次. 記 錄 完一天的資料

後, 用 Ethernet 發 email 把 該 記 錄 好的 file 發出來.   

072 
Q: 應用例: 使用 WinCon-8xx7 每 20 ms 記 錄 一筆 電壓 / 電流 資 料, 連續 記 錄 1 到 10 

分鐘, 完成後用 Email 將該 記 錄 檔案發出來.   

073 
Q: 為何 ISaGRAF 程式內用 i_7017 方塊讀到的 I-7017 模塊的輸入值是 正常值的 2 倍大或 

變成負值 ?   

074 Q: 如何 使用 ISaGRAF New Retain Variable 與 它的優點 ?   

075 Q: 為何我的 ISaGRAF 程序無法正確連上其它廠牌的 Modbus Slave 設備 ?   

077 
Q: 應用例: 使用 μPAC-7186EG 每秒 記 錄 一筆 電壓 / 電流 資 料, 連續 記 錄 1 到 10 分鐘, 

完成後用 Email 將該 記 錄 檔案發出來.   

http://ftp.icpdas.com.tw/pub/cd/wincon_isagraf/napdos/isagraf/wincon/chinese_manu/faq053_chinese.pdf
http://www.icpdas.com/products/PAC/i-8000/pdf/performance_comparison_c.pdf
http://www.icpdas.com/faq/isagraf/055_c.htm
http://www.icpdas.com/faq/isagraf/055_c.htm
http://www.icpdas.com/faq/isagraf/055_c.htm
http://www.icpdas.com/faq/isagraf/056_c.htm
http://www.icpdas.com/faq/isagraf/056_c.htm
http://www.icpdas.com/faq/isagraf/057_c.htm
http://www.icpdas.com/faq/isagraf/057_c.htm
http://www.icpdas.com/faq/isagraf/057_c.htm
http://www.icpdas.com/faq/isagraf/057_c.htm
http://www.icpdas.com/faq/isagraf/058_c.htm
http://www.icpdas.com/faq/isagraf/058_c.htm
http://www.icpdas.com/faq/isagraf/058_c.htm
http://www.icpdas.com/faq/isagraf/059_c.htm
http://www.icpdas.com/faq/isagraf/059_c.htm
http://www.icpdas.com/faq/isagraf/060_c.htm
http://www.icpdas.com/faq/isagraf/060_c.htm
http://www.icpdas.com/faq/isagraf/061_c.htm
http://www.icpdas.com/faq/isagraf/061_c.htm
http://www.icpdas.com/faq/isagraf/061_c.htm
http://www.icpdas.com/faq/isagraf/061_c.htm
http://www.icpdas.com/faq/isagraf/062_c.htm
http://www.icpdas.com/faq/isagraf/062_c.htm
http://www.icpdas.com/faq/isagraf/063_c.htm
http://www.icpdas.com/faq/isagraf/063_c.htm
http://www.icpdas.com/faq/isagraf/063_c.htm
http://www.icpdas.com/faq/isagraf/062_c.htm
http://www.icpdas.com/faq/isagraf/065_c.htm
http://www.icpdas.com/faq/isagraf/065_c.htm
http://www.icpdas.com/faq/isagraf/066_c.htm
http://www.icpdas.com/faq/isagraf/066_c.htm
http://www.icpdas.com/faq/isagraf/066_c.htm
http://www.icpdas.com/faq/isagraf/067_c.htm
http://www.icpdas.com/faq/isagraf/067_c.htm
http://www.icpdas.com/faq/isagraf/067_c.htm
http://www.icpdas.com/faq/isagraf/068_c.htm
http://www.icpdas.com/faq/isagraf/068_c.htm
http://www.icpdas.com/faq/isagraf/069_c.htm
http://www.icpdas.com/faq/isagraf/069_c.htm
http://www.icpdas.com/faq/isagraf/070_c.htm
http://www.icpdas.com/faq/isagraf/070_c.htm
http://www.icpdas.com/faq/isagraf/071_c.htm
http://www.icpdas.com/faq/isagraf/071_c.htm
http://www.icpdas.com/faq/isagraf/071_c.htm
http://www.icpdas.com/faq/isagraf/072_c.htm
http://www.icpdas.com/faq/isagraf/072_c.htm
http://www.icpdas.com/faq/isagraf/072_c.htm
http://www.icpdas.com/faq/isagraf/073_c.htm
http://www.icpdas.com/faq/isagraf/073_c.htm
http://www.icpdas.com/faq/isagraf/073_c.htm
http://www.icpdas.com/faq/isagraf/074_c.htm
http://www.icpdas.com/faq/isagraf/074_c.htm
http://www.icpdas.com/faq/isagraf/075_c.htm
http://www.icpdas.com/faq/isagraf/075_c.htm
http://www.icpdas.com/faq/isagraf/077_c.htm
http://www.icpdas.com/faq/isagraf/077_c.htm
http://www.icpdas.com/faq/isagraf/077_c.htm
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編號 中文 ISaGRAF Ver.3 FAQ 

080 
Q: 應用例: 用 μPAC-7186EG 來 記 錄 10 個 溫度 資 料, 每分鐘 記 錄一次. 記 錄完一天的 

資 料後, 用 Ethernet 發 email 把 該 記 錄 好的 file 發出來.   

081 Q: 如何在 ISaGRAF controller 內使用 I-87017W-A5 來量測 +/- 150VDC ?   

082 Q: 一個 FRnet : 快速遠程 I/O 的簡單程式設計方法.   

083 Q: 如何設定 I-8xx7, I-8x37-80, I-7188EG 和 μPAC-7186EG 的 TCP 回收時間?   

084 
Q: 應用例: 經濟且有效 的 可熱插拔 備援 (冗餘)系統 - μPAC-7186EG 或 I-8437-80 + 

RU-87P4 / 8.   

086 
Q: 如何使用 WinCon-8347 / 8747 或 μPAC-7186EG 或 iPAC-8447 / 8847 來連接一顆 I-7530 

或多顆 I-7530, 來 讀取 或 控制 CAN 及 CANopen 設備 與 傳感器 ?   

087 Q: 當七段顯示器出現 Err00, Err02, Err03, Err90 和 E.0001 訊息時代表什麼意思?   

088 

Q: 功能變更: W-8347/8747,μPAC-7186EG,I-8x37-80,I-8xx7 和 I-7188EG/XG 從新版 driver

起, S256/512 和 X607/608 不再支持舊的可保存變數 (Retain variable) 方式 ，請改用功

能較好的 新的可保存變數方式.   

089 Q:為何我的 μPAC-7186EG 無法更新驅動程式和 ISaGRAF 應用程式?   

090 Q: 如何在 ISaGRAF PAC 內使用 I-7017Z?   

091 
Q: 如何使用 ISaGRAF PAC 加上 I-87089 卡片搭配 VW sensor , 來量測 水泥建築物 的 VW 

頻率 與 溫度 去 求得 建築物的 內部應力 ?   

092 
Q: 如何啟用 μPAC-7186EG, I-7188EG 和 I-7188XG 的 COM2 或 COM3 成為 Modbus RTU 

Slave 埠?   

093 Q: WinCon-8347 / 8747 新的 可熱插拔 備援系統 (冗餘系統).   

094 Q: 如何更新 WinCon-8347 / 8747 的 OS 版本 ?   

095 Q: WinCon-8xx7 從第 4.03 版 Driver 起支持最多 32 個 Modbus TCP/IP 連線.    

096 Q: 新增 Modbus RTU / ASCII 功能方塊來一次讀取最多 24 個 Word 或最多 384 個 Bit.  

097 
Q: 如何在 WinCon-8x47 沒有接 Mouse 與 VGA 顯示器的情況下, 使用 USB 隨身碟來更改

它的 IP 地址 , 站號 與 Modbus RTU 等設定? 

098 Q: 應用例: 使用 COM Port 的函式讀寫 Modbus RTU 設備  

099 
Q: 如何編寫一個每固定時間取樣 (或每個 PLC scan 取樣) 然後求整數或實數平均值的功

能方塊 ? 

100 Q: 如何使用 I-8084W (4 / 8 – Ch. Counter 或 8-Ch. frequency) ?  

101 

Q: 如何使用 MBUS_XR 或 MBUS_XR1 方塊來對 Modbus RTU / ASCII 設備, 一次讀取最多

120 個 Word 或 最多 60 個長整數 或 最多 60 個實數 (只適用於 Wincon-8xx7 / 8xx6 與 

WP-8xx7 / 8xx6 與 VP-25W7/23W7/25W6/23W6) ?  

102 Q: 為何 WP-8xx7 或 VP-25W7/23W7 的 FTP server 連不上 ?  

103 Q: 在 WinPAC 上使用 RS-232 或 USB 觸控式螢幕.  

104 Q: 為何我的 PC / ISaGRAF 無法正常連上 ISaGRAF PAC ?  
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105 Q: 如何在WP-8xx7 , VP-25W7/23W7與 iPAC-8xx7內使用 I-8088W來控制 8個PWM輸出 ?  

106 
Q: 如何利用WinPAC-8xx7 和 I-8084W來量測頻率或轉速輸入並使用 C# .net 2008 將所記

錄的值畫成趨勢圖? 

107 
Q: 如何在 ISaGRAF PAC 內使用 I-87211W (GPS module) 來利用衛星訊號進行自動時間校

正與取得目前位置的經緯度座標 ?  

108 
Q: 如何利用WinPAC-8xx7 和 I-87018z 來量測溫度並使用 C# .net 2008將所記錄的值畫成

趨勢圖 ?  

109 
Q: 如何利用 ISaGRAF PAC和 I-87211w 並透過Ebus校正整個區域網路上全部 ISaGRAF PAC

的時間?  

110 Q: ZigBee 無線通訊應用 : 如何遠距離控制 I/O 與 進行資料收集 ?  

111 Q: 如何利用 GTM-201-RS232 發各別國家文字的簡訊?  

112 Q: 如何使用 ISaGRAF 來編程 I-8093W (3 軸高速 Encorder 輸入模塊) ?  

113 Q: 在 ISaGRAF PAC 內使用 Modbus TCP/IP Master 來連接 Modbus TCP/IP Slave 裝置.  

114 
Q: 列印 ISaGRAF PDF 文件時, 如何避免印出亂碼?  

115 

Q: 開發 eLogger HMI 加上 ISaGRAF SoftLogic 一起應用於 WP-8xx7, VP-2xW7 與 

XP-8xx7-CE6 等 PAC 內. (文件版本 1.03,於 2010 年 7 月 15 日發佈)  

116 

Q: 如何在不修改 ISaGRAF 程式的情況下啟用 WP-8xx7 與 VP-2xW7 的第 2 到第 5 個 

Modbus RTU slave 串口 ?  

117 
Q: 如何在 Windows Vista 或 Windows 7 中安裝 ISaGRAF?  

118 
Q: 一個 M.S. VC++ 6.0 範例程式跑 Modbus TCP 來連接一台 WP-8xx7.  

119 
Q: 如何實現中央控制站與地區控制站間的通訊備援機制 ?  

120 
Q: 如何使用 Aver_N 與 Aver_F 來計算連續平均值 (或稱 移動平均值) ?  

121 
Q: 如何建立與移除 ISaGRAF 開發環境?  

122 

Q: 如何解決 W-8x47 發生的 USB-Freeze 問題 ? 如何更新 Wincon-8347 / 8747 的 OS 版

本 ?  

123 

Q: 如何加快 InduSoft + ISaGRAF 的畫面顯示速度 (W-8xx6 / WP-8xx6 / VP-25W6 / 

XP-8xx6-CE6) ?  

124 
Q: ISaGRAF 專業版控制器 XP-8xx7-CE6-PRO 的 Web HMI 應用範例 – 使用 FrontPage  

125 

Q: XP-8xx7-CE6 與 iDCS-8000 (或 ET-7000 或 其它 Modbus TCP Slave 設備) 備援 (冗餘) 系

統  

126 

Q: 利用 WP-8847 連接控制 ET-7018Z 與 ET-7044D，並使用 InduSoft 或 VS2008 C# .NET

以及 VB .NET 來當 HMI  

128 

Q: 如何使用 ISaGRAF PAC 加上 i-87113DW 卡片搭配 Carlson Strain Gauage Inputs (差阻

式傳感器 ) ?  

129 
Q: 如何使用 ISaGRAF PAC 連接 ICP DAS 電力表 – PM-2133 與 PM-2134 ?  
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130 
Q: 如何使用 WP-8x47/VP-23W7 SNTP Client 網路自動校時功能 ?  

131 
Q: Soft-GRAF : 在 XP-8xx7-CE6 與 WP-8xx7 與 VP-2xW7 等 PAC 內建立多彩多姿的 HMI 畫

面 (文件版本: 1.3)  

132 Q: 使用 I-8094F/8092F/8094 執行馬達控制運動 . 

133 
Q: 如何在 ISaGRAF PAC 內使用 UDP 或 TCP 來 收取 (或 發送) 廣播資料 封包 或 一般資料

封包   

134 Q: 如何寫 ISaGRAF 程式來 Reset ISaGRAF driver 或 Reset 整台 Controller ?   

135 Q: 如何寫 ISaRAF 程式用 WinCE PAC 去對後台的 MicroSoft SQL Server 讀取或寫出資料 ?   

136 Q: HART 應用 : ISaGRAF 可程式自動控制器 (PAC) 加上 I-87H17W   

137 Q: 如何使用 uPAC-5000 系列控制器透過 GPRS 連線至遠端伺服器並且傳送資料?   

138 Q:如何設計一個 XP-8xx7-CE6 備援 (冗余) 系統 (採用 I-87K8 或 Modbus I/O 或 其它 I/O) ?   

139 Q:如何安裝使用 ISaGRAF 3.55 Demo 版以及有何限制 ?   

140 Q:InduSoft PC 端的 HMI 如何利用 Modbus TCP 與 ISaGRAF PAC 通訊?   

141 Q:iP-8xx7/μPAC-7186EG/I-8xx7/I-8xx7-80 提供防寫入快閃式記憶體 (Flash memory) 功能   

142 Q: 如何保護你的 ISaGRAF 程式, 讓盜用它的人無法使用 ?   

143 Q: 如何讓 ISaGRAF WinCE PAC 撥接 GPRS 來連上網路傳資料 ?   

144 Q: 新增 Modbus RTU / ASCII / TCP 方塊“Mbus12w” 來一次寫出 1 ~ 12 個 Word .   

146 
Q: Soft-GRAF Studio : 在XP-8xx7-CE6 與 WP-8xx7 與VP-2xW7 等PAC 建立多采多姿的HMI 

畫面 

147 Q: 如何使用 VPD-130 經由 RS-485 讀取 μPAC-7186EG 的系統日期/時間?   

149 Q: 如何讓 ISaGRAF WinCE PAC 播放聲音 ?   

150 
Q: ISaGRAF 線上教學影片  

151 
Q: 如何使用 FTP Client 功能, 上傳資料檔案至遠端 PC 的 FTP Server?  

152 
Q: 如何使用 ISaGRAF PAC 操作紅外線遙控模組 IR-210/IR-712?  

153 

Q: 如何使用 3G 或 2G 無線技術 讓 ISaGRAF PAC 跟 遠方的 Modbus TCP server 或 ftp 

server 進行通訊 ?  

154 
Q: 如何使用 ISaGRAF PAC 操作 FRnet AI/AO 模組 ?  

155 Q: 如何在 WP-5xx7 , VP-25W7 與 WP-8xx7 內使用 Micro_SD 內 的 file 來保存變數資料 ? 

156 Q: 如何使用 ISaGRAF PAC 連接 DL-100TM485 來測量濕度與溫度值 ?  

157 Q: 如何使用 ISaGRAF PAC 連接溫溼度計 DL-100T485 ?  

158 Q: Soft-GRAF 應用 – 資料記錄器 (Data Logger)  

159 Q: ISaGRAF PACs 如何使用 tGW-700 系列產品(Modbus TCP to RTU/ASCII gateway)?  

160 Q: Soft-GRAF 應用 - 警報列表 (Alarm Lists)  
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161 Q: 在 ISaGRAF PAC 用 For 迴圈 使用大量的 Modbus 方塊 Mbus_AR 與 Mbus_AW 

162 Q: 如何使用 ISaGRAF PAC 傳送 事件 (Event) 資料 ? 

163 Q: 當 Ethernet 無法連線 PAC 且 Power LED 和 L1 LED 指示燈一直閃爍原因. 

165 Q: 如何使用 ISaGRAF PAC 來控制 tM 系列與 LC 系列 Modbus I/O?  

166 Q: ISaGRAF WinCE PAC 排程控制 - Schedule Control  

167 Q: 在 ISaGRAF WinCE PAC 內開發屬於自己的 C-function 與 C-function Block .  
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第 10 章 使用 C#.net 2008 程式來 讀/寫 ISaGRAF 變數 

 
重要: 

 
請最好不要把資料 file 與 開發好的 .net 程式存放在 \System_Disk 內, 因為 \System_Disk 使用 

的是 Nor Flash 記憶體, 它主要是給 OS, ISaGRAF driver, 與一些必要 utility 與 DLL 存放使用, size 

不大. 而且 Nor Flash 記憶體 不適合常常去更新資料, 若常常在 \System_Disk 內更新 file (比如

每 1 ~5 秒就更新 file 一次, 一天下來 就更新了約幾萬次), 久了可能會損壞 \System_Disk 內的

資料. 所以自行開發的程式與要操作的 file 最好都存放在 \Micro_SD 內。 

 
 
 

本章使用Visual Studio .NET 2008 開發工具，以建立一個範例程式的方式來說明，範例程式

可於WinPAC-8xx7 CD光碟中找到. 

 
WP-8xx7 CD-ROM : \napdos\isagraf\wp-8xx7\CSharp.net_2008_demo\ 

wp_CSharp01 : 數位 I/O 範例，搭配 I-87055W 模組 (於 slot 0) 

wp_CSharp02 : 類比 I/O 範例，搭配 I-87024W (slot 1) 與 I-8017HW (slot 2) 

wp_CSharp03 : 讀/寫 ISaGRAF internal integer, timer 及 real 變數 (無需 I/O模組) 

 
 
對應的專案範例檔名: "wp_vb01.pia" , "wp_vb02.pia” , "wp_vb03.pia" (同目錄) 

 

 

10.1 建立新專案 
 

1. 開啟微軟 Visual Studio .NET 2008 軟體，點選 [File] > [New Project]  
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2. 點選 [Smart Device] > [.NET frame work 2.0] < [Smart Device Project]，在下方輸入專案名稱

(本例: project1)，然後按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. 點選 [Device Application] > [Windows CE] > [.NET Compact Framework Version 2.0]，然後

按 “OK”。 
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10.2 加入專案參考 

“QuickerNet” library 包含了所有模組的 function，在程式裡使用 “Quicker” 關鍵字之前，

您必頇在應用程式的參考清單裡加入參考: “QuickerNet.dll”。 

 
 
1. 滑鼠右鍵點擊 “Solution Explorer” 

視窗裡的專案名稱， 

選擇 “Add Reference …” 

 
2. 點選 “mscorlib”，按 “OK”。

(“mscorlib” 出現在.NET 的 

Component Name 區) 

 

 
 
3. 點選 “Browse” 頁籤， “搜尋位置” 請切換到WP-8xx7光碟 \napdos\isagraf 

\wp-8xx7\CSharp.net_2008_demo\，在 wp_CSharp01 子目錄或自訂目錄下，選擇 

“QuickerNet.dll”，按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

點選 Mscorlib.dll 

點選 “Browse”，找到 

“QuickerNet.dll” 

右鍵 
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4. 加入 “mscorlib” 及 “QuickerNet.dll” 後，會出現在 “solution explorer” 視窗。 

 
 

5. 以滑鼠右鍵點選 “Form1.cs”，選擇 “View Code”，將游標移到最上方，在第一個區段中加

入 “using Quicker;” 。  

 

 
接著您就可以在您的 C# 表單中設計所需的物件與動作了。 
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10.3 編譯應用程式 

程式撰寫完成後，請依下列步驟建置(build)一個應用。 

 
1. 請記得隨時按下 “Save All” 工具按鈕來存檔。 

 
 

 
 
 
 
 
 
 
2. 編譯 (即建置) 此專案，下方的 “Error List” 視窗會列出建置結果。 

 
 

 
 
 
 
 
 
 
 
 
 

3. 在下列資料夾中可以展到執行檔 

 
<您的 C# .net 專案資料夾> \bin\Release\ <project_name>.exe 

 
請將此執行檔複製到控制器的 \System_Disk\ISaGRAF\ 目錄下來執行。 

 
 
注意: 

使用者可複製 C#.net 執行檔到其他目錄下執行，但是至少要同時複製 3 個 DLL 檔案，否則執

行會有錯誤。 

例如: 要在 \Micro_SD\ 目錄下執行 project1.exe，必須在該目錄下有下列 3+1 個檔案，即 

“project1.exe”, “QuickerNet.dll”, “Quicker.dll” 與 “Mscorlib.dll”檔。  

(可在 WP-8xx7 光碟的 “\System_disk\ISaGRAF\” 目錄下取得此 3 個 DLL 檔案 “QuickerNet.dll”, 

“Quicker.dll” 與 “Mscorlib.dll”) 
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10.4 QuickerNET.DLL  

 
本節著重於 QuickerNET.DLL function 的應用範例說明。有許多 function 都可用來 讀/寫 資料 

從/到 ISaGRAF 控制器。 

 
QuickerNET.DLL 的 function 可以分為兩大類: 

1. 數位 讀/寫 Function 

2. 類比 讀/寫 Function 

 
 
 
 
 
 

10.4.1 Digital 數位 讀/寫 函式 

  
■UserSetCoil 

 
說明: 

此 function 設定 Boolean 值到指定的 Modbus 位址編號的 Boolean 變數。 

 
語法: 

 
UserShare.UserSetCoil(ushort iUserAddress, byte iStatus) 

 
參數:  

iUserAddress : 指定變數的 Modbus 位址編號 (1 ~ 8191) 

iStatus : 設定變數的狀態；例如: iStatus = 1 表示 True，iStatus = 0 表示 False。 

 
回傳值: 

無 

 
範例:  

//設定 Modbus 網路位址 “1” 的 output 變數為 True.  

UserShare.UserSetCoil(Convert.ToUInt16(1), 1);  
 
範例程式 :  

WP-8xx7 CD-ROM: \napdos\isagraf\wp-8xx7\CSharp.net_2008_demo\wp_CSharp01 
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■UserGetCoil 

 
說明: 

此 function 讀出指定的 Modbus 位址編號的 Boolean 變數值。 

 
語法:  

 
UserShare.UserGetCoil(ushort iUserAddress, out byte iStatus) 

 
參數:  

iUserAddress : 指定變數的 Modbus 位址編號 (1 ~ 8191) 

iStatus : 取得變數的狀態；iStatus = 1 表示 True，iStatus = 0 表示 False 

 
回傳值: 

無 

 
範例:  

//取得 Modbus 位址編號 “1” 的變數狀態.  

byte iStatus;  
UserShare.UserGetCoil(Convert.ToUInt16(1),out iStatus);  
 
範例程式 :  

WP-8xx7 CD-ROM: \napdos\isagraf\wp-8xx7\CSharp.net_2008_demo\wp_CSharp01 
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10.4.2 Analog 類比 讀/寫 函式 

 

■UserSetReg_short ■UserSetReg_long ■UserSetReg_float 

 
說明: 

這些 function 用來設定16-bit short integer、32-bit long integer 及 32-bit float 值到指定的Modbus 

位址編號。 

 
語法:  

 

UserShare.UserSetReg_Short(ushort iUserAddress, out int iStatus) 
 

UserShare.UserSetReg_Long(ushort iUserAddress, out int iStatus) 
 

UserShare.UserSetReg_Float(ushort iUserAddress, out float iStatus) 
 

 
參數 :  

iUserAddress : 指定變數的 Modbus 位址編號 (1 ~ 8191) 

iStatus : 設定 short / long integer 或 float 值 

 
範例:  

//設定 long 值 “1234567” 到 Modbus 位址編號 “1” 的變數.  

int temp1=1234567; 
UserShare.UserSetReg_long(Convert.ToUInt16(1), out temp );    
 
//設定 short 值 “-1234” 到 Modbus 位址編號 “3” 的變數.  

int temp2= -1234; 
UserShare.UserSetReg_short(Convert.ToUInt16(3), out temp2 );    
 
//設定 float 值 “2.174” 到 Modbus 位址編號 “4” 的變數.  

float temp3=2.174; 
UserShare.UserSetReg_float(Convert.ToUInt16(4), out temp3 );    
 
範例程式 :  

WP-8xx7 CD-ROM:   
1. 讀/寫 類比I/O: \napdos\isagraf\wp-8xx7\CSharp.net_2008_demo\wp_CSharp02  

2. 讀/寫internal long integer、Timer 及Real (浮點數) 的值: 

\napdos\isagraf\wp-8xx7\CSharp.net_2008_demo\wp_CSharp03  
 
注意: 

ISaGRAF 專案中，long integer、timer 及 real 變數必須佔用 2 個網路位址編號。 

(請參閱 “ISaGRAF 進階使用手冊” 4.2 節 或 光碟: \napdos\isagraf\wp-8xx7\english_manu\ 

“Chinese_User_Manual_I_8xx7.pdf”) 
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■UserGetReg_short ■UserGetReg_long ■UserGetReg_float 

 
說明: 

這些 function 讀出指定的 Modbus 位址編號的 16-bit short integer、32-bit long 

integer 及 32-bit float 的值。 

 
語法:  

 

UserShare.UserGetReg_Short(ushort iUserAddress, out int iStatus) 
 
UserShare.UserGetReg_Long(ushort iUserAddress, out int iStatus) 

 
UserShare.UserGetReg_Float(ushort iUserAddress, out float iStatus) 
 

 
參數:  

iUserAddress : 指定變數的 Modbus 位址編號 (1 ~ 8191) 

iStatus : 取得 short / long integer 或 float 值  

  
範例:  

float float_val 
short short_val 
int long_val 
  
//取得 Modbus 位址編號 “7” 的 float 變數值.  

UserShare.UserGetReg_float(Convert.ToUInt16(7),out float_val);  
 
//取得 Modbus 位址編號 “9” 的 long 變數值.  

UserShare.UserGetReg_long(Convert.ToUInt16(9),out long_val); 
 
//取得 Modbus 位址編號 “11” 的 short 變數值.  

UserShare.UserGetReg_short(Convert.ToUInt16(11),out short_val) ; 
 
範例程式 :  

WP-8xx7 CD-ROM:   
1. 讀/寫 類比 I/O: \napdos\isagraf\wp-8xx7\CSharp.net_2008_demo\wp_CSharp02 

2. 讀/寫 internal long integer、Timer 及Real (浮點數) 的值: 

\napdos\isagraf\wp-8xx7\CSharp.net_2008_demo\wp_CSharp03  
 
 
注意: 

ISaGRAF 專案中，long integer、timer 及 real 變數必須佔用 2 個網路位址編號。 

(請參閱 “ISaGRAF 進階使用手冊” 4.2 節 或 光碟: \napdos\isagraf\wp-8xx7\chinese_manu\ 

“Chinese_User_Manual_I_8xx7.pdf”) 
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第 11 章  更多實用的功能 

本章節將介紹更多陸續新增且適用於 ISaGRAF WinCE PAC 的實用功能，您可在 “產品問答 (FAQ)” 中

了解實際的用法。 

 
 

11.1 FAQ-167: 在 ISaGRAF WinCE PAC 內開發屬於自己的 

C-function 與 C-function Block 

FAQ-167 提供了範例程式，教導使用者如何開發自訂的 C-function 與 C-function Block. 詳情請參考 

ISaGRAF FAQ: www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC > FAQ-167  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
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11.2 FAQ-166: ISaGRAF WinCE PAC 排程控制 - Schedule Control 

 

 ISaGRAF WinCE 系列 PAC，支援排程控制功能 (Schedule Control)，只要經過幾個簡單的步驟就可

以達成一般日, 周末日, 特別假日, 補班, 及四季區分… 等複雜的排程控制需求。 

 一台 ISaGRAF WinCE 系列 PAC 可以控制最多 10 個控制設備 (Target) 的排程 (Schedule)。每個控

制設備 (Target) 可控制 1 個布林 (Boolean)、1 個整數 (Integer)、1 個實數 (Real) 共三個變數。 

 請參考  www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC > FAQ-166 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
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11.3 FAQ-160: Soft-GRAF 應用: 警報列表 (Alarm Lists) 

 

您可使用 Soft-GRAF HMI 軟體，在 ISaGRAF WinCE PAC 內做出一個警報列表 (Alarm Lists)。 

 

 Soft-GRAF 提供的 “g_ Alarm” 元件，最多一天可發送 3000 筆警報訊息。 

 FAQ-160 提供了範例程式，當警報發生時，可透過手機傳送簡訊給相關人員。 

 系統每日會建立一個新檔案來儲存警報訊息，使用者也可將檔案匯出至個人的隨身碟中。 

(檔案格式:  .csv 或 .txt) 

 可啟用 FTP Client 功能，於每日固定時間點，自動將記錄檔傳送至控制中心 (FTP Server1, FTP 

Server2)。或者，Server 端也可以 FTP 方式抓取 ISaGRAF WinCE PAC 的檔案。 

 請參考  www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC > FAQ-160 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
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11.4 FAQ-158: Soft-GRAF 應用 – 資料記錄器 (Data Logger) 

 

您可使用 Soft-GRAF HMI 軟體，在 ISaGRAF WinCE PAC 內做出一個資料記錄器應用 (Data Logger)。 

 

 Soft-GRAF 提供的 “g_Logger1” 元件，最多可記錄 50 個資料 (Tag)。 

(資料型態:  Boolean、16-bit signed integer、32-bit signed integer 與 32-bit Float) 

 系統每日會建立一個新檔案來儲存記錄資料，使用者也可將檔案匯出至個人的隨身碟中。 

(檔案格式:  .csv 或 .txt) 

 可啟用 FTP Client 功能，於每日固定時間點，自動將記錄檔傳送至控制中心 (FTP Server1, FTP 

Server2)。或者，Server 端也可以 FTP 方式抓取 ISaGRAF WinCE PAC 的檔案。 

 請參考  www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC > FAQ-158 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
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附錄 A 硬體系統與設定 

WinPAC-8xx7 或 WP-8xx7 為 WP-8147/8447/8847/8137/8437/8837 的簡稱. 

WinPAC-8xx6 或 WP-8xx6 為 WP-8146/8446/8846/8136/8436/8836 的簡稱. 

 

A.1 使用正確的電源供應器 

請使用供電為 +10V 到 +30V 之間的直流電源供應器 (大於 25W 更佳)。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
選購指南:  

 
電源供應器(Power Supply):  

http://www.icpdas.com/root/product/solutions/accessories/power_supply/power_supply_selection.ht
ml 
 DP-660 :  24V/2.5A , 5V/0.5A 電源供應器 (DIN-Rail mounting) 

 DP-665 :  24V/2.5A , 5V/0.5A 電源供應器 

 DP-1200 : 24V/5A 電源供應器 

 
工業型乙太網路轉換器(Ethernet Swith):  
http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html 
 NS-205: 10/100M , 5 埠 

 NS-208: 10/100M , 8 埠 

 RS-405: 10/100M , 5 埠, 環狀式 (Ring Switch) 

 RS-408: 10/100M , 8 埠, 環狀式 (Ring Switch) 

 

  

http://www.icpdas.com/root/product/solutions/accessories/power_supply/power_supply_selection.html
http://www.icpdas.com/root/product/solutions/accessories/power_supply/power_supply_selection.html
http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html
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A.2 修改 NET-ID 與 Modbus RTU 連接埠的設定 

使用者可以自行設定 WP-8xx7 的 Net-ID (Slave 站號) 為 1 到 255 之間。 

 
出貨時預設的 Modbus RTU slave 埠為 “None”，使用者請依實際應用自行設定需要的埠號 (請參考附

錄 G 與 E，有更多 Modbus RTU 埠號說明)。 

 
每次修改設定後，都必須重新啟動 WP-8xx7 控制器讓新的設定生效。 
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A.3 設定 WP-8xx7 的 IP 位址 

請執行 WinPAC 上的 [Start] > [Setting] > [Control Panel]，然後點選 “Network and Dial-up Connections”，

再一一點選 “LAN1” 與 “LAN2”，設定你的 WinPAC 控制器的 IP 位址與與子網路遮罩(Subnet Mask)。

(ISaGRAF 的應用必須永遠設定為固定 IP，不可使用 DHCP) 

 
 
 
 
 
 
 
 
 
 
 
 
 

接著執行 [Start] > [Programs] > [WinPAC Utility]，點選 “Save and Reboot” 以儲存設定。 
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A.4 連接 PC 到 WP-8xx7 的乙太網路埠 

在使用乙太網路將 ISaGRAF 應用程式下載到 WP-8xx7 控制器之前，首先必須正確的設定 PC 連接

WP-8xx7 的乙太網路埠。 

 
WP-8xx7 端 :   

設定 IP, Mask 與 Gateway 位址。請參考 “附錄 A.3:  設定 WP-8xx7 的 IP 位址” 

 
PC 端 :   

首先開啟 ISaGRAF 專案選擇要下載到 WP-8xx7 的程式，接著點選該專案視窗的 "Link Setup" 按鈕，

如下。 

 
 
 

 
 
 

 
 
 
出現 "PC-PLC Link Parameters" 對話框，選擇 "Ethernet" 為通訊選項，按 "Setup"。 

 
 
 
 
 
 
 
 
 
 
 
出現 "Ethernet Link Parameters" 對話框，設定 "Port Number" 為 "502"，在 “Internet address” 輸入

WP-8xx7 的 IP 位址。 

 
 
 

 
 
 
 
 
 
 
 
輸入完成，點選 "OK" 按鈕，現在 PC 與 WP-8xx7 乙太網路埠的通訊設定完成了。    
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A.5 COM1/COM2/COM3/COM4 的接腳圖 與 多重連線 

每台 WP-8xx7 有一個 IP 位址及一個固定的乙太網路埠號 502。透過乙太網路，最多可連接 32 台 PC 

(以 Modbus TCP/IP 通訊協議，使用一個 TCP/IP 連結 來連接每一台 PC)，其他 PC / HMI 可以連接到

COM2: RS-485 埠  或 COM3:RS-232/485 埠 (或 COM1,4, ... 見附錄 G 與 E) (Modbus RTU slave)。 

 
 
 
 
 
 
 
 
 
 
 
 
工業型乙太網路轉換器選購指南:  

 
http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html 
 NS-205: 10/100M , 5 埠 

 NS-208: 10/100M , 8 埠 

 RS-405: 10/100M , 5 埠 (Ring Switch) 

 RS-408: 10/100M , 8 埠 (Ring Switch) 

 
 
接腳圖: 

 
COM1, COM2, COM3 與 COM4 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

PC/HMI PC/HMI … … PC/HMI 

PC/HMI 
MMI 

Modbus TCP/IP 

Modbus RTU 

COM2: RS-485 COM1: RS-232 COM4: RS-232 COM3: RS-232/485 COM3: RS-232/485 

http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html
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A.6 連接 PC 到 WP-8xx7 的 COM2 或 COM3 

Modbus RTU slave port 的預設值是 “None”，使用者可更改為“COM2:RS-485” 或 “COM3:RS-232/485” 

或 “None” (請參考附錄 “A.2: 修改 NET-ID 與 Modbus RTU 連接埠的設定”，及 附錄 G/E 取得更多

Modbus RTU ports 的資料)。 

預設的通訊參數是 “19200,8,N,1”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
要連接 PC 到 WinPAC 的 COM2 或 COM3 的 RS-485，必須使用一台 I-7520 (RS-232/485 轉換器)，如

下: 

 
 
 
 
 
 
 
 
 
 
為了使 ISaGRAF Workbench RS-232 通訊正常，只使用 RXD, TXD 與 GND 訊號線。若您執行硬體設備

或軟體程式的 PC 是使用 CTS 與 DSR 訊號線，請將 RTS-CTS 與 DTR-DSR 訊號線連在一起，如下圖所

示。 
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A.7 從 WP-8xx7 刪除 ISaGRAF 專案 

使用者刪除 WP-8xx7 控制器裡的 ISaGRAF 程式方法如下。 

 
點選 “Setting” 頁籤後，按下 “Current Application” 的 “Delete” 按鈕即可。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
刪除 WP-8xx7 的 ISaGRAF 程式，若發生軟體毀損導致而 WinCE 停滯或當機時 : 

 
1. 請將 WP-8xx7 前面板的旋轉設定鈕切換到位置 1 (安全模式)，然後再次啟動 WP-8xx7。 

 
2. 接著 WP-8xx7 會以安全模式開啟，螢幕跳出一個視窗詢問 “... reboot right now ...”，請回答 “No”，

接著進入 WinCE 桌面的 “My Device”，請點選進入目錄 “\System_Disk\isagraf\”，刪除 “ISA11”，

“ISA11” 是 ISaGRAF 目前正在執行的應用程式。 (若您在\System_Disk\isagraf\ 目錄裡找不到 

“ISA11”，請到 [Explorer] > [View] > [Options] 修改設定) 

 
3. 將旋轉設定鈕切換到位置 0 (一般模式)，重新啟動 WP-8xx7，當 ISaGRAF 連線時即會顯示 “No 

Application”。 
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A.8 連接 I-7000 和 I-87K 遠程 I/O 模組 

WP-8xx7 PAC 系統可使用 COM2 或 COM3 (RS-485) 其中之一來連接泓格科技的"I-7000" 與 " I-87K" 遠

程 I/O 模組，對於分散式遠程 I/O 到離散式系統應用，都是非常有效的規劃。 

 
一台WP-8xx7控制器最多可連接255台 I-7000 / I-87K遠程 I/O模組 (建議不超過40台 I-7000 或 I-87K)，

每一台 I-7000 與 I-87K 遠程模組必須設定互不相同的位址，以及與 WP-8xx7 控制器設定相同的 Baud

率。 

 
有關 I-7000 / I-87K 遠程模組詳細的設定與程式資料，請參考 “ISaGRAF 進階使用手冊” 第 6 章 - "連

接 I-7000 和 I-87K 遠程 I/O 模組"。 

 

 
 
 
 

  

D+ 
D- 

DATA+ 
DATA- 

DATA+ 
DATA- 

DATA+ 
DATA- 

COM2 
(COM3) 

I-7000 模組 

位址: 1 

位址: 2 位址: 3, 4, 5, 6 

I-87K 模組 
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A.9 連接 HMI 人機介面設備 

WP-8xx7/8xx6 控制器 COM2 或 COM3 (RS-232/RS-485)其中一個埠 (或最多 COM1, 4. 5, 6, 7, 8 中的 4

個埠，請參考附錄 G 與附錄 E) 可以連接人機介面 (HMI) 設備，例如: 觸控螢幕。 

 
設定 COM2 或 COM3 為 Modbus RTU 埠 之前，請先參考附錄 A.2。泓格科技提供全系列的觸控螢幕

顯示器，例如: "Touch" 系列螢幕，Touch 系列包括 Touch 500、Touch 8000、Touch 6000 等系列螢幕。 

 
更多人機介面設備 Touch 系列產品連接 WP-8xx7/8xx6 控制器的相關資料，請參考 “ISaGRAF 進階使

用手冊” 第 4 章- "連接 I-xx7 控制器與人機介面(HMI)程式"。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

Touch 500 
Touch 8000 
Touch 6000 

Series 

接線圖 

WP-8xx7  
(Modbus RTU Slave 埠: RS-232) 

COM3  或 

COM1  或 

COM4  或  

COM5,  6,  7,  8 

  
RXD  
TXD  
GND 

RS-232 
 

TXD 
RXD 
GND 
CTS  
RTS  
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A.10 連接其他 Modbus 設備 

 
WP-8xx7 的 COM2 (RS-485) 或 COM3 (RS-232/485) (或 COM1, 4, COM5 到 COM14，請參考附錄 E) 支

持 Modbus Master 通訊協議，請參考 “ISaGRAF 進階使用手冊” 第 8 章有更多詳細說明。. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

RS-232 
RXD  
TXD  
GND  
CTS  
RTS  

Modbus 設備 WP-8xx7 

COM1, 3 
TXD 2 
RXD 3 
GND 5 

RS-232: 

Modbus 設備 WP-8xx7 

RS-485 
  485 +  
  485 -  

COM2 或 COM3 

       D + 
       D - 
 

Modbus 設備 

RS-485 
  485 +  
  485 -  

RS-485: 
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A.11 控制 LED 指示燈 

WP-8xx7 有一個可程式 LED 指示燈(標示 “RUN”)，於 ISaGRAF 軟體中，您可使用 “ I/O Connection” 中

的 “show3led” I/O 來控制 LED 燈號:  

 

1. 滑鼠點選 “ I/O Connection” 開啟該視窗。 

2. 於 “ I/O Connection” 視窗，滑鼠雙擊任何大

於或等於編號 9 的插槽 並選取 “show3led” 

功能，最後再點選 “Save”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

重要注意:   

插槽 1~8 是留給實體 I/O 卡使用，請設定於插槽 9 或之後的插槽。 

 

3. 請參考第 4.2、4.3 章節來編譯程式，並將其下載至控制器中。 

 

4. 下載完成後，請開啟  “ I/O 

Connection” 視窗。您可變更 

I/O 的狀態 (False > True) 並觀

察控制器面板上 LED 燈號的

變化。 

 
 
 

  

LED (RUN) 

1 

3 

2 
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附錄 B 更新 WinPAC ISaGRAF 驅動程式 

注意: 

購買 WP-8xx7 時，ISaGRAF 驅動程式已安裝在出貨的控制器中，您無需自己安裝，但是當驅動程式

需要更新到新版本時，您需要自己更新。 

 
WinPAC ISaGRAF 驅動程式放置於 WP-8xx7 光碟目錄: 

          \napdos\isagraf\wp-8xx7\driver\wp-8x47\<version Number>\ 
 
例如: 1.01 版放在光碟: \napdos\isagraf\wp-8xx7\driver\wp-8x47\1.01\ 

          或可到下列網站下載: 

www.icpdas.com > 商品目錄 > 解決方案 > Soft PLC, ISaGRAF & Soft-GRAF HMI > ISaGRAF 首頁 > 下

載區 > 驅動程式  

 
1. 若使用的WinPAC是WP-8xx7/WP-8xx6，請先進入 “WinPAC ISaGRAF Driver” 視窗按下 “End Driver” 

停止按鈕。若是 WP-8xx1/8xx9 (沒有 ISaGRAF 執照的 WinPAC)，請跳到步驟 2。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
2. 設定 WinPAC 的 IP, Mask, FTP 目錄與自動執行 

 
A. 請在 WinPAC 控制器 “\System_Disk” 目錄下建立 “isagraf” 資料夾，如下:  

  \System_Disk\isagraf\ 
 

B. 請執行 WinPAC 視窗的 [Start] > [Setting] > [Control Panel]，接著滑鼠雙擊 “Network and Dial-up 

Connections”， 然後分別點選 “LAN1” 與 “LAN2”，一一設定 WinPAC 的 IP 位址, 子網路遮罩。

(ISaGRAF 應用請務必使用固定 IP，不可使用 DHCP) 

 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/isagraf_tc.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download/isagraf-link.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download/isagraf-link.html
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C. 請執行 [Start] > [Programs] > [WinPAC Utility]，設定 FTP 目錄到根目錄 “\”，三項 ftp 選項都請

勾選 “Enable”，按下 “Setting” 按鈕。 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

D. 點選 “Auto Execution” 頁籤，按下 “Browse” 按鈕選擇路徑檔案 或 直接輸入 

“\System_Disk\isagraf\isaWinPAC.exe”，按下 “Setting” 按鈕。 
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E. 點選 [File] > [Save and Reboot] 儲存步驟 A 到 D 所作的設定，WinPAC 會自動重新啟動。 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. WinPAC 成功的重新啟動後，請再次停止 ISaGRAF 驅動程式。(只有 WP-8xx7 / 8xx6 有執行 ISaGRAF

驅動程式，WP-8xx1 / 8xx9 沒有。) 

 
注意: 當 ISaGRAF 驅動程式執行中, 檔案是無法複製的，即使您看到好像複製成功了。 
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接著將 PC 內下列檔案下載到 WinPAC 控制器 “\System_Disk\isagraf\” 目錄中 : 

(以下為 1.16 版的檔案, 請注意不同版本的 ISaGRAF 驅動程式所包含的檔案大小與數量可能會有差

異) 

 

isaWinPAC.exe,  rs_wphmi.exe 

mscorlib.dll,  QuickerNet.dll,  Quicker.dll,  login.dll,  main.dll,  whmi_filter.dll 

isaWinPAC.lnk,  isa_el.dll  與 sharedmemory.dll 

(若您的 WinPAC 是 WP-8xx1/8xx9 還需下載 “license.bin” 檔案) 

 
您也可以使用 PC 的 ftp utility 下載這些檔案 : 

請開啟網頁瀏覽器，輸入網址  ftp://<IP address>，例如: Ftp://192.168.1.178，再瀏覽 

\System_Disk\isagraf\ 目錄，即可複製所有檔案再貼上即可。 

 
 

複製完成，請重新啟動WinPAC，即可自動執行新的驅動程式，您可檢查版本號來確認。 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

ftp://192.168.1.178/
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附錄 C 機構圖 

單位: mm 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

WP-8147 

左視圖 前視圖 右視圖 

後視圖 底視圖 上視圖 
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WP-8447 

後視圖 

底視圖 

上視圖 

左視圖 

右視圖 
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WP-8847 

後視圖 

底視圖 

上視圖 

左視圖 

右視圖 
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附錄 D 如何 啟動/停止 WP-8xx7 的 LAN2 

重要:   

1. 建議使用 NS-205 或 NS-208 工業型乙太網轉換器。 

2. ISaGRAF 應用時，LAN1 請務必使用固定 IP (若啟動 LAN2 也請使用固定 IP)。 

 
 
 
WP-8xx7 的 LAN2 預設狀態為 “停止”(disabled)，使用 LAN2 前需先設為 “啟動”。 

 
ISaGRAF應用 “Ebus” (請見 ISaGRAF 進階使用手冊7.5節) 與 “新備援系統” (請見www.icpdas.com > 支

援服務 > 產品問答 > ISaGRAF Soft-Logic PAC > FAQ-093) 時，必須使用 WP-8xx7 的 LAN2； 而 ISaGRAF

應用 “以 UDP 或 TCP 傳送訊息” 時也可以使用 LAN2 (請見 ISaGRAF 進階使用手冊 19.2 和 19.3 節)。 

 
請點選 [Start] > [Setting] > [Control Panel]，開啟 “Network and Dual-up Connections” ，以滑鼠右鍵啟

動 LAN2 為 “Enable” (或設為停止 “Disable”)。 

 

再點選 [Start] > [Programs] > [WinPAC Utility]，選擇 “Save and Reboot” 儲存設定值並重新啟動。 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 

 
 
 

  

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
http://www.icpdas.com/root/support/faq/isagraf_tc.php
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附錄 E 使用 RS-232 / 485 / 422 擴充卡 

客戶可以在 WinPAC 插槽(slot 0~7) 使用下列模組來擴充 16 個以上的 COM 埠。 

 
 I-8112iW :  2 埠 隔離式 RS-232 模組 

 I-8114iW :  4 埠 隔離式 RS-232 模組 

 I-8114W  :  4 埠 無隔離式 RS-232 模組 

 I-8142iW :  2 埠 隔離式 RS-422/RS-485 模組 

 I-8144iW :  4 埠 隔離式 RS-422/RS-485 模組 

 
 
使用上列模組前，必須先以 “WinPAC utility” 設定 (自 2.0.0.6 版起)，請將模組插入 WinPAC 的 0 ~ 7

槽 (最好是 0 ~ 3 槽)，執行 WinPAC utility : 

 
 點選 “Multi-serial port wizard” 頁籤。 

 選擇 “Use MSA/MSBx” 

 按下 “Slot scan” 按鈕，開始自動搜尋目前插槽上的多序列埠模組，卡號列在左欄中，COM 埠

的原始設定會列在右欄中。 

 按下 “Set” 按鈕，更新原始設定為模組目前的設定。 

 執行 [File] > [Save and Reboot] 儲存新設定並重新啟動 WinPAC。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

1 

2. ISaGRAF 應用需選

擇 MSA/MSBx 

3 4 

5 
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設定成功後，ISaGRAF 定義擴充卡的 COM 埠編號是 COM5 到 COM20。 
 

WinPAC 與 ISaGRAF 定義的 COM 對應表: 
 

WinPAC ISaGRAF WinPAC ISaGRAF 

MSA1 COM5 MSB1 COM13 

MSA2 COM6 MSB2 COM14 

MSA3 COM7 MSB3 COM15 

MSA4 COM8 MSB4 COM16 

MSA5 COM9 MSB5 COM17 

MSA6 COM10 MSB6 COM18 

MSA7 COM11 MSB7 COM19 

MSA8 COM12 MSB8 COM20 

 
注意: 

1. 請參考 ISaGRAF 進階使用手冊第 8.4 節 multi-ports Modbus Master 相關資料。 

    (WP-8xx7 最多可設定 10 個 Modbus RTU/ASCII Master 埠 (COM1 ~ 14) 

2. 請參考 ISaGRAF進階使用手冊附錄 A.4使用 COM_OPEN, COM_READ, … 函式讀寫 COM埠的資料。 

3. 請參考本手冊附錄 G 有關更多設定 Modbus RTU slave 埠的資料。 

 
 
接腳圖 1: 

 
  

例如, slot 0: I-8142iW   與 

          slot 1: I-8144iW 
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接腳圖 2: 
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附錄 F 減慢 ISaGRAF 驅動程式的速度 

為什麼 ?  快 不好嗎 ? 

 
減慢 ISaGRAF 驅動程式的原因是 : 當您同時執行 ISaGRAF 與其他 HMI 軟體 (例如 InduSoft 或 VB.net 

程式)，CPU 只有一個，所有在 WinPAC 上執行的程式都共用同一個 CPU，當您覺得 HMI 軟體執行

不順暢或顯得緩慢，您可以使用 ISaGRAF function – “PLC_Mode( )” 來減緩 ISaGRAF 驅動程式的速

度。 

 
PLC_Mode 
 

說明: 

Function              改變 ISaGRAF driver 速度 
 

語法: 

    MODE_      integer 可以是 0, 1, 2, 或 3 

                0:  快速模式，預設值，最小 PLC scan time 約為 2 ~ 3 ms 

                1:  稍慢模式，最小 PLC scan time 約為 6 ~ 7 ms 

                2:  較慢模式，最小 PLC scan time 約為 9 ~ 11 ms 

                3 或其他值:  最慢模式，最小 PLC scan time 約為 19 ~ 21 ms 
 

回傳: 

    Q_  boolean 固定回傳 True 
 
 
 

注意: 

1. 系統預設值為 "快速模式"。 

2. 使用者可在第一個 PLC scan 裡呼叫 "PLC_mode( )" 來改變 PLC 的速度。 

3. 減慢 PLC 速度是為了改善執行 ISaGRAF 同時又執行 HMI 軟體時的效能， 

例如: 當 WinPAC 同時執行 ISaGRAF 與 InduSoft 時可以使用此函式改善效能。 
 

範例 :  
 

  (* TMP 宣告為 Boolean internal 變數 *) 

  (* INIT 宣告為 Boolean internal 變數, 初始值為 TRUE *) 

  if  INIT  then 
    INIT  :=  False ;   (* 只在第一個 PLC scan 裡呼叫一次 *) 

    TMP  :=  PLC_mode(2) ;   (* 設定 PLC 速度為 2: 較慢模式 *) 

  end_if ; 
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附錄 G 設定更多 Modbus RTU Salve 埠 

WP-8xx7/8xx6 最多可以設定 5 個 Modbus RTU slave 埠 : COM2 或 COM3 其中一個埠 以及 COM1 到 

COM8 的其中 4 個埠 (插槽 0 到插槽 3 多埠擴充卡的設定方式請參考附錄 E)。 

 
 
注意 : WP-8147 沒有 COM3 和 COM4 (只有 WP-8447/8847 有) 

 
1. 第一個可以設為 Modbus RTU slave 埠的是 COM2 或 COM3 其中一個，該埠可以滑鼠設定為 

"WinPAC 顯示器" (參考附錄 A.2)。 

 
2. 使用者可以將 COM1 到 COM8 啟動為 第 2, 3, 4 或 5個 Modbus RTU slave 埠 (不支援其他 COM 

埠)。 

 
3. 使用此功能之前，請確定上列 COM 埠確實存在, 並已規劃設定完成 (參考附錄 E)。 

 
4. 使用第 2, 3, 4 或 5 個 Modbus RTU slave 埠時，ISaGRAF 可以用該埠來對控制器 除錯/設值，但是

不能用來 停止/下載/更新 ISaGRAF 程式。 

 
5. 除錯/設值/停止/下載/更新 ISaGRAF 程式，請使用乙太通訊埠 (或第 1 個 Modbus RTU slave 埠，也

就是以 COM2 或 COM3 啟動的那個第一個埠)，第二個 Modbus RTU slave 埠(以其餘的 COM1 ~ 

COM8 啟動的第二個埠) 不具備 停止/下載/除錯 的功能。 
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如何設定 ? 

 
請在 “ISaGRAF I/O connection” 視窗設定 “Rtu_slav” ，重新編議專案並以 Ethernet 乙太埠下載到

WinPAC (或使用第 1 個 Modbus RTU 埠)  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

RTU_Slave_Port2 ~ 5 用來啟動 COM 埠號碼，編

號可為 0, 1 到 8，0 表示不啟動。 

 
Baud 率可設為 600, 1200, 2400, 4800, 9600, 

19200, 38400, 57600, 115200 4 個布林輸入通道顯

示對應埠是否啟動 : 

True: 啟動。 

False: 沒有啟動。 
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附錄 H 不同版本 ISaGRAF 產生的編譯錯誤 

 
自 2003 年起，最近幾年所有 ICP DAS 光碟、網站提供的 ISaGRAF 範例程式 都是以 3.46 版 ISaGRAF 

workbench 撰寫的，如果您的 ISaGRAF workbench 是 3.51 版或更新的版本，當您重新編譯程式時，

可能會出現錯誤訊息。 

 
要解決這個因不同版本產生的編譯錯誤，請執行一次 [ Make ] > [ Touch ]， 然後重新編譯範例程式

專案。 

 
[Make] > [Touch] 可以將所有已編譯的程式重新設定為 “尚未編譯”  ，而下一個[Make] > [Make 

application] 可以將全部的程式重新編譯。 

 

 
 
 

  



WinPAC-8xx7 ISaGRAF PAC 快速上手手冊,  1.65 版,  2013 年 8 月     ICP DAS                   Ap-27 

附錄 I 使用 RS-232 序列/USB 觸控螢幕 

WP-8000 支援 3 種型態的 RS-232 序列 或 USB 觸控螢幕。 
 

  “penmount_serial_touch” , “penmount_usb_touch” 或 penmount-相容 觸控螢幕。 

  “elo_serial_touch” ,  “elo_usb_touch” 或 elo-相容 觸控螢幕。 

  “egalax_serial_touch” , “egalax_usb_touch” 或 egalax-相容 觸控螢幕。 

 

I.1 觸控螢幕的驅動程式與安裝注意事項  

WP-8000 觸控螢幕驅動程式放在控制器 \System_Disk\external_device_driver\ 目錄下 

此目錄下有 Touch 螢幕的驅動程式(如下所列)，您只能執行正確適合的驅動程式 !  

(檔案與名稱內的 “_vyyyymmdd” 可能會有所不同，依修改版本與日期而有變化) 

 
 
 
 
 
 
 
 
 
 

如果找不到這些驅動程式檔案，請到下列網址下載: 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/micro_sd/external_device_driver/ 

以 ftp 方式複製 “external_device_driver” 檔案到 PAC 的 \System_Disk\external_device_driver\ 目錄下 

 
 

注意事項 : 

1. 為了避免硬體上的衝突，請勿同時安裝 USB 與 RS-232 驅動程式。 

2. 若安裝了錯誤的觸控螢幕驅動程式，請執行解除安裝 (解除安裝請參考附錄 I.4 )，之後再重新

安裝。 

3. WinPAC 安裝 Touch 驅動程式後螢幕產生不正常顯示時(如: 太大、太小、疊紋…)，可調整螢幕

頻率來解決顯示問題，請參考 附錄 I.5。 

 

本附錄的範例使用觸控螢幕 “TPM-4100” : 

10.4" 工業型面板安裝 (Panel Mount，鋁合金面板) 觸控螢幕，支援 RS-232 或 USB 介面，網址:  

http://www.icpdas.com/root/product/solutions/hmi_touch_monitor/touch_monitor/tpm-4100.html 
    

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/micro_sd/external_device_driver/
http://www.icpdas.com/root/product/solutions/hmi_touch_monitor/touch_monitor/tpm-4100.html
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I.2 使用 USB 觸控螢幕的步驟 

 

1. 連接觸控螢幕的 USB 到 WP-8xx7 的 USB 插口 (如圖)，並在

WP-8000 裝上 USB 滑鼠方便設定觸控螢幕的驅動程式, 

WP-8x37 有 2 個 USB, WP-8x47 有 1 個 USB(設定時可交替使用

USB 或以 VCEP 遠端設定)，接著啟動 WinPAC。 

 

2. 安裝觸控螢幕驅動程式 :滑鼠雙擊控制器中 \System_Disk\external_device_driver\ 目錄下適當的

觸控螢幕驅動程式，此例使用 TPM-4100，驅動程式檔 (PenMount_USB_TOUCH_Vyyyymmdd.CAB)  

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 

3. 螢幕校正: 點選 [ 開始 ] >  [ Programs ] > [ USB_TOUCH ] > [ PenMount ] > [ Calibration ] 呼叫螢幕觸

控校正功能。依序觸碰螢幕上出現的指標來校正螢幕。再以 WinPAC Utility “Save and Reboot”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

按下 “OK” 進行安裝。 

點選 WinPAC 圖示 或  

“Start Menu” > “Programs” > 
“WinPAC Utility”，選擇 “File” > 

“Save and Reboot”，儲存設定與

重新開機，即可使用。 

USB 

http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_utility.htm
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I.3 使用 RS-232 觸控螢幕的步驟 

 

1. 連接觸控螢幕的 RS-232 訊號線到 WP-8xx7 的 COM4 (參考 

附錄 A.5 COM4 的接腳圖)，並在 WP-8xx7 裝上USB 滑鼠 (用

來設定觸控螢幕的驅動程式)，接著啟動 WinPAC。 

 
 

2. 安裝觸控螢幕驅動程式 :滑鼠雙擊控制器 \System_Disk\external_device_driver\ 目錄下適當的觸

控螢幕驅動程式，此例使用 TPM-4100，驅動程式檔如圖 (PM6000_Serial_TOUCH_Vyyyymmdd.CAB)  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3. 螢幕校正: 點選 [ 開始 ] >  [ Programs ] > [ Serial_TOUCH ] > [ PenMount ] > [ Calibration ] 呼叫螢幕

觸控校正功能。依序觸碰螢幕上出現的指標來校正螢幕。再以 WinPAC Utility “Save and Reboot”。 

 
 
 
 
 
 
 
 
 
 

4. 設定 COM Port: 點選  [ 開始 ] >  [ Programs ] > [ Serial_TOUCH ] > [ PenMount ] > [SetCOM ] 可設定

COM port。此例 COM Port 為 4，連接到新設的 COM，使用 WinPAC Utility 重新啟動 PAC。 

 
 
 
 
 
 
 
 
  

按下 “OK” 進行安裝。 

點選 “Start Menu” > 

“Programs” > “WinPAC 
Utility”，選擇 “File” > “Save and 

Reboot”，儲存設定與重新開

機，即可使用。 

COM4 USB 
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I.4 移除觸控螢幕的驅動程式 

使用者可能因為安裝了錯誤的驅動程式，或需更換螢幕而想要移除目前的驅動程式。請依照下列步

驟來完成此程序。 

 

1. 開始功能表  [ Start ] > [Programs ] > [USB_TOUCH ] 或  [Serial_TOUCH ] > [PenMount] > [Uninstall] 

 
 
 
 
 
 
 
 
 
 
 

2. 確認移除: 在出現的視窗中點選 “Yes” 按鈕確認解除安裝程式。 

 
 
 
 
 
 
 

3. 重新啟動 WinPAC 控制器: 一旦完成移除驅動程式，會出現下列視窗，點選 “Yes”，即可自動重新

啟動控制器。 
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I.5 調整 WinPAC 的螢幕顯示頻率 

WinPAC 出廠預設的螢幕設定，可能無法支援所有的顯示螢幕，若出現顯示問題，請參考本附錄

調整螢幕顯示，來解決下列顯示問題 : 

1. 疊紋 (Moire). 

2. 無顯示. 

3. 不正常顯示. (太大、太小或單向超出) 
 

WinPAC 自下列版本起支援調整螢幕顯示頻率的功能 : 

PAC 平台 OS 版本 WinPAC/ViewPAC utility 版本 

WP-8x3x  所有版本 所有版本 

WP-8x4x  自 V1611 版本起 自 V2027 版本起 

WP-5000  自 V1100 版本起 自 V2027 版本起 
 

注意:  某些頻率可能導致螢幕無法顯示，因此調整前請先在 WinPAC-Utility 設定 VCEP 為自動執行項

目，以便螢幕無法顯示時能遠端控制 WinPAC。(參考 WinPAC FAQ Chappter 2-001 )      

 

步驟 1 :  按下顯示器的 自動調整(Auto)按鈕。 

步驟 2 :  若自動調整按扭無法解決問題，請依照步驟 3~6 

調整 WinPAC 螢幕顯示頻率。 

 

步驟 3 :  執行 WinPAC 桌面的 WinPAC_Utility。 

進入 System Settings 頁面。 

 
 

步驟 4 :  更換其他頻率，並點選 “Setting”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

步驟5 :  點選  [ File ] > [ Save and reboot ] 儲存並重啟 WinPAC.  

步驟6 :  若設定的頻率顯示仍不適用，請重複步驟 3~6 重新選擇適當的

頻率。 

  

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/document/faq/system_maintenance/w2-001_how_to_use_vcep_to_remotely_control_wince_pac_english.pdf
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附錄 J 為何執行 ISaGRAF 的 PC 無法正確連接 ISaGRAF 

PAC ? 

本文件可於下列網頁下載: www.icpdas.com > 支援服務 > 產品問答 > ISaGRAF Soft-Logic PAC > 104. 

 
有時, 當 PC / ISaGRAF 除錯器連接 ISaGRAF 控制器時, 出現下列彈跳視窗的訊息:  “Can not link ...” 或 

“Can not download” 或 “Can not find BMP ...” 或 ...  
 

解決的步驟如下: 
 

1. 首先關閉所有 ISaGRAF 視窗. 接著按下 “Ctrl” + “Alt” + “Delete” 鍵來開啟 “工作管理員”.  

2. 停止記憶體為空白的處理程序. 接著再次執行 PC / ISaGRAF 來連接控制器. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

3. 若仍有問題而您是使用Ethernet來連接控制器, 請檢查PC與控制器是否設定相同的IP網域, 例如, 

PC(IP, Mask) = (192.168.1.2, 255.255.255.0) , 是無法連上控制器=(192.168.3.5, 255.255.255.0) 的. 

但若控制器=(192.168.1.5, 255.255.255.0) 則可正常連接. 

 
4. 若仍有問題而您是使用RS-232 來連接控制器, 請檢查RS-232 線的連接是否正確以及PC連接控制

器的RS-232 埠號是否設定正確. 

 
5. 最後的方法就是重新開啟您的PC 再試一次. 

 
 

  

關閉所有 ISaGRAF 視窗, 再按 

Ctrl+Alt+Del 開啟工作管理員, 再停止

記憶體為空白的程序, 接著再次執行 

ISaGRAF 來連接電腦. 

http://www.icpdas.com/
http://www.icpdas.com/root/support/faq/isagraf_tc.php
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附錄 K 啟動 WinPAC 螢幕保護功能 

 
啟動 WP-8xx7 的螢幕保護功能, 請設定下列兩個項目. 

 
請執行  “Control Panel” > “Power” > “Schemes” , 在 “Power Scheme” 項目選擇 “AC power” , 並將 

“User Idle” 與 “System Idle” 設定同樣的值 (或設定 “System Idle” 的值比 “User Idle” 的值大) , 然後, 記

得執行 “WinPAC Utility” > “File” > “Save” 存檔及重新啟動.  

 
如果使用者沒有碰觸螢幕或按鍵, 設定的時間到時, WP-8xx7 會關閉背光 啟動螢幕保護功能. 之後只

要使用者碰觸螢幕或按鍵, WP-8xx7 就會再次開啟螢幕背光.  

 
 
若不想使用螢幕保護功能, 請設定 “User Idle” 與 “System Idle” 為 “Never” , 同時記得要執行 WinPAC 

Utility > File > Save, 儲存設定並重新啟動. 
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附錄 L 如何偵測雙電池電力狀況與 Ethernet Port 狀態 

注意 : 更換電池前請先關閉控制器的電源，以免電池誤觸其他電子零件而造成損毀。 

 

WinPAC 配備有雙電池備援的 512 KB 記憶體，電力中斷時仍可持續保存重要資料。雙電池設計可在

更換其中一顆電池時，另一電池仍持續供電，(注意：請勿將兩顆電池同時取下更換，以免造成數

據遺失)。 

 

 使用 R_MB_ADR 函式來偵測 雙電池的電力狀況 

在 R_MB_ADR 函式填入 ADR 編號 9992 和 9993 來讀取電池的電力狀況，如圖 LD 語法 1 與 2。 

ADR 編號 9992 表示電池 1 的狀態。  

ADR 編號 9993 表示電池 2 的狀態。  

 使用 R_MB_ADR 函式來偵測 Ethernet Port 的斷線狀態 

在 R_MB_ADR 函式填入 ADR 編號 9987 和 9986 來讀取 Ethernet Port 斷線狀態 (LD 語法 3 與 4)。 

ADR 編號 9987 表示 LAN1 的狀態。 1: ok ; 0: 斷線。 

ADR 編號 9986 表示 LAN2 的狀態。 1: ok ; 0: 斷線。 

 

名稱 變數型態 屬性 ADR 說  明 

batery1 Integer Internal 9992 偵測電池 1 的電力狀態 

batery2 Integer Internal 9993 偵測電池 2 的電力狀態 

lan1 Binary Internal 9987 偵測 LAN1 的斷線狀態 

Lan2 Binary Internal 9986 偵測 LAN2 的斷線狀態 
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執行程式後: 

1. 參數 batery1 或 batery2 的回傳值表示下列狀態: 

"99" : 表示電力正常，暫時不需要更換電池。  

"0"  : 表示低電位狀態或電力已耗盡，請盡快更換電池。  

 

2. 參數 lan1 或 lan2 的回傳值表示下列狀態: 

"1" : 表示 Ethernet port 連線正常。  

"0"  : 表示 Ethernet port 斷線狀態。  
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